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Notes for the reader

Notes for the reader

Introduction

This manual helps you to use the Océ TCS500. The manual contains a description 
of the Océ TCS500 and guidelines to use and operate the Océ TCS500. There are 
also tips to increase your knowledge of the Océ TCS500 and to help you manage the 
workflow even better.

Definition

Attention Getters

Parts of this manual require your special attention. These parts provide important, 
additional information or are about the prevention of damage to your properties. 

Note, Attention and Caution

The words Note, Attention and Caution indicate these important parts. 

■ The word Note comes before additional information about the correct operation 
of the Océ TCS500 or a tip.

■ A part marked with Attention contains information to prevent damage to items, 
for example the Océ TCS500, an original or a file.

■ A part marked with Caution contains information to prevent personal injury. 
Caution is found only in manuals that describe physical products.

Safety information

The safety information for this product is included in a separate manual with the title 
Safety manual. This manual is part of the documentation set that you received with 
your product.
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How to use this manual

How to use this manual

Introduction

You can access a topic quickly through the following methods.
■ Refer to the alphabetical index at the end of the manual.
■ Refer to the table of contents at the beginning of this manual.

Before you turn to the complete table of contents, you can also use the following 
table to find a topic quickly.

The sections of this manual

The following table gives an overview of how the chapters are arranged logically.

[1] 

Chapters Section Topics

1 Introduction ■ Explanation of the product concept
■ The main components of the Océ 

TCS500
■ Overview of available 

documentation 

2 Get to know the system ■ Scanner
■ Controller
■ Printer
■ Finishing options

3 Prepare the system for use ■ Turn the system on and off
■ Define the time-outs
■ Set the system language
■ Configure the network settings

4 Use the PLC applications 
to control your workflow

■ Océ Settings Editor
■ Océ System Control Panel
■ Océ Queue Manager
■ Océ Scan Manager
■ Océ Remote Logic®

5-6-7 Use the system ■ Scan-to-file jobs
■ Print jobs
■ Copy jobs

8 Ensure the best quality 
output

■ Define the output quality
■ Check the output quality
■ Optimise the output quality
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How to use this manual

9 Optional Document 
Management 

■ Océ Account Center
■ Océ Repro Desk
■ Océ Engineering Exec

10 Optional License 
Management

■ Océ License Logic

11 Maintain the system ■ Maintain the scanner
■ Maintain the printer

12 System messages and 
solutions

■ System messages
■ Scanner messages
■ Printer messages

Appendix A Specifications ■ System specifications
■ Supported media types and sizes

Appendix B General information Reader's comment sheet

Appendix C General information Addresses of local Océ organisations

Chapters Section Topics
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Available documentation

Available documentation

Introduction

This manual is part of a complete documentation set. The following table shows a 
complete overview of the available documentation.

Available documentation
[2] 

[2] Available documentation (1 – 2)

Product Documentation Medium

Océ TCS500 Océ TCS500 User manual CD-ROM, as a PDF file in 
multiple languages.

Océ TCS500 Safety Manual Hardcopy manual 
(multilingual).

Océ Power Logic®  controller Océ TDS-TCS connectivity 
manual

CD-ROM, as a PDF file in 
English only.

Océ Power Logic® 
applications On-line Help

Embedded in the applications, 
as an on-line help file in 
multiple languages.

Océ Windows® Printer 
Driver

Océ Windows® Printer 
Driver User Manual

CD-ROM, as a PDF file in 
multiple languages on Océ 
Driver Pack CD-ROM.

Océ Windows® Printer 
Driver On-line Help

Embedded in the driver 
application as on-line help file 
in multiple languages.

Océ PostScript® 3 driver Océ PostScript® 3 driver 
Getting Started

CD-ROM, as a PDF file in 
multiple languages on Océ 
Driver Pack CD-ROM.

Océ PostScript® 3 driver 
Getting Started

Embedded in the driver 
application as on-line help file 
in multiple languages.
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Available documentation

Note: Visit Océ on the internet at www.oce.com for the latest information.

Océ Account Center Océ Account Center User 
Manual

CD-ROM, as a PDF file in 
multiple languages.

Océ Account Logic on-line 
help

Embedded in the application, 
as an on-line help file in 
multiple languages.

Océ Account Console on-line 
help

Embedded in the application, 
as an on-line help file in 
multiple languages.

Océ License Logic Océ License Logic on-line 
help

Embedded in the application, 
as an on-line help file in 
multiple languages.

Océ Print Exec® Workgroup Océ Print Exec® Workgroup 
User Manual

CD-ROM, as a PDF file in 
multiple languages.

Océ Print Exec® Workgroup 
on-line help

Embedded in the driver 
application as on-line help file 
in multiple languages.

[2] Available documentation (2 – 2)

Product Documentation Medium
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The product concept and complete workflow

The product concept and complete workflow

Definition

A complete Océ solution includes several different hardware and software products 
to manage your complete document workflow. The complete document workflow 
includes several different jobs and documents. The following illustration gives an 
overview of a complete Océ solution and the document workflow.

Illustration
[1] 

[1] Overview of a complete Océ solution. The system set-up and control.

Different documents

The complete workflow includes the following different documents.

[3] 

Different products

The complete Océ solution is a combination of the following elements.
■ Scanner
■ Controller
■ Printer
■ Finishing options
■ Job submission software
■ Document management software.

Scanner Controller Printer
Finishing
Options

Job
Submission

Document
Management

Nr. Document

1 Original

2 Copy

3 Print

4 File
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The product concept and complete workflow

Different jobs

The arrows in the illustration show the different possible jobs (see figure 1 on 
page 17). The complete document workflow of the Océ solution includes the 
following different jobs.
■ Print job.

A print job starts with a file (4) and ends with a print (3). 
■ Copy job.

A copy job starts with an original (1) and ends with a copy (2).
■ Scan-to-file job.

A scan-to-file job starts with an original (1) and ends with a file (4).
■ Set-up and control the complete workflow.

Do  which job where

Use the following products to do the following jobs.
■ Print jobs on the job submission software or printer drivers.
■ Copy jobs on the scanner operator panel
■ Scan-to-file jobs on the scanner operator panel
■ Set up and control the complete  workflow on the controller.

Note: A setting in the job submission software or driver always overrules a system 
setting.
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The Océ TCS500 users

Introduction

The Océ TCS500 has the following types of users.
■ Common user
■ Repro operator
■ Key operator
■ System administrator.

Note: (see ‘User modes’ on page 121) for or more information about the user 
modes and how to log on as a specific type of user.

Common user

The common user is a person who uses the system for print jobs. The common user 
has no permission to change the system settings. Therefore, the common user is 
referred to as an anonymous user. In order to be consistent with the Océ Power 
Logic® controller software, in this manual the common user is referred to as an 
anonymous user.

Note: You do not need a password if you are a common user or an anonymous user

Repro operator

The repro operator is responsible for the daily use of the Océ TCS500 in a central 
repro department. The repro operator has no permission to change the settings in the 
Océ Settings Editor. 
The repro operator has full permission in the Océ Queue Manager.

Note: The default password for the repro operator is  ReproOp .

Key operator

The key operator is responsible for the user maintenance and the system settings of 
the Océ TCS500.
The key operator has the permission to define the key operator settings in the Océ 
Settings Editor.
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The Océ TCS500 users

[4] 

The key operator has full permission in the Océ Queue Manager.

Note: The default password for the key operator is  KeyOp .

System administrator

The system administrator is responsible for the installation and the configuration of  
the Océ TCS500 in the network environment.

The system administrator has the permission to define the system administrator 
settings in the Océ Settings Editor.

[5] 

Note: The default password for the system administrator is  SysAdm .

Key operator settings

Mode Settings to change

Key operator ■ System settings
■ Printer settings
■ Job settings for print jobs

System administrator settings

Mode Settings to change

System administrator ■ System settings
■ Security settings
■ Connectivity settings
■ Printer PDL settings
■ Printer pen settings
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The Océ TCS500 colour printing system

The Océ TCS500 colour printing system

Introduction

The Océ TCS500 is a modular wide-format colour printing system.
The Océ TCS500 offers a wide range of print functionality. The Océ TCS500 uses 
the CMYK colour model. The printer contains printheads for cyan, magenta, yellow, 
and black (CMYK) and is based on thermal inkjet technology.

The Océ TCS500 colour printing system consists of the following modules.
■ The scanner
■ The Océ Power Logic® Controller.
■ The printer

The modular construction of the Océ TCS500 allows you to create a customised 
configuration. The Océ Power Logic® Controller is required for all configurations.

The Océ TCS500 main components

If you have a configuration without a monitor, a keyboard and a mouse directly 
connected to the controller, you can place the Océ Power Logic® controller inside 
the controller cabinet of the printer.
If you have a configuration with a monitor, a keyboard and a mouse directly 
connected to the controller, you cannot place the Océ Power Logic® controller inside 
the controller cabinet of the printer.
You can always place the Océ Power Logic® controller inside a separate controller 
cabinet.

The following figure shows a Océ TCS500 colour printing system.

[2] 

[2] The Océ TCS500 colour printing system

1. The scanner

1 2 3
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The Océ TCS500 colour printing system

2. The Océ Power Logic® controller inside a separate controller cabinet with a 
monitor, a keyboard and a mouse directly connected to the controller

3. The printer
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The Océ TCS500 scanner

The Océ TCS500 scanner

The Océ TCS500 scanner

Introduction

The Océ TCS500 scanner is a wide-format scanner with an optical resolution of 575 
dpi.

Illustration
[3] 

[3] The Océ TCS500 scanner

The main components of the Océ TCS500 scanner
[6] 

1 2
3

4

5

Number Component Function

1 Top cover Get access to the glass plate.

2 Original feed table Feed the original.

3 Operator panel Define the job settings.

4 On / off switch Turn the Océ TCS500 scanner on 
and off.

5 Integrated receiving tray Receive the originals.
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The scanner operator panel

The scanner operator panel

Introduction

Use the scanner operator panel to do a copy or scan-to-file job.

Illustration
[4] 

[4] The operator panel of the Océ TCS500 scanner

1 2 3 4 5 6 7 8 9 0

3

5

6

11

4

1 2

78

10

  9

12
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The scanner operator panel

The keys and their functions
[7] 

[7] The keys and their functions (1 – 2)

Number Component Function

1 Green and red light Indicate the status of the scanner.
■ A green light indicates that the scanner is 

ready.
■ A blinking green light indicates that the 

scanner is busy.
■ A red light indicates that an error occurred.
■ A blinking red light indicates that the 

scanner is busy and an error occurred.

2 Screen Show the system information in text and 
icons.

3 and  12 Upper softkeys The upper-left softkey can have one of the 
following functions.
■ Select the job, 'Copy' or 'Scan-to-file'. 
■ Return to  the home screen with the 'Home' 

function.
■ Cancel a set with 'Cancel set' in case of a 

set copy.

The upper-right softkey can have one of the 
following functions.
■ Cancel a setting with the 'Cancel' function.
■ Create and close a set with the 'Create set' 

and 'Close set' function.

4 Scroll-wheel key ■ Open a template or a  setting
■ Close a setting
■ Define a toggle setting.

5 Scroll wheel ■ Scroll to a setting or template
■ Define the value of a setting.

6 and 10 Lower softkeys The lower-left softkey can have one of the 
following functions.
■ Select another language.
■ Reset the settings of the templates with the 

'Defaults' function.

The lower-right softkey can have one of the 
following functions.
■ Close a setting with the 'Close' function.
■ Open the system settings with the 'System' 

function.
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The scanner operator panel

Note: The function of a softkey depends on where you are in the definition the job 
settings step.

7 Start key Start a copy or scan-to-file job.

8 Stop key ■ Stop a copy or scan-to-file job.
■ Release an original.

9 Numeric keys Enter a numeric value.

11 Left softkeys ■ Open a template.
■ Define a setting that contains two values.

This setting is called a toggle setting.
■ Open a setting that contains various values.
■ Open a setting that contains various 

settings.
This setting is called a grouped setting.

[7] The keys and their functions (2 – 2)

Number Component Function
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The Océ Power Logic® controller

The Océ Power Logic® controller

Introduction

The Océ Power Logic® controller is based on a PC platform running Windows® XP 
Embedded.

Use the Océ Power Logic® controller to do the following.
■ define the default system settings
■ receive jobs over the network
■ process the scan-to-file jobs
■ process the copy jobs
■ process the print jobs
■ manage the job queue
■ manage the set memory

The location of the Océ Power Logic® controller

You can place the Océ Power Logic® controller in one of the following locations.

[8] 

[8] The location of the Océ Power Logic® controller 

Location of the controller

Integrated in the right-hand side of the 
Océ TCS500 printer.

[5] 

[5] The Océ Power Logic® Controller 
(printer)

Inside a separate controller cabinet.
When you have a monitor, a keyboard 
and a mouse connected to the Océ 
Power Logic® controller, the controller 
is always placed inside a separate 
controller cabinet. 

[6] 

[6] The Océ Power Logic® Controller (stand 
alone)
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The Océ Power Logic® controller

The applications that run on the Océ Power Logic® controller
[9] 

[9] Océ applications that can run on the Océ Power Logic® controller (1 – 2)

Application Function Description

Océ Settings 
Editor

Setup your workflow With the Océ Settings Editor you 
can view or edit the default 
settings of the system. 
The repro operator and the 
anonymous users can only view 
the default settings.
To edit the default settings you 
need a password.
There are two types of settings.
■ Key Operator settings

To edit the key operator 
settings you need a 
key-operator password.

■ System Administrator settings
To edit the system 
administrator settings you need 
a system administrator 
password.

Océ System 
Control Panel

Control your workflow: 
information about the 
system status

■ Display the status of the printer
■ Display the media available on 

the system
■ Display the volume of set 

memory in use
■ Print the configuration settings
■ Print a demo print.

Océ Queue 
Manager

Control your workflow: 
information about the 
current print jobs

■ Control and view the job queue
■ Inspect the progress of a job by 

set and page.
■ Cancel jobs
■ Delete jobs
■ Pause and restart jobs
■ Move jobs to the top of the 

queue
■ Reprint multiple sets from the 

history queue.
■ Print jobs from the inbox queue
■ View and edit  the properties of 

jobs in the print queue, inbox 
queue and history queue.
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The Océ Power Logic® controller

Note: To perform some of these actions you need a password.

Océ Remote 
Logic® (Server)

Possibility to setup and 
control your workflow 
from a remote workstation

If you install Océ Remote Logic® 
(Client) on your remote 
workstation, you can access the 
Océ System Control Panel, the 
Océ Settings Editor, and the Océ 
Queue Manager on the Océ Power 
Logic® controller. 

Océ License 
Logic

Manage the licenses for 
the Océ software 
applications

Océ Account 
Logic

Create an exact record of 
the print, copy and 
scan-to-file volume for 
accounting purposes.

[9] Océ applications that can run on the Océ Power Logic® controller (2 – 2)

Application Function Description
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The Océ TCS500 printer

The Océ TCS500 printer

Introduction

The Océ TCS500 printer is a 36 inch colour printer with a true resolution of 600 dpi 
and is available with 1, 2, or 3 media rolls. Each of the rolls can contain different 
types and sizes of media. The size and type of the loaded media are indicated on the 
operator panel. There are three finishing options available for the Océ TCS500 
printer (see ‘The finishing options’ on page 40).
The Océ TCS500 printer uses the CMYK colour model. The printer contains 
printheads for cyan, magenta, yellow, and black (CMYK) which are based on 
thermal inkjet technology. 

Illustration
[7] 

[7] The Océ TCS500 printer (2 roll version)

5

7

6

1

3

4

2
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The Océ TCS500 printer

The main components of the Océ TCS500 printer
[10] 

Note: The copy receiving rack is an optional feature. The copy receiving rack is 
required for the 3 roll version (see ‘The optional copy receiving rack’ on page 42).

Number Component Function

1. The printer operator panel Define the job settings.

2. The top cover Get access to the carriage with the 
printheads.

3. The media rolls Provide the media for your printed 
output.

4. The integrated receiving tray Receive the output (option).

5. The ink tanks Provide the ink for your printed 
output.

6. The Océ Power Logic® controller 
door

Get acces to the optionally 
integrated Océ Power Logic® 
controller.

7. The maintenance door Get access to the maintenance 
cassette.
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The printer operator panel

Introduction

This section describes the parts and the functions of the printer operator panel. You 
can turn the printer operator panel for easy viewing to both sides.

Use the printer operator panel to view system information when the system is in the 
on-line mode and to do actions when the system is in the off-line mode.

The main components of the printer operator panel are the following.

[8] 

[8] The operator panel of the Océ TCS500 printer

Al l sys tems OK.

Demo p r i n t s Nede r l ands

5

1

6

3

4

2
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The printer operator panel

The keys and their functions
[11] 

[11] The keys and their functions (1 – 2)

Number Component Function

1 The upper softkeys The function of a softkey depends on the mode 
of the printer operator panel. (see ‘The on-line 
mode and the off-line mode’ on page 36) 
Use the upper softkeys to do the following
■ Scroll through the information tabs on the 

on-line screen
■ Scroll through the wizard cards on the 

off-line screen
■ Step through the wizards on the off-line 

screen.

2 The red attention 
LEDs

When operator action is required, the red LEDs 
illuminate and you will hear an audio signal. 
The printer has the following types of signals.
■ An attention signal

A short interrupted audio signal. The red 
LEDs flash two times.

■ A warning signal
A short interrupted audio signal. The red 
LEDs remain illuminated.

■ An error signal
A long, uninterrupted audio signal. The 
LEDs flash continuously.

Note: Chapter 12 System 
messages and solutions describes 
how to correct possible errors.

3 The screen The screen of the printer operator panel 
displays different types of information. The 
type of information depends on the mode of the 
system.
When the printer is in the on-line mode, the 
screen displays general system information 
and job information.
When the printer is in the off-line mode, the 
screen displays various wizards for user action 
(see ‘The on-line mode and the off-line mode’ 
on page 36).
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Note: The function of a softkey depends on where you are in the definition the job 
settings step.

4 The on-line / off-line 
key with green LED

Use the on-line / off-line key to switch between 
the on-line mode and the off-line mode on the 
screen. When you press the on-line / off-line 
key while the printer is active, the printer 
finishes the print. Then the printer goes 
off-line. The next section contains more 
information about the on-line mode and the 
off-line mode (see ‘The on-line mode and the 
off-line mode’ on page 36).

5 The stop key Use the stop key to delete or to stop a job (see 
‘Stop, delete or hold an active job’ on 
page 150).

6 The lower softkeys. The function of a softkey depends on the mode 
of the printer operator panel. (see ‘The on-line 
mode and the off-line mode’ on page 36)
Use the lower softkeys to do the following
■ Select items on the on-line screen
■ select the wizards on the off-line screen
■ Select options in the wizards on the off-line 

screen.

[11] The keys and their functions (2 – 2)

Number Component Function
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The on-line mode and the off-line mode

The on-line mode and the off-line mode

Introduction

Use the on-line / off-line key to switch between the on-line mode and the off-line 
mode on the screen of the printer operator panel. When you press the on-line / 
off-line key while the printer is active, the printer finishes the print. Then the printer 
goes off-line.

The on-line mode
[9] 

[9] The on-line mode (system information card)

When the printer is in the on-line mode, the green LED is on. The screen of the 
printer operator panel displays the following 5 information cards.
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[12] 

Use the upper softkeys to scroll through the information tabs.

Note: The information on the on-line screen is also available in the Océ System 
Control Panel.

[12] On-line mode - Information cards 

Information card Displayed information

Job information
[10] 

■ Job status
■ Job name
■ Progress indication
■ Selected print mode

Media information
[11] 

The media types and media sizes loaded on the 
system

Ink level information
[12] 

There are four indication types.
■ Percentage of ink in a tank (1% - 100%).
■ 'Ink tank empty' (0%). The indication for the 

empty tank blinks and an exclamation symbol is 
added.

■ The ink tank is not in place. The indication shows 
a dashed indication for the tank.

Printhead information
[13] 

The status of each printhead. There are two status 
types.
■ All printheads OK
■ Printhead error

System information
[14] 

■ Error messages and warnings about the 
maintenance cassette.

Select the lower left softkey 'Demo print' to do the 
following.
■ Make a demo print.
■ Print an overview of the current Settings Editor 

settings.
■ Print a quality check print.
■ Print a tone scale area check print.

Select the lower right softkey 'Language'  to do the 
following.
■ Toggle between two display languages.
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The on-line mode and the off-line mode

The off-line mode

Press the on-line / off-line key to enter the off-line mode. When the printer is in the 
off-line mode, the green LED is off. The printer operator panel displays a set of 
wizards. A wizard always requires a user action. When you initially enter the off-line 
mode, the printer operator panel displays the wizards 1 and 2. The next time you 
enter the off-line mode, you return to the previous position.

[15] 

[15] The off-line mode

Use the upper softkeys to navigate through the wizard cards (graphical 
representation of the wizards) and through the wizard steps ('Back', 'Next'). Use the 
lower softkeys to select a wizard card or an option within the wizards.
You can select the following wizards.

[13] 

[13] Overview Océ TCS500 printer wizards (1 – 2)

Wizard Reference

'Feed & cut'
[16] 

(see ‘Cut the output and clean cut a roll of media’ on 
page 154)
Use this wizard to do the following.
■ Cut the output.
■ Clean cut a roll of media. Use this option to cut the 

roll so that the edge is straight.

'Change media type'
[17] 

(see ‘Replace the media’ on page 239)
Use this wizard to correct the type of media when an 
incorrect media type was defined when the roll was 
loaded.

'Optimise print quality'
[18] 

(see ‘Use the Optimise print quality wizard’ on page 215)
Use this wizard to correct problems with the output 
quality. The wizard performs the following actions.
■ Detect weak or failing nozzles. 

The Océ TCS500 automatically compensates the 
detected nozzles in future prints to make sure that 
print quality is optimal.

■ Align the printheads and optimise the paper transport.
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'Replace printhead'
[19] 

(see ‘Replace a defective printhead’ on page 249)
Use this wizard to replace a defective printhead, after the 
printer operator panel displays an error message and 
prompts you to replace the defective printheads. Only 
replace the printheads the system indicates.

'Replace cassette'
[20] 

(see ‘Replace the maintenance cassette’ on page 254)
Use this wizard to replace the maintenance cassette, after 
the printer operator panel displays the message 
'Maintenance cassette nearly full.'.

'Replace ink tank'
[21] 

(see ‘Replace the ink tanks’ on page 246)
Use this wizard to replace the ink tank when the ink level 
indicator on the printer operator panel shows 0%. The 
indicator flashes when the ink tank is empty.

'Display counters'
[22] 

Select this wizard to check the amount of media and ink 
that is used since the system was installed. Press the 
softkey for 'Finish' to return to the off-line screen.

'Configure system'
[23] 

(see ‘Configure the network settings of the Océ TCS500’ 
on page 66) 
You can perform the following actions in the 'Configure 
system' wizard.
■ Configure the network settings.
■ Clear the set memory (see ‘Clear the set memory’ on 

page 268).
Use this option for a damaged job that you cannot 
delete in the Océ Queue Manager.

'Language'
[24] 

Toggle between the two languages that you defined in the 
Océ Settings Editor. (see ‘Define the display language of 
the Océ TCS500’ on page 62)

[13] Overview Océ TCS500 printer wizards (2 – 2)

Wizard Reference
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The finishing options

The finishing options

The finishing options

Introduction

It is possible to expand your Océ TCS500 printer with one of the following finishing 
options. 



41

The finishing options

The finishing options
[14] 

Note: You can not use both a Copy Receiving Rack and a folder.

[14] The  finishing options 

Component Function Position of the component

Integrated 
Receiving 
Tray

This option is advised 
for a low production 
environment and a lot 
of same size output.
The Integrated 
Receiving Tray is not 
available for the 3 roll 
version.

[25] 

[25] The Integrated Receiving Tray

Copy 
Receiving 
Rack

Collects output at the 
rear side of the printer. 
This option is advised 
for a higher production 
environment. The copy 
receiving rack can 
collect a maximum of 
100 prints.

[26] 

[26] The Copy Receiving Rack

Folder Folds the output
[27] 

[27] The folder (Estefold)
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The optional copy receiving rack

Introduction

The copy receiving rack is a movable tray that you can place behind the printer. The 
copy receiving rack is an option for the 1-roll configuration and the 2-roll 
configuration of the Océ TCS500 printer, but is required when you have a 3 roll 
configuration.

Purpose

Use the copy receiving rack to collect the printed output. You need to adjust the copy 
receiving rack before you can collect the printed output. How to adjust the copy 
receiving rack depends on the type of print job that you run.

The components
[28] 

[28] The optional copy receiving rack
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[15] 

How to adjust for standard print jobs

Attention: The copy receiving rack can collect a maximum of 15 prints in this 
position. When you try to collect more prints, the prints can get damaged.

1. Place the rack with side I against the back of the printer.
2. Secure the rack with the breaks of the wheels.
3. Place the trailing edge stoppers at the end of the tray.
4. Adjust the rack with the guides into the position marked with the following figure.

[29] 

[29] Rack adjustment for standard print jobs
Use the handles on the left and right guide to lower the tray.
Take the end of the tray to lift the tray.

Note: The position of the leading edge stopper is not important in this situation.

How to adjust for productive print jobs with  same media sizes

Attention: The copy receiving rack can collect a maximum of 100 prints in this 
position.

1. Place the rack with side II against  the back of the printer.
2. Secure the rack with the breaks of the wheels.
3. Place the trailing edge stoppers at the end of the first sheet for a straight stack.
4. Adjust the rack with the guides into the position marked with the following figure.

[15] The components and functions of the copy receiving rack 

Nr. Component Function

1 Adjust guides Adjust the rack

2 Leading edge stopper Stop the print at the leading edge

3 Trailing edge stopper Stop the print at the trailing edge

4 Left and right handle Lower the rack

5 End of the rack Lift the rack
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[30] 

[30] Rack adjustment for productive print jobs with same media sizes
Use the handles on the left and right guide to lower the tray.
Take the end of the tray to lift the tray.

5. Adjust the leading edge stopper into the position that is equal to the size of the print.
The marks on the leading edge stopper show the cut length in portrait direction.
Press the handle on the leading edge stopper to adjust the leading edge stopper.

Note: You can collect all types of media in this position except Photo-gloss and 
Film.

How to adjust for productive print jobs with different media sizes

Attention: The copy receiving rack can collect a maximum of 100 prints in this 
position.

1. Place the rack with side II against  the back of the printer.
2. Secure the rack with the breaks of the wheels.
3. Place the trailing edge stoppers at the tray.
4. Adjust the rack with the guides into 1 of the 4 positions marked with the following 

figure to find the balance for the longest print.
[31] 

[31] Rack adjustment for productive print jobs with different media sizes
Use the handles on the left and right guide to lower the tray.
Take the end of the tray to lift the tray.

5. Adjust the leading edge stopper into the position that is equal to the size of the 
shortest print.
The marks on the leading edge stopper show the cut length in portrait direction.
Press the handle on the leading edge stopper to adjust the leading edge stopper.
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How to adjust for productive print jobs with humid prints

Attention: The copy receiving rack can collect a maximum of 100 prints in this 
position.

1. Place the rack with side II against the back of the printer.
2. Secure the rack with the breaks of the wheels.
3. Place the trailing edge stoppers at the tray.
4. Adjust the rack with the guides into the position marked with one of the following 

figures.
[32] 

[32] Rack adjustment for standard print jobs with humid prints
[33] 

[33] Rack adjustment for standard print jobs with very humid prints

Use the handles on the left and right guide to lower the tray.
Take the end of the tray to lift the tray.

Note: The mark for very humid prints is at the bottom of the adjust guides. Lift and 
turn the guides to adjust the rack into the position for very humid prints.
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Introduction

Introduction
This chapter contains all the information you need to prepare your Océ TCS500 for 
use. You can learn more about the following.
Turn on and off the Océ TCS500.
Set the Océ TCS500 scanner timers.
Set the Océ TCS500 printer timers.
Define the display language of the Océ TCS500.
Configure the network settings of the Océ TCS500.
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Turn on and off the Océ TCS500

Turn on and off the Océ TCS500 printer and the Océ Power 
Logic® Controller 

Introduction

The Océ Settings Editor application contains an important setting for the start up and 
shut down of the printer and Océ Power Logic® controller. 

The path of the setting is the following.
■ Key Operator - Printer - Settings - Synchronise controller power on / off.

Depending on this setting, you can turn on and off the Océ TCS500 printer and the 
Océ Power Logic® controller together or separately.
You can define if this setting is 'On' or 'Off'. 

The following paragraphs describe how to turn on and off the Océ TCS500 when the 
above setting is set to either 'On' or 'Off'.

The Océ TCS500 printer and Océ Power Logic® controller have 2 energy save modes 
that enable you to prevent unnecessary power consumption when the system remains 
turned on in an idle state (see ‘The energy save mode timer’ on page 58) an (see ‘The 
sleep mode timer’ on page 60).

Note: The Océ TCS500 printer has a separate main power switch on the backside 
of the printer. Set this main power switch to the position 1, after you connect the Océ 
TCS500 printer to the main power supply with the main power cable.
The main power switch must be set to the position 1, before you can turn the system 
on, as described below
Only set the main power switch to the position 0 if you want to disconnect the Océ 
TCS500 printer from the main power supply, for example in case you want to move 
your printer to another location or in case your printer will not be used for a longer 
period of time (weeks).
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[34] 

[34] The power switch on the backside of the printer.

Turn on the Océ Power Logic® controller and the printer
[35] 

[35] The On / off button of the printer (front)
[16] 

Note: When you turn on the Océ Power Logic®controller, the Océ Power 
Logic®controller needs some preparation time before it can handle jobs. The 
preparation time for print jobs is two and a half minutes.

Setting Key Operator - 
Printer - Settings - 
Synchronise controller 
power on / off

Action

Set to 'On' Press the On / off button on the printer
The Océ Power Logic® controller and the printer 
both start up.

Set to 'Off'. 1. Press the On / off button on the Océ Power Logic® 
controller.
2. Press the On / off button on the printer.
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Turn off the Océ Power Logic® controller and the printer

There are 2 possibilities.

[17] 

Note: The Océ Power Logic ®controller needs a few minutes to finish the shut down 
process. To turn off the main power, wait until the shut down process has finished.

SettingKey Operator - 
Printer - Settings - 
Synchronise controller 
power on / off

Action

Set to 'On' ■ Press the On / off button on the printer, or
■ From the 'System' menu in the Océ System 

Control Panel, select 'Shut down'.

The Océ Power Logic® controller and the printer 
both shut down.

Set to 'Off'. ■ Press the On / off button on the printer.  (The 
printer shuts down.)

■ Open the Océ System Control Panel application 
on the Océ Power Logic® controller.

■ From the 'System' menu, select 'Shut down'. (The 
Océ Power Logic® controller shuts down.)
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Turn on and off the Océ TCS500 scanner

Turn on and off the Océ TCS500 scanner

Introduction

When you turn on the Océ TCS500 scanner, the Océ TCS500 scanner needs some 
preparation time before it can handle jobs. The preparation time for scan-to-file and 
copy jobs is less than twenty seconds.

Illustration
[36] 

[36] The on / off switch at the right of the Océ TCS500 scanner

Turn on the Océ TCS500 scanner

1. Set the on / off switch at the right to position 1.
The green light at the operator panel illuminates.

Turn off the Océ TCS500 scanner

1. Set the on / off switch at the right to position 0.
The green light at the operator panel is turned off.
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Set the Océ TCS500 scanner timers

Overview of the  Océ TCS500 scanner timers

Introduction

You can use timers to define the behaviour of the Océ TCS500 scanner if the Océ 
TCS500 scanner remains unused for a time.

The Océ TCS500 scanner timers

The Océ TCS500 scanner has three timers that are always enabled. You can define 
the time-out settings for each timer in the Océ Settings Editor.
■ The set time-out of an opened set in a copy job.

When the scanner remains unused for a time after a set was opened, the set closes 
automatically. (see ‘The set timer’ on page 55)

■ The panel  time-out of the scanner operator panel.
When the scanner operator panel remains unused for a time, the scanner operator 
panel returns to the home screen automatically. The Océ TCS500 scanner is 
ready for the next user. (see ‘The panel timer’ on page 56)

■ The sleep mode time-out of the scanner.
When the Océ TCS500 scanner remains unused for a time, the Océ TCS500 
scanner enters the sleep mode automatically and saves energy. When the Océ 
TCS500 scanner enters the sleep mode, the job settings are set to default. (see 
‘The sleep mode timer’ on page 57)

Automatic behaviour of the unused Océ TCS500 scanner

The automatic behaviour of the scanner when the scanner is unused for a while 
depends on two items, the values of the time-out settings and the status of the 
scanner.

The time-out settings

You are advised to define the time-out settings in the following order.
■ Define the set time-out to the lowest value according to the sleep mode time-out 

and the scanner operator panel time-out setting.
■ Define the scanner operator panel time-out to the middle value according to the 

sleep mode time-out and the set time-out setting.
■ Define the sleep mode time-out as the highest value according to the set time-out 

and scanner operator panel time-out setting.
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Overview of the Océ TCS500 scanner timers

The status of the scanner

Depending on the status of the scanner and the scanner operator panel, the Océ 
TCS500 scanner shows different behaviour if you stop to use the scanner.

[18] 

[18] Automatic behaviour, depending on the status of the scanner 

When Then

The scanner operator panel was used for 
a copy or scan-to-file job.

The scanner operator panel returns to 
the home screen when the scanner 
operator panel time-out expires. The 
settings are set to default. The scanner 
enters the sleep mode when the sleep 
mode timer expires.

The scanner operator panel was used to 
copy a set.

The set will close when the set time-out 
expires. The scanner operator panel 
returns to the home screen when the 
scanner operator panel time-out expires. 
The settings are set to default. The 
scanner enters the sleep mode when the 
sleep mode timer expires.
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The set timer

Introduction

The set timer is only activated in case you want to copy a set.
When the scanner operator panel remains unused for a period of time after a set was 
opened, the set closes automatically.
Use the set timer to define this period of time. The set timer is always enabled. You 
can use the Océ Settings Editor to change the set time-out setting of the Océ TCS500 
scanner.

The set time-out

The default value for the set time-out is 120 seconds.
If you must change the default value in the Océ Settings Editor proceed as follows.

[19] 

[19] Change the Key Operator settings in the Océ Settings Editor  

Step Action

1 Click 'File' and select 'Log on'.

2 Select 'Key Operator' and enter the password.

3 Click 'View' and select 'Key Operator  settings'.

4 Navigate to the set time-out setting.
Key Operator - Scanner - Timers - Set time-out

5 Change the value.

6 Click 'Apply'.

7 Click 'File' and select 'Log off' to prevent unauthorised use.
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The panel timer

The panel timer

Introduction

When the scanner operator panel remains unused for period of time, the scanner 
operator panel returns to the home screen automatically. The Océ TCS500 scanner 
is ready for the next user.
Use the panel timer to define this period of time. The panel timer is always enabled. 
You can use the Océ Settings Editor to change the panel time-out setting of the Océ 
TCS500 scanner.

The panel time-out

The default value for the panel time-out is 90 seconds.
If you must change the default value in the Océ Settings Editor proceed as follows.

[20] 

[20] Change the Key Operator settings in the Océ Settings Editor  

Step Action

1 Click 'File' and select 'Log on'.

2 Select 'Key Operator' and enter the password.

3 Click 'View' and select 'Key Operator  settings'.

4 Navigate to the panel time-out setting.
Key Operator - Scanner - Timers - Panel time-out

5 Change the value.

6 Click 'Apply'.

7 Click 'File' and select 'Log off' to prevent unauthorised use.
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The sleep mode timer

Introduction

If the Océ TCS500 scanner is not used for a longer period of time, the Océ TCS500 
scanner enters the sleep mode automatically to save energy and the job settings are 
set to default.
Use the sleep mode timer to define this period of time. The sleep mode timer is 
always enabled. You can use the Océ Settings Editor to change the sleep mode 
time-out setting of the Océ TCS500 scanner.

The sleep mode time-out

The default value for the sleep mode time-out is 15 minutes.
If you must change the default value in the Océ Settings Editor proceed as follows.

[21] 

[21] Change the Key Operator settings in the Océ Settings Editor  

Step Action

1 Click 'File' and select 'Log on'.

2 Select 'Key Operator' and enter the password.

3 Click 'View' and select 'Key Operator  settings'.

4 Navigate to the sleep mode time-out setting.
Key Operator - Scanner - Timers - Sleep mode time-out

5 Change the value.

6 Click 'Apply'.

7 Click 'File' and select 'Log off' to prevent unauthorised use.
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The energy save mode timer

Set the Océ TCS500 printer timers

The energy save mode timer

Introduction

The Océ TCS500 printer has 2 modes to prevent unnecessary power consumption.
■ The energy save mode.
■ The sleep mode.

This section describes the energy save mode.

The energy save mode

The Océ TCS500 printer uses less energy in the energy save mode than in the normal 
operating mode.
Both the printer and the Océ Power Logic® controller remain turned on.
You can define the following energy save mode settings in the Océ Setting Editor.

[22] 

Note: By default, the 'Energy save mode timer' is enabled and the 'Energy save 
mode time-out' is set to 5 minutes.

If you must change the default settings in the Océ Settings Editor proceed as follows.

[22] Energy save mode settings in the Océ Setting Editor 

Key Operator - Printer - Settings - 
Timers - Energy save mode timer 
enable - Energy save mode timer

Key Operator - Printer - Settings - 
Timers - Energy save mode time-out

Enabled Use this setting to define the delay in 
minutes before the Océ TCS500 printer 
enters the energy save mode.

Disabled Not applicable
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[23] 

When the Océ TCS500 is in the energy save mode, there are four ways to activate 
the system. 

■ press a key on the printer operator panel 
■ send a job 
■ press the retract button to retract a roll 
■ load a roll

[23] Change the Key Operator settings in the Océ Settings Editor   

Step Action

1 Click 'File' and select 'Log on'.

2 Select 'Key Operator' and enter the password.

3 Click 'View' and select 'Key Operator  settings'.

4 Navigate to the energy save mode settings.
Key Operator - Printer - Settings - Timers - Energy save mode timer 
enable - Energy save mode timer
Key Operator - Printer - Settings - Timers - Energy save mode time-out

5 Change the required settings.

6 Click 'Apply'.

7 Click 'File' and select 'Log off' to prevent unauthorised use.
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The sleep mode timer

The sleep mode timer

Introduction

The Océ TCS500 printer has 2 modes to prevent unnecessary power consumption.
■ The energy save mode.
■ The sleep mode.

This section describes the sleep mode.

The sleep mode

The Océ TCS500 printer uses less energy in the sleep mode than in the normal 
operating mode and even less energy than in the energy save mode.
The power supply of the printer is turned off in the sleep mode. The Océ Power 
Logic® controller remains turned on.
You can define the following sleep mode settings in the Océ Setting Editor.

[24] 

Note: By default, the 'Sleep mode timer' is enabled and the 'Sleep mode time-out' is 
set to 30 minutes.

If you must change the default settings in the Océ Settings Editor proceed as follows.

[24] Sleep mode settings in the Océ Setting Editor 

Key Operator - Printer - Settings - 
Timers - Sleep mode timer enable - 
Sleep mode timer

Key Operator - Printer - Settings - 
Timers - Sleep mode time-out

Enabled Use this setting to define the delay in 
minutes before the Océ TCS500 printer 
enters the sleep mode.

Disabled Not applicable
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[25] 

When the Océ TCS500 is in the sleep mode, there are two ways to activate the 
system. 

■ send a job 
■ press the On / off button of the printer

The printer needs about 1 minute to wake up from the sleep mode. The green LED 
illuminates. This indicates that the system wakes up. During the wake-up period, the 
screen remains blank.

Note: The sleep mode complies with the EPA Energy Star® sleep mode requirements 
for wide format printers.

[25] Change the Key Operator settings in the Océ Settings Editor  

Step Action

1 Click 'File' and select 'Log on'.

2 Select 'Key Operator' and enter the password.

3 Click 'View' and select 'Key Operator  settings'.

4 Navigate to the sleep mode settings.
Key Operator - Printer - Settings - Timers - Sleep mode timer enable - 
Sleep mode timer
Key Operator - Printer - Settings - Timers - Sleep mode time-out

5 Change the required settings.

6 Click 'Apply'.

7 Click 'File' and select 'Log off' to prevent unauthorised use.



62 Chapter 3 Prepare the Océ TCS500 for use

Define the display language of the Océ TCS500

Define the display language of the Océ TCS500

Introduction

The Océ Settings Editor allows you to define the 'First language' (the default display 
language) and the 'Second language' (the alternative display language) for the 
following components.
■ The controller applications (Océ Settings Editor, Océ System Control Panel, Océ 

Queue Manager)
■ The printer operator panel
■ The scanner operator panel

If you have a keyboard, mouse and monitor with your Océ Power Logic® controller, 
you can access the controller applications locally on the controller. If you do not have 
a keyboard, mouse and monitor with your Océ Power Logic® controller, you must 
use Océ Remote Logic® to connect to the controller applications.

The 'First language' and the 'Second language' you defined in the Océ Setting Editor 
are also the display languages that are available on the printer operator panel and the 
scanner operator panel. You can toggle between these two languages using the 
operator panel.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps 
to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key Operator' and enter the password.

How to define the default and the alternative display languages

1. Click 'View' and select 'Key Operator  settings'.
2. Navigate to Key Operator - System - Regional settings - Display languages - 

First language.
3. Define one of the available languages as the default language.
4. Navigate to Key Operator - System - Regional settings - Display languages - 

Second language
5. Define one of the available languages as the alternative language.
6. Click 'Apply' to confirm the settings.
7. Click 'File' and select 'Log off' to prevent unauthorised use.
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How to change the display language of the controller applications

1. Open the 'View' menu of the controller application (Océ Settings Editor, Océ System 
Control Panel, Océ Queue Manager).

2. Select 'Language'.
3. Select one of the languages.

The display language of the controller application changes to the selected language.

Note: If you connect to the controller from Océ Remote Logic® and you must change 
the display language, all languages are available and only the display language of 
your current application will change. 

Note: If you use the controller applications locally on the controller you can only 
toggle between the first language (default language) and the second language 
(alternative language)   and the display languages of all the controller applications 
will change at the same time.

How to change the display language on the on-line screen of the printer operator 
panel

Note: Only the first language (default language) and the second language 
(alternative language) defined in the Océ Settings Editor are available on the 
operator panels.

4. Use the upper softkeys to select the 'System' tab.
5. Press the lower right softkey to toggle between the first language and the second 

language.
[37] 

[37] Press the lower-right softkey to change the language
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How to change the display language on the off-line screen of the printer operator 
panel

Note: Only the first language (default language) and the second language 
(alternative language) defined in the Océ Settings Editor are available on the 
operator panels.

6. Press the on-line / off-line key to set the printer off-line.
7. Use the upper softkeys to scroll to the 'Language' card.

[38] 

[38] The language card on the off-line screen
8. Press the softkey below the 'Language' card to toggle between the first language and 

the second language.

How to change the display language on the scanner operator panel

Note: Only the first language (default language) and the second language 
(alternative language) defined in the Océ Settings Editor are available on the 
operator panels.

9. Press the upper left softkey to return to the home screen.
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[39] 

[39] The home screen of the scanner
10. Press the lower left softkey, below the display, to toggle between the first language 

and the second language.

1 2 3 4 5 6 7 8 9 0
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Configure the network settings of the Océ TCS500

Introduction

The system administrator is responsible for installing and configuring the Océ 
TCS500 in the network environment. There are two ways to configure the network 
settings.
■ From the printer operator panel

The off-line screen on the printer operator panel contains a wizard to configure 
the network settings.

■ With the System Administrator settings in the Océ Settings Editor.
The Océ Settings Editor allows you to configure a large number of system 
settings. Only the system administrator is authorised to define the system 
settings.

Actions in the Configure system wizard

You can perform the following actions in the 'Configure system' wizard.
■ Enable DHCP
■ Set the IP address
■ Set the IP subnet mask
■ Set the default gateway
■ Configure  the DNS settings
■ Configure  the primary and secondary WINS
■ Clear the set memory. (see ‘Clear the set memory’ on page 268).

Use this option for a damaged job that you cannot delete in the Océ Queue 
Manager.

The 'Configure system' wizard also contains installation settings and service 
settings. A password protects the installation settings and the service settings. Only 
Océ service engineers can access the installation settings and the service settings.

How to configure the system from the printer operator panel 

1. Press the on-line / off-line key to set the printer off-line  
(see ‘The on-line mode and the off-line mode’ on page 36).

2. Use the upper softkeys to scroll to the 'Configure system' card.
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[40] 

3. Press the softkey below the 'Configure system' card to enter the wizard.
The screen displays the message 'Use this wizard to configure the system.'

4. Press the key for 'Next'.
The screen displays the message 'Select item.'

5. Use the lower softkeys to select 'Network settings adapter 1'.
[41] 

6. Press the key for 'Next'.
7. The screen displays the current settings for the selected adaptor. The system 

indicates which settings are received through DHCP with a round dot.
Use the lower softkeys to scroll through the settings. Press the key for 'Edit', to 
change the network settings.

8. The screen displays 'Use DHCP server for adapter 1?'. Use the lower softkeys to 
select 'Yes' or 'No'.

[42] 

Continue with step 9 when you select 'Yes'.
Continue with step 10 when you select 'No'.
Press the key for 'Undo', to cancel your settings.

9. After you select 'Yes', press the key for 'Next'.
The wizard will lead you through a series of dialogues where you can enable DHCP 
or define the IP addresses for the following.
■ The default gateway
■ DNS
■ WINS.
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After you completed all dialogues, the screen shows an overview of all the network 
settings.
Press the key for 'Apply' to confirm the settings and to exit the wizard
The system indicates whether you have to reboot the Océ Power logic controller to 
apply the new network settings. This can, for example,  be the case when settings are 
received through DHCP. When no indication appears, you do not need to reboot the 
Océ Power logic controller.

Note: When 'Synchronise controller power on / off' is set to 'On', you must turn the 
printer off and on to reboot the Océ Power Logic controller.

10. After you select 'No', press the key for 'Next' to manually define the network settings.
11. The screen displays 'Set IP address for adapter 1'.

[43] 

Press the keys for '-' and '+' to define the IP address.
After you finish an octet, press the key for 'Next' to go to the next octet.

12. Press the key for 'Next' after you finish the last octet. The screen displays 'Set subnet 
mask for adapter 1'.

[44] 

Press the keys for '-' and '+' to define the subnet mask.
After you finish an octet, press the key for 'Next' to go to the next octet.

13. Press the key for 'Next' after you finish the last octet. The screen displays 'Set default 
gateway for adapter 1'.

[45] 

Press the keys for '-' and '+' to define the default gateway.
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After you finish an octet, press the key for 'Next' to go to the next octet.
14. After you finish the last octet, the wizard will lead you through a series of dialogues 

where you can configure DNS, and the primary and secondary WINS.
15. After you completed these dialogues, the screen shows an overview of all the 

network settings.
[46] 

16. The final dialogue allows you to define a password protection for the 'Configure 
system' wizard. You can enable the password protection to prevent accidental 
changes in the configuration of the system.
The password is fixed and cannot be changed. Use the lower left (= a) and right (= 
b) soft keys of the operator panel to enter the password: abbab. When the 
password-protection is enabled, you must enter this password the next time you want 
to edit the network settings. You can disable the password protection again at the end 
of the 'Configure system' wizard.

17. Press the key 'Apply' to confirm the settings and to exit the wizard.
The system indicates whether you have to reboot the Océ Power logic controller to 
apply the new network settings. This can, for example, be the case when settings are 
received through DHCP. When no indication appears, you do not need to reboot the 
Océ Power logic controller.

Note: When 'Synchronise controller power on / off' is set to 'On', you must turn the 
printer off and on to reboot the Océ Power Logic controller.

How to configure the system from the Océ Settings Editor

1. Log on to the system administrator mode.
2. From the 'View' menu in the menu bar, select 'System Administrator settings'.
3. Use the buttons on the left toolbar to display the required group of settings.
4. Select the required settings in the tree structure.
5. Define the settings in the update area.
6. Click the 'Apply' button to confirm the new settings.
7. Log off from the system administrator mode to prevent unauthorised use of the 

application.
See the on-line help in the Océ Settings Editor for more information about how to 
configure the system from the Océ Settings Editor.
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Configure the network settings of the Océ TCS500
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Introduction

Introduction

Introduction

The Océ Power Logic  controller applications have two important main roles.
■ Set up the Océ TCS500 to your specific requirements to create the most 

productive workflow.
■ Control your workflow for the print jobs.

Set up your workflow  with the Océ Settings Editor

The Océ TCS500 offers a lot of settings to optimise your workflow. Use the Océ 
Settings Editor to define the most used settings for your jobs. Open the Océ Settings 
Editor to get a complete overview of the available settings. Refer to the on-line help 
of the Océ Settings Editor for an explanation of each setting.

Control your workflow

The  Océ TCS500 offers the following applications to control your workflow.

■ Océ System Control Panel
■ Océ Queue Manager
■ Océ License Logic

See the on-line help files of these applications for a complete overview of the 
application.
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Start the Océ Power Logic® controller applications

Introduction

You can start the Océ Power Logic® controller applications locally on the controller 
or from a remote workstation. This section describes how to start the applications 
locally on the Océ Power Logic® controller. The section 'Start the applications with 
Océ Remote Logic®' describes how to start the applications from a remote 
workstation (see ‘Start the applications with Océ Remote Logic®’ on page 117).

Start the applications locally on the Océ Power Logic® Controller

1. Select the 'Launcher' application.
2. Select the required application.

The application starts with your default system.
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Use the Océ Settings Editor to control 
your workflow

Introduction to the Océ Settings Editor

Definition

This chapter gives information about the Océ Settings Editor. The on-line help of the 
Océ Settings Editor application contains exact information about specific settings.

You can access the Océ Settings Editor locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller. You must use 
Océ Remote Logic® to connect to the Océ Settings Editor when you do not have a 
keyboard, mouse and monitor with your Océ Power Logic® controller.

Description of the Océ Settings Editor

Use the Océ Settings Editor to define the default settings for the system according to 
your requirements.

The Océ Settings Editor contains the following types of settings.
■ Key Operator settings
■ System Administrator settings

A password protects the 'Key Operator  settings' and the 'System Administrator 
settings'.  (see ‘The Océ TCS500 users’ on page 19) for the default passwords. 
Without a password, you can only view the settings.

The key operator is allowed to change the following groups of settings  
(see ‘Define the settings in the Océ Settings Editor’ on page 81).
■ Job settings for the print jobs
■ Printer settings
■ System settings

The system administrator is allowed to change the following groups of settings  
(see ‘Define the settings in the Océ Settings Editor’ on page 81).
■ Printer Description Language settings
■ Pen settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings
■ Media profiles settings (and install new media profiles)

In the 'Anonymous' mode, the operator is not logged on. The anonymous user is 
allowed only to view the settings.
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The user interface of the Océ Settings Editor

Introduction

The Océ Settings Editor has the following fields.
1. The menu bar
2. The top toolbar
3. The left toolbar
4. The settings area
5. The status bar

Illustration
[47] 

[47] The structure of the Océ Settings Editor
[48] 

[48] The menu bar
[49] 

[49] The top toolbar
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The user interface of the Océ Settings Editor

[50] 

[50] The left toolbar
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[51] 

[51] The settings area
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The user interface of the Océ Settings Editor

The menu bar
[26] 

The top toolbar
[27] 

[26] The menu bar items 

Menu Function

'File' ■ Log on to a user mode
■ Log off from the previous user mode
■ Open a file that contains saved settings
■ Save the current settings to a file
■ Connect to a different controller ( for remote users 

only).
■ Close the application.

'Edit' ■ Define the host name
■ Define the default system you want to connect to at the 

start-up
■ Use 'Automatic logon', to start the Océ Settings Editor 

application automatically in the defined user mode.
■ Licences

'View' ■ Toggle between the display languages
■ Toggle between the display of the Key Operator 

settings and the System Administrator settings.

'Help' ■ Access the contents of the on-line help
■ Get more information about the copyright and the 

version of the application.

[27] The buttons of the top toolbar (1 – 2)

Button Function

'Open' Open a file that contains saved settings.

'Save as...' Save all the Key Operator settings or the System 
Administrator settings in a file.
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The left toolbar
[28] 

Click a button to access the special group of settings of this button. A shadow 
highlight indicates which button is activated.

The on-line help in the Océ Settings Editor includes complete information about the 
different settings.

'Apply' Apply the changes you made to the settings.

Note: The button is enabled after you change a 
setting. The button is disabled after you apply 
the settings, or after an undo action.

'Undo' Restore the settings to the state before the settings were 
changed. The 'Undo' button does not restore the factory 
default.

Note: The button is enabled after you change a 
setting. The button is disabled after you apply a 
changed setting.

[27] The buttons of the top toolbar (2 – 2)

Button Function

[28] The buttons of the left toolbar 

Button Function

'Jobs' Gives access to the settings for the jobs.

Note: The 'Jobs' button is only available in the 
key operator view.

'Printer' Gives access to the settings for the printer.

'System' Gives access to the settings for the system.

'Scanner' Gives access to the settings for the scanner.
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The settings area
[29] 

The status bar

The status bar at the bottom of the Océ Settings Editor displays the following (from 
left to right).
■ The system status ('Connected' or 'Disconnected').
■ The system name ('Localhost' if you are working on the controller).
■ The user mode ('Key Operator', 'System Administrator' or 'Anonymous' (repro 

operator)).
■ The view mode ('Key Operator  settings' or 'System Administrator settings').

[30] 

[29] The parts of the settings area 

Part Function

Tree structure Display the settings.
Open a folder to show all the settings in that folder.
The display does not include the unavailable settings for the 
system components.

Update area Define the settings selected in the tree structure.
The update area can contain additional information 
(definition and values) about the selected setting.
Only authorised users can change the settings. If the user is 
not authorised to change a setting, the update area is greyed 
out.

[30] The icons for the connection status 

Icon Description
[52] 

The Océ Settings Editor is connected to a system.
[53] 

The Océ Settings Editor is not connected to a system.
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Define the settings in the Océ Settings Editor

Introduction

The Océ Settings Editor allows you to define the following settings.
■ 'Key Operator  settings'
■ 'System Administrator settings'

You need a password to change the 'Key Operator  settings' and 'System 
Administrator settings'(see ‘Log on to the controller applications’ on page 121).

Note: Only one key operator, system administrator or anonymous user (repro 
operator) at a time is authorised to change the settings. An error message appears 
when a second user tries to log on to the key operator mode or system administrator 
mode. Multiple users are authorised to view the settings.

How to define the key operator settings

1. Log on to the key operator mode.
2. Use the buttons on the left toolbar to display the required group of settings.
3. Select the required settings in the tree structure.
4. Define the settings in the update area.
5. Click the 'Apply' button to confirm the new settings.
6. Log off from the key operator mode to prevent unauthorised use of the application.

How to define the system administrator settings

1. Log on to the system administrator mode.
2. Use the buttons on the left toolbar to display the required group of settings.
3. Select the required settings in the tree structure.
4. Define the settings in the update area.
5. Click the 'Apply' button to confirm the new settings.
6. Log off from the system administrator mode to prevent unauthorised use of the 

application.
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Define the job templates for your scanner operator panel

Introduction

Job templates enable you to easily perform copy jobs and scan-to-file jobs that you 
do very often. Job templates appear on the scanner operator panel when you select 
'Copy' or 'Scan-to-file'.
A job template defines the following.

■ The top 5 settings.
You can select 5 settings that you want to see immediately when you open the job 
template at the scanner operator panel.  The top 5 settings are the settings that you 
need to change frequently if you use this job template. You can see the remaining 
settings when you scroll downwards.

■ The default values for  all available settings.
You can define a default value per setting. Define a value that you use very often.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps 
to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define a job template

1. Click 'View' and select 'KO settings'.
2. Navigate to Key Operator - Jobs - Copy - Copy job templates to define the copy 

job templates.
Navigate to Key Operator - Jobs - Scan to file - Scan to file job templates to define 
the scan-to-file job templates.

3. Define the job template name and the job template description.
4. Select the top 5 settings that you want to see on the scanner operator panel when you 

open the job  template.
5. Define the number of prints / sets.
6. Select a default value for all the settings that you want to pre-define for your job 

template. 
7. Click 'Apply' to confirm the settings.
8. Click 'File' and select 'Log off' to prevent unauthorised use.
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Define the automatic original feed setting

Introduction

This setting provides an easy method to feed a set of originals, because you only 
need to press the start key once. If you use this setting you can also define the original 
feed time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps 
to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key Operator' and enter the password.

How to define the auto original feed settings

1. Click 'View' and select 'Key Operator  settings'.
2. Navigate to Key Operator - Scanner - Auto original feed time-out.
3. Select 'On'.
4. Define the original feed time-out if necessary.
5. Click 'Apply' to confirm the settings.
6. Click 'File' and select 'Log off' to prevent unauthorised use.

Note: You can also define the auto original feed setting at the scanner operator 
panel. Select 'System' - 'Auto feed' - 'On'.

Result

Feed a set of originals in a more productive way. 
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Define the original release mode

Introduction

Use the original release mode setting to define if the scanner must hold or release the 
original after the scan procedure.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps 
to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key Operator' and enter the password.

How to define the original release mode

1. Click 'View' and select 'Key Operator  settings'.
2. Navigate to Key Operator - Scanner - Original release mode.
3. Select the required value.

You can select one of the following modes.
■ Hold the original at the front.
■ Release the original at the front.
■ Hold the original at the back.
■ Release the original at the back.

4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Note: You can also define the original release mode at the scanner operator panel. 
Select 'System' - 'Original release mode' - 'Release' / 'Hold' and 'Rewind''Yes' /'No'.

Result

The original release mode is defined.
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Define the media sizes

Introduction

Use this setting to define the default media range.

If you want to select a new media size on the operator panel of the printer, only the 
sizes in the defined media series are available.
When 'Auto format' is enabled, the 'Media sizes' setting selects which sizes are used 
(only those available in the 'Media sizes').

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps 
to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key Operator' and enter the password.

How to define the media series

1. Click 'View' and select 'Key Operator  settings'.
2. Navigate to Key Operator - System - Media - Media sizes.
3. Define the required value.

[31] 

4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Setting Group Values

'Media sizes' 'DIN' A4, A3, A2, A1, A0, E+, B1_707, 
B2_707

'DIN carto' A4, A3, A2, A1, A0, E+, B1_700, 
B2_700

'ANSI small' A, B, C, D, E, E+, 30 inch

'ANSI mixed' A, A+,  B, B+, C, C+,  D,  D+, E, 
E+, 30 inch
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Save, load and print the settings

Introduction

It is possible that you need different settings for different customers, departments or 
other conditions. For this reason, you can save the settings to a file and then load the 
settings from a file.

The Océ TCS500 has the following special files for your use.
1. Backup.kos/Backup.sas  

These files contain the previous values for the key operator settings and the system 
administrator settings before the last 'Apply'.

2. Current.kos/Current.sas  
These files contain the values for the key operator settings and the system 
administrator settings after the last 'Apply'.

If you need a complete overview of all settings defined in the Océ Settings Editor, 
you can print a list of all current settings.

How to save the settings to a file

1. From the 'File' menu, select 'Save as...'.
You can also click the 'Save as...' button on the toolbar.
If the client is a local client, the screen displays a dialogue box. The user can enter a 
file name. The file is saved in the specified directory on the system.
If the client is a remote client, the screen displays a dialogue box. The user can enter 
a directory name and a file name.

Note: Repro operators and anonymous users are not authorised to save the settings 
to a file.

How to load the settings from a file

1. From the 'File' menu, select 'Open'.
You can also click the 'Open' button on the toolbar.
The screen displays a dialogue box from where you can browse to the required file.

2. Click the 'Apply' button.
The settings are transferred to the system.
When you are logged on as a Key Operator, the system only loads the Key Operator 
settings.
When you are logged on as a System Administrator, the system only loads the 
System Administrator settings.
Repro operators and anonymous users are not authorised to load the settings from a 
file.
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How to print a list of the current settings

1. From the 'System' menu in the Océ System Control Panel, select 'Print settings'.
A list of the current settings on the Océ Power Logic® controller is printed.
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Use the Océ System Control Panel to 
control your workflow

Introduction to the Océ System Control Panel

Definition

The Océ System Control Panel application provides you with the following 
information about the status of the system.
■ Status of the printer
■ Descriptions of the different types and sizes of available media on the system
■ Status of the scanner
■ Status of the controller
■ The amount of set memory in use.

You can access the Océ System Control Panel locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller. If you do not 
have a keyboard, mouse and monitor with your Océ Power Logic® controller you 
must use Océ Remote Logic® to connect to the Océ System Control Panel.

See  'Océ Power Logic® controller: Océ Settings Editor' for information about how 
to start the application locally on the controller. 
(see ‘Start the Océ Power Logic® controller applications’ on page 73).
See 'Océ Power Logic® controller: Océ Remote Logic®' for information about how 
to start the application from a remote workstation.  
(see ‘Start the applications with Océ Remote Logic®’ on page 117).

User operations in the Océ System Control Panel

The Océ System Control Panel allows you to

■ Print your system configuration   
(see ‘Save, load and print the settings’ on page 86)

■ Clear the system memory (see ‘Clear the set memory’ on page 268) 
■ Shut down the system (see ‘Turn on and off the Océ TCS500 printer and the Océ 

Power Logic® Controller’ on page 49)
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The user interface of the Océ System Control Panel

Introduction

The Océ System Control Panel contains the following items.
1. The menu bar
2. The toolbar, with buttons to access the view area
3. The status of the printer
4. An overview of the loaded media types
5. The ink level indicators
6. The status of the Océ Power Logic® controller
7. The amount of set memory in use
8. The progress bar
9. The status bar

Illustration
[54] 

[54] The structure of the Océ System Control Panel
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The user interface of the Océ System Control Panel

The menu bar
[32] 

[32] The items of the menu bar 

Menu Items

'File' ■ Click 'Log on' to select the user mode. Then enter the password.
■ Click 'Log off' to leave the user mode.
■ Click 'Connect to' and select a different controller (only for 

remote users).
■ Click 'Close' to leave the Océ System Control panel.

'Edit' Click 'Options' to define the following.
■ The 'Host name'.
■ The 'Default system'.
■ The 'Automatic logon'. Use 'Automatic logon' to start up 

automatically in the defined user mode.
■ Select the two screen languages.

'View' ■ Select one of the display languages for the application.
■ Display the items for the status control. Click an item to view the 

status. The items correspond with the buttons of the toolbar.

'System' ■ Click 'Print settings' to print a report of the configuration 
settings.

■ Click 'Demo print' to make a demo print.
■ Click 'Clear system' to remove all the jobs from the system.
■ Click 'Shut down' to shut down the system.

'Help' ■ Click 'Contents' to access the topics of the on-line help.
■ Click 'About' for general information about the Océ System 

Control Panel.
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The toolbar

Click the buttons on the toolbar of the Océ System Control Panel to check the status 
of the items in the view area. If operator action is required, the appropriate button 
will flash.

[33] 

[33] The buttons of the toolbar 

Item Function

'Printer' View the status of the printer. If the printer operator panel displays 
an error, the 'Printer' status window of the Océ System Control Panel 
will display the same error.

'Media' View the status of the media (available, empty or disabled). The 
'Media' display also shows information about the available media 
sizes and media types.

Note: When a roll is disabled, the roll icon is greyed out. 
The text 'Disabled' replaces the media information.

'Ink' View the ink levels of the four colours.

'Scanner' View the status of the scanner.

'Controller' View the status of the controller.

'Memory' Check the amount of set memory that is available. The percentage 
on the right-hand side of the set memory metre indicates the amount 
of set memory in use. The colours indicate the following.
■ Green indicates that the set memory has sufficient space for a 

large print job or many small jobs.
■ Orange indicates that the set memory approaches the red zone. 

Large print jobs may not be possible.
■ Red indicates that the set memory is (nearly) full. The system 

does not accept new print jobs. Remove files or wait until files 
are printed and automatically removed from the memory.

Note: Define the threshold values for the orange zone 
and the red zone in the Océ Settings Editor.
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Icons

The status bar

The status bar at the bottom of the Océ System Control Panel displays the following.
■ The system status (connected or disconnected).
■ The system name ('Localhost' if you work on the Océ Power Logic® controller).
■ The user mode (Key operator, Repro operator, System administrator, Service 

operator or 'Anonymous').

[34] 

Icons
The Océ System Control Panel uses a number of icons to display the information 
about the media available on the printer. The following icons are used.

[35] 

[34] The icons of the status bar 

Icon Function
[55] 

The Océ System Control Panel is connected to a system.
[56] 

The Océ System Control Panel is not connected to a system.

Icon Description
[57] 

The media roll is available and the roll is ready to print
[58] 

The media roll is disabled.
[59] 

The media roll is enabled but empty.
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Introduction to the Océ Queue Manager

Definition

This chapter describes how to view and manage the jobs with the Océ Queue 
Manager.

You can access the Océ Queue Manager locally on the controller if you have a 
keyboard, mouse and monitor with your Océ Power Logic® controller.You must use 
Océ Remote Logic® to connect to the Océ Queue Manager when you do not have a 
keyboard, mouse and monitor with your Océ Power Logic® controller.

(see ‘Introduction to the Océ Settings Editor’ on page 74) for information about how 
to start the application locally on the controller.  
(see ‘Start the Océ Power Logic® controller applications’ on page 73).
(see ‘Start the applications with Océ Remote Logic®’ on page 117) for information 
about how to start the application from a remote workstation .

Description of the Océ Queue Manager

The Océ Queue Manager application provides you with a graphical image of the 
print queue, the history queue or the inbox queue

The Océ Queue Manager allows you to do the following.
■ View the queue of jobs.
■ Cancel the current job.
■ Delete jobs in the queue.
■ Place jobs on hold in the queue.
■ Print jobs from the history queue.
■ Print jobs from the inbox queue.
■ Move jobs to the top of the queue.
■ Give priority to jobs in the queue.
■ Restart the jobs that were placed on hold in the queue.
■ Change the attributes of a job.
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Introduction to the Océ Queue Manager

User modes

The Océ Queue Manager has the following user modes.
■ The key operator mode
■ The repro operator mode
■ The system administrator mode
■ The service operator mode.

Note: The service operator mode is for the Océ service engineer only.

The user modes provide the following permission.

The key operator, the repro operator and the system administrator user modes allow 
you to do the following.

■ to hold, and if necessary change the attributes of a job
■ to resume the printing of a job
■ to delete a job
■ to move a job to the top of the queue

The anonymous user mode only allows the user to view the queue. All the buttons 
and menu items are disabled in this mode. The anonymous user is allowed to delete 
the jobs when the user works locally with the Océ Queue Manager on the controller.

Note: The key operator, the system administrator and the repro operator have the 
same access permission to functions in the Océ Queue Manager and the Océ System 
Control Panel. The permission to access the settings in the Océ Settings Editor vary 
according to the different user modes.
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The user interface of the Océ Queue Manager

Introduction

This section contains an overview of the Océ Queue Manager application. Use the 
Océ Queue Manager to manage the jobs in the job queue.

Illustration
[60] 

[60] The Océ Queue Manager
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The structure of the Océ Queue Manager

The Océ Queue Manager contains the following items.

[36] 

The Océ Queue Manager uses columns to display the following information for each 
job.
■ The current status and the schedule of the job
■ The name of the job
■ The type of job (a print job or a copy job)
■ The name of the user who sent the print job
■ The number of sets and pages
■ Remarks.

Note: Drag the table header separators to change the width of the columns. Drag a 
column to a new position to change the sequence of the columns.

1. The menu bar

2. The tool bar

3. The window for the print queue

4. The window for the inbox queue or history queue

5. The status bar
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The menu bar
[37] 

The toolbar
[38] 

[37] The items of the menu bar 

Menu Items

'File' ■ Click 'Log on' to select the user mode. Then enter the 
password.

■ Click 'Log off' to leave the user mode.
■ Click 'Connect to' and select a different controller (only 

for remote users).
■ Click 'Close' to leave the Océ Queue Manager.

'Edit' Click 'Options' to define the following.
■ The 'Host name'.
■ The 'Default system'.
■ The 'Automatic logon'. Use 'Automatic logon' to start up 

automatically in the defined user mode.
■ Select the two screen languages.

'View' ■ Toggle between the defined display languages.
■ Toggle between the 'Inbox' queue and the 'History' queue.
■ Define the 'Column options'. Select the table headers you 

want to see when you open the Océ Queue Manager.

'Job' Display the actions for a job. The menu items correspond 
with the toolbar buttons.

'Help' ■ Click 'Contents' to access the topics of the on-line help.
■ Click 'About' for general information about the Océ 

Queue Manager.

[38] The toolbar buttons 

Button Function

'Hold' Place a job on hold in the print queue .

'Resume' Continue a job that was placed on hold.

'Move to top' Move a job to the top of the print queue, to give the job 
priority.

'Delete' Delete a job from the print queue.

'Properties' View or edit the properties of a selected job.

'Print' Print a job from the print queue.
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The status bar

The status bar at the bottom of the Océ Queue Manager displays the following.
■ The system status (connected or disconnected).
■ The system name ('Localhost' if you work on the Océ Power Logic® controller).
■ The job status (for example 'Printing').
■ The user mode ('Key Operator', 'Repro Operator', 'System Administrator', 

'Service Operator' or 'Anonymous').

The window for the print queue 

The print queue window in the left-hand pane contains two sections.
■ The top section above the separation line shows the job that is printed.
■ The bottom section under the separation line shows the jobs that wait to be 

printed. The window displays the jobs in the order in which the jobs are received.

The window for the inbox queue or history queue

The inbox queue in the right-hand pane contains the jobs that were sent to the inbox 
on the controller. You can print the jobs, delete the jobs and view the properties of 
the jobs. The print jobs are sent to the inbox when the setting Key Operator - 
System - Job management - Print jobs in the Océ Settings Editor is set to inbox or 
when 'Send to inbox' is enabled in the driver.

The history queue in the right-hand pane contains the jobs that have been printed. 
You can print the jobs, delete the jobs and view the properties of the jobs. Use the 
setting Key Operator - System - Job management - History queue - Print job 
lifetime in the Océ Settings Editor to define how long the jobs must remain in the 
history queue.
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User operations in the Océ Queue Manager

Introduction

The Océ Queue Manager allows you to do the following.
■ Print a job from the inbox queue or the history queue
■ Cancel jobs

This action deletes jobs from the print queue.
■ Place jobs on hold

This action places print jobs on hold. When you place jobs on hold other jobs take 
priority.

■ Change the attributes of jobs on hold
With this action you can change the properties of a job that is placed on hold.

■ Restart jobs on hold.
This action resumes jobs that were previous placed on hold.

■ Give priority to jobs.
This action changes the order of the jobs in the printer queue.

The Océ Queue Manager displays the jobs in the sequence that the jobs are received.

How to print jobs from the inbox queue or the history queue

1. Select the jobs in the inbox queue or the history queue.
Print jobs are sent to the inbox queue when the setting Key Operator - System - Job 
management - Print jobs is set to 'Inbox' or when you have enabled 'Send to inbox' 
in the printer driver.
After you print a job from the print queue, the job moves to the history queue.

2. From the 'Job' menu select 'Print', click the 'Print' button on the toolbar or right-click 
and select 'Print'.

3. The job moves to the print queue.
You can select more than one job with the mouse and the shift or control key.
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User operations in the Océ Queue Manager

How to cancel jobs from the Océ Queue Manager

Attention: You can never undo this action. The cancelled jobs are not saved in 
the history queue.

1. Select the jobs in the print queue, the history queue, or the inbox queue.
2. From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

A cross icon indicates the deleted job.
The system does not print the cancelled job.
You can select more than one job with the mouse and the shift or control key.

Note: An anonymous user cannot cancel a job from a remote system.

How to cancel active jobs from the Océ Queue Manager

Attention: You can never undo this action.

1. Select the active job in the print queue.
2. From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.

The printer stops the printing immediately.
If the controller was still processing part of the job, the controller flushes the job.

Note: An anonymous user cannot cancel a job from a remote system.

How to place jobs on hold in the Océ Queue Manager

1. Select the jobs in the print queue or the active print job.
2. From the 'Job' menu, select 'Hold', or click the 'Hold' button on the toolbar.

To put an active print  job on hold, press the stop button on the printer operator panel 
and then select the option 'Hold'. The job will then be put back in the print queue with 
the  'on hold' status. 
A job that is placed on hold keeps its position in the print queue. The job will not 
print until the job is resumed. While a job is on hold, other jobs are printed. The jobs 
that were in the queue behind the job on hold are also printed.
You can select more than one job with the mouse and the shift or control key.
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How to change attributes of jobs on hold in the Océ Queue Manager

1. Log on as a key operator or as a system administrator.
2. Select the job on hold in the inbox queue or the history queue.
3. Open the 'Job properties' dialogue box.

Use one of the following methods to open the 'Job properties' dialogue box.
■ From the 'Job' menu, select 'Properties' or, 
■ Click the 'Properties' button on the toolbar or, 
■ Right-click the job and select 'Properties'.

4. Select the 'Settings' tab in the 'Job properties' dialogue box.
5. You can change the number of sets in the 'Sets' field.
6. You can change the 'Media': 'Roll' 1 / 'Roll' 2 / 'Roll' 3. 
7. You can change the 'Colour mode': 'Colour' / 'Greyscale'
8. You can change the 'Quality mode': 'Check' / 'Release' / 'Presentation'.
9. Print the job as described in the paragraph above.

The system prints the indicated number of sets.

Note: For copy jobs you can only change the number of sets.

Note: Before you print a number of copies of a job, first make one print. Then you 
can make sure that you get the required output. If that is the case, you can print a 
number of copies. 

How to restart jobs in the Océ Queue Manager

1. Click the job that was placed on hold.
2. From the 'Job' menu, select 'Resume', or click the 'Resume' button on the toolbar.

The job restarts.
You can select more than one job with the mouse and the shift or control key.

How to give priority to jobs in the Océ Queue Manager

1. Select the jobs in the print queue.
2. From the 'Job' menu, select 'Move to top', or click the 'Move to top' button.

You can select more than one job with the mouse and the shift or control key.
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Icons

Icons
The Océ Queue Manager uses a number of icons to display information about a job 
in the queue. The following icons are used.

[39] 

Icon Description
[61] 

Receiving a job in the inbox or the print queue.
[62] 

Received a job in the print queue.
[63] 

Processing a job in the print queue.
[64] 

Processed a job in the print queue.
[65] 

An active job in the print queue (bold font and above the grey 
separation line).

[66] 

Printing a job.
[67] 

Delivering a job to the history queue.
[68] 

Delivered a job to the history queue.
[69] 

Deleted a job.
[70] 

A job that is put on hold by default . This icon indicates that the 
job is displayed in the inbox.

[71] 

A job is on hold.
[72] 

Warning, a media request.



103

Create destinations

Use the Océ Scan Manager to control 
your workflow

Create destinations

Introduction

You can scan to file to the following types of destination.
■ Local

The local destinations are temporary and can only contain a limited number of 
scanned files.

■ A network destination with SMB
■ An internet destination with FTP.

You can create a maximum number of 10 destinations.

Create a local destination

1. Select 'Destination' in the tree structure.
2. From the 'File' menu, select 'New'.

You can also click the 'New' button on the toolbar.
[73] 

The 'Destination properties' dialogue box opens.
[74] 

[74] The Destination properties dialogue box
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3. Enter a name for the destination in the 'Name' text box.
This name will appear on the scanner panel.

4. From the 'Type' drop-down list box, select 'On the controller'.
5. Enter a path of the target folder in the 'Path' text box. 

You can also click the 'Browse' button to select the path.
6. Click 'OK' to accept the destination properties.

Create a network destination with SMB

1. Create a shared folder on a workstation. For example c:\Scan.
2. From the 'File' menu on the Océ Scan Manager, select 'New'.

You can also click the 'New' button on the toolbar.
The 'Destination properties' dialogue box opens.

3. From the 'Type' drop-down list box, select 'SMB'.
4. Enter the system name of the workstation where you created the shared folder in the 

'System' text box.

Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

5. Enter a path of the target folder in the 'Path' text box.
The path name is the name of the shared folder on your workstation. For Windows 
NT® , Windows® 2000 and XP, use the DOS name of the shared folder. For Windows 
95/98® use the folder name. This is case sensitive.
You can also select a shared folder from the drop-down list.

6. If you defined a user name and a password for the shared folder on the workstation, 
then enter the user name and the password in the required fields.

Note: Make sure the user has write-access privileges on the destination.

7. Define the required file naming properties.
8. Click 'OK'.

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager then 
shows the contents of the new SMB destination.
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Create an internet destination with FTP

1. Create a home directory and a subdirectory on a workstation. For example 
c:Ftp/Scan

2. Enable FTP on the workstation.
3. From the 'File' menu on the Océ Scan Manager, select 'New'.

You can also click the 'New' button on the toolbar.
The 'Destination properties' dialogue box opens.

4. From the 'Type' drop-down list box, select 'FTP'.
5. Enter the system name of the workstation where you created the shared folder in the 

'System' text box.

Note: Find the system name of the workstation on the control panel of the 
workstation (Control panel - Network - Identification - System name)

6. Enter a path of the target folder in the 'Path' text box.
The path name is the name of the destination folder on the workstation.

7. A user name and password is defined on the FTP server that runs on the workstation 
to access to the directory on the workstation through FTP. Enter this user name and 
this password in the required fields on the Destination Properties dialogue box of the 
Océ Scan Manager.

Note: Make sure the user has write-access privileges on the destination.

8. Define the required file naming properties.
9. Click 'OK'.

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager then 
shows the contents of the new FTP destination.



106 Chapter 4 Use the PLC applications to control your workflow

Manage destinations

Manage destinations

Introduction

You can do the following to manage the destinations.
■ Lock a destination.
■ Unlock a destination
■ Delete a destination
■ Change the destination properties.

Purpose

When you lock a destination, an anonymous user cannot change the destination 
properties.

Lock or unlock a destination

1. Select a destination.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3. Check the 'Locked' check box.

Uncheck the 'Locked' check box to unlock the destination.
4. Click 'OK' to accept the destination properties

Delete a destination

1. Log on to the key operator mode or the repro operator mode.
2. Select a destination.
3. From the 'File' menu, select 'Delete'.

You can also click the 'Delete' button on the toolbar.
The selected destination is deleted.

Note: You cannot delete the last destination.

Change the destination properties

1. Select a destination.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3. Change the destination properties like described in the 'Create destinations' section. 

(see ‘Create destinations’ on page 103) 

Note: When the destination is locked, anonymous users cannot change the 
destination properties.
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Define a file name

When to do

When you scan, the scanner operator panel shows the file name. 
Before a new scan-to-file job, enter a new file name or replace the file name with 
###.
When the file name is not changed, the new scan-to-file job writes over the previous 
scan-to-file job.

Define a file name

1. Select a destination.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
3. Enter a name in the 'Base name' text box.

The 'Base name' can contain "###" for automatic file naming. An ascending number 
replaces the "###". There are no limits to the number of dots in the base name.

4. Select the check box 'Add correct file extension' to define a file extension. Use the 
setting KO - System - Scan to file - File extension ... in the Océ Settings Editor to 
define a file extension.

5. Click 'Apply' or press 'Enter' to accept the settings.
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Manage the scanned files

Introduction

The right-hand pane of the destination area displays information about the scanned 
files.

You can do the following to manage the scanned files.
■ View a scanned file'Auto view'

When  is enabled, Océ View Station LT starts automatically to display the 
scanned file when the scan to file is complete.

■ Print a scanned file
■ Delete a scanned file
■ View the properties of a scanned file.

View a scanned file

1. Select a file.
2. From the 'File' menu, select 'View'.

You can also click the 'View' button on the toolbar.
[75] 

[75] The View button on the toolbar

Océ View Station LT starts and displays the file

Enable Auto view

1. From the 'System' menu, select 'Auto view'.
A check mark in the menu in front of 'Auto view' indicates that 'Auto view' is 
enabled. 

Print a scanned file

1. Select a file.
2. From the 'File' menu, select 'Print'.

You can also click the 'Print' button on the toolbar.
[76] 

[76] The Print button on the toolbar
The system prints the selected file with the default settings defined in the Océ 
Settings Editor.
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Delete a scanned file

1. Log on to the key operator mode or the repro operator mode.
2. Select a file.
3. From the 'File' menu, select 'Delete'.

You can also click the 'Delete' button on the toolbar.
[77] 

[77] The Delete button on the toolbar
The system deletes the selected file.

Clear the temporary store

1. From 'System' menu, select 'Clear temporary store' or, 
2. Use the settings KO - System - Disk cleanup - ... - ... in the Océ Settings Editor to 

clear the temporary store automatically.

View the properties of a scanned file

1. Select a file.
2. From the 'File' menu, select 'Properties'.

You can also click the 'Properties' button on the toolbar.
[78] 

[78] The Properties button on the toolbar

3. The 'Scanfile properties' window appears.
[79] 

[79] The Scanfile properties window

4. Click 'OK' to close the 'Scanfile properties' window.
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Introduction to Océ View Station LT

Introduction to Océ View Station LT

Definition

Océ View Station LT is a viewer included in Océ Scan Manager. Océ View Station 
LT displays the scanned files.

Auto view

When 'Auto view' is enabled, Océ View Station LT starts automatically to display the 
scanned file when the scan to file is complete. You can also start Océ View Station 
LT manually. (see ‘View a scanned file’ on page 108) 

Overview of Océ View Station LT

Introduction

Océ View Station LT has the following fields.
■ The menu bar
■ The view ribbon
■ The view area.

[80] 

[80] Océ View Station LT

The menu bar

■ The menu bar has the following menu's.
■ 'File'  
■ 'View'  
■ 'Preference'
■ 'Help'.
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[40] 

[41] 

[40] The File menu 

Item Function

'  Close' Close the active document.

'Properties'  Open the properties dialogue box of the document. The 
properties dialogue box enables you to change some 
properties of the document.

[41] The View menu 

Item Function

'Fit'  Scale the image to fill the window.

'1:1' Show the image at a 1:1 scale factor.

'Magnify' Zoom into the page.

'Reduce' Zoom out of the page.

'Refresh'  Refresh the view of all the windows that show the active 
document.

'Invert' Reverse the black and white parts of the image.

'Mirror' Mirror the image.

'Rotate 90 CCW' Rotate the image 90 degrees counter-clockwise (to the left).

'Rotate 90 CW'  Rotate the image 90 degrees counter-clockwise (to the right).

'Rotate 180' Rotate the image 180 degrees.

'Sample' When active, 'Sample' shows only a sample of bilevel raster 
pixels.

'Negate'  Reverse the showed raster image pixels. Change the 
dominant raster image pixels for scaling.

'Scale to grey' When active, 'Scale to grey'   shows the active bilevel raster 
image as a greyscale image.

'Monochrome''Mo
nochrome'

Show an image or screen with only background and 
foreground colours, like black-and-white or bilevel.
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Overview of Océ View Station LT

[42] 

[43] 

The view ribbon
[44] 

[42] The Preference menu 

Item Function

'View ribbon' Show the view ribbon. The view ribbon provides easy access 
to some 'File', 'View', and Preference menu items. See the 
'View ribbon' section below.

'Status bar' Shows the status bar at the bottom of the Océ View Station LT 
window. The Status Bar shows the pointer co-ordinates and a 
status line.

'Reference' Show the 'Reference' window. The 'Reference' window is a 
small, normally floating window. The 'Reference' window 
shows the complete current page in miniature. The crossed 
box in the 'Reference' window indicates the part of the page 
showed in the document window. Move or change the size of 
the crossed box to change the area of the page showed.

 'Detail' Shows the 'Detail' window.

'Measurement' Enables you to measure the lines and the areas on the image.

[43] the Help menu 

Item Function

'About' Show information about Océ View Station LT.

[44] The View ribbon (1 – 2)

Button Function
[81] 

Reverse the black and white parts of the image.
[82] 

Scale the image to fill the window.
[83] 

Show the image at a 1:1 scale factor.
[84] 

Zoom into the page.
[85] 

Zoom out of the page.
[86] 

Mirror the image.
[87] 

Rotate the image 90 degrees counter-clockwise (to the left).
[88] 

Rotate the image 90 degrees counter-clockwise (to the right).
[89] 

Rotate the image 180 degrees.
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The view area

The view area shows the scanned file.

The part of the memory that is allocated to viewer is limited. When you reach the 
limitation of the memory space, the viewer cannot show the scanned file. Then, the 
viewer shows a red border with a red cross.

[45] 

Use your right mouse button to click on the file shown in the view area. You can 
select the following menu items from the pop-up menu.
■ 'Zoom ±'
■ 'Pan' (Hand tool)
■ 'Fit' 
■ 'Magnify'
■ 'Reduce' 
■ 'Invert'
■ 'Rotate 90 CCW'  
■ 'Rotate 90 CW' 
■ 'Rotate 180'.

[90] 

Enables you to measure the lines and the areas on the image.
[91] 

how the 'Reference' window. The 'Reference' window is a 
small, normally floating window. The 'Reference' window 
shows the complete current page in miniature. The crossed 
box in the 'Reference' window indicates the part of the page 
showed in the document window. Move or change the size of 
the crossed box to change the area of the page showed.

[92] 

Shows the 'Detail' window.

[44] The View ribbon (2 – 2)

Button Function

[93] 

[93] An error view in Océ View Station LT



114 Chapter 4 Use the PLC applications to control your workflow

Introduction to Océ Remote Logic®

Use Océ Remote Logic® to control your 
workflow from a remote workstation

Introduction to Océ Remote Logic®

The applications of Océ Remote Logic®

You must use Océ Remote Logic® to connect to the Océ Power Logic® controller 
applications when you do not have a keyboard, mouse and monitor with your Océ 
Power Logic® controller.

You can use Océ Remote Logic® to run the following applications from a remote 
workstation.
■ Océ Settings Editor

Use the application to change the default settings of the system.
■ Océ Queue Manager

Use the application to manage the print jobs.
■ Océ System Control Panel

Use the application to view the status of the printer, the scanner and the 
controller. You can also view the media available on the printer and the amount 
of set memory in use.

User modes

The Océ Remote Logic® controller applications have different user modes (see ‘The 
Océ TCS500 users’ on page 19). An additional user mode is the 'Service operator' 
mode. This mode is for the Océ technician only.



115

Install Océ Remote Logic® on your system

Install Océ Remote Logic® on your system

Introduction

The Océ Remote Logic® application can run on all platforms with Java Virtual 
Machine. This section describes the installation procedures for the different types of 
platforms.

Before you begin

To install Océ Remote Logic® on Windows® NT, ME, XP, or 2000, your system must 
be at least equipped with a 233 MHz processor with 32 Mb RAM.

Installation procedure for Microsoft® Windows® platforms

1. Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® controller 
CD-ROM into the CD-ROM drive of your PC.

2. The installation starts automatically. If does not start automatically, run Setup.exe.
3. Select the required language in the installation wizard and click 'OK'.

[94] 

[94] Select the setup language

4. Follow the instructions on the screen to complete the installation of Océ Remote 
Logic®.

Note: You can only use Océ Remote Logic® when TCP/IP is enabled on your system. 
Refer to your system administrator for help with the installation procedure for 
TCP/IP.

Installation procedure for UNIX platforms

1. Check if a Java Runtime Environment (JRE) is installed on the system.
2. From the directory  Products/remotelogic/UNIX , unpack the contents of the file  

RemoteLogic_vX.tar  to a subdirectory on the system.
3. Use  tar xvf RemoteLogic_vX.tar  to unpack the file.
4. Set the environment variable  RL_VM_HOME  to point to the installation of the 

JVM.
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5. Run the file  remotelogic  with the applications as parameters (for example  
remotelogic QM SCP SE  to start the three applications), or use  remotelogic AL  
as the application launcher.

UNIX versions and the required JRE
[46] 

Note: OS = Operating System, JRE = Java Runtime Environment

Where to download the Java Runtime Environments
[47] 

Installation procedure for other platforms

1. Install Java Virtual Machine (version 1.1.8).
2. From the Océ Remote Logic® CD-ROM, load  RemoteLogic_vX.tar  or  

RemoteLogic_vX.zip .
3. Set the environment variable  RL_VM_HOME  to point to the Java 

Products/remotelogic/UNIX  installation directory.
4. If necessary, edit the Océ Remote Logic® script or batch file.
5. Use the Océ Remote Logic® script or batch file to start the applications.

UNIX version OS 
version

JRE Default installation 
directory

IBM® AIX 4.1.5 1.1.6 /usr/jdk_base

IBM® AIX 4.2.1 1.1.8 /usr/jdk_base

IBM® AIX 4.3.3 + fix 1.2.2 /usr/jdk_dev2

IBM® AIX 4.3.3.10 + 
fix

1.3.0 /usr/jdk_java130

SUN® Solaris 2.6 1.1.6

HP-UX 10.20 1.1.3

LINUX® 1.0 1.1.3

LINUX® 1.2 1.1.8

[47] Download Java Runtime Environments 

Platform Preferred version Download location

1 1.1.8 http://www.ibm.com/java

2 C.01.18.xx http://www.unix.hp.com/java

3 N/A http://www.ibm.com/java



117

Start the applications with Océ Remote Logic®

Start the applications with Océ Remote Logic®

Introduction

Use the following 2 methods to start the applications with Océ Remote Logic®.
■ Use the programs menu of your operating system.
■ Use a command line parameter.

Use the programs menu to start the applications

1.  Select 'Océ Remote Logic' 

2. Select the 'Launcher' application.

3. Select the required application.

The application starts with your default system.

Note: You can select another system than your default system (see ‘Connect to the 
controller’ on page 120).

Use command line parameters to start the applications

Six command line parameters are available to facilitate the start of the applications.

■ configfile=<config_file>
Sets the configuration file to use.

■ server=server
Sets the indicated server as the server to connect to.

■ language1=lang
Specifies the first language in combination with the parameter  
country1=country .

■ country1=country
Specifies the first language in combination with the parameter  
language1=language .

■ language2=lang
Specifies the second language in combination with the parameter  
country2=country .

■ country2=country
Specifies the second language in combination with the parameter  
language2=language .

Note: Always use a matching combination of language and country (see the 
following table).



118 Chapter 4 Use the PLC applications to control your workflow

Start the applications with Océ Remote Logic®

Parameters of supported languages
[48] 

Apply the parameters to the applications

Apply the parameters to the following applications.
■ QM.exe (Océ Queue Manager)
■ SCP.exe (Océ System Control Panel)
■ SE.exe (Océ Settings Editor)
■ AL.exe (Application launcher).

The easiest method to apply the parameters to the applications is to create a shortcut 
for an application. Then add the command line properties.

Note: The .exe files are usually located in C:\Program Files\Remote Logic\Bin.

[48] Parameters of supported languages 

Language Language parameters Country parameters

Danish da DK

Swedish sv SV

Norwegian no NO

Finnish fi FI

Hungarian hu HU

Czech cs CZ

Polish pl PO

German de DE

Dutch nl NL

UK English en GB

US English en US

French fr FR

Italian it IT

Spanish es ES

Portuguese pt PT

Russian ru RU

Chinese simplified cn CN

Chinese traditional cn TW

Japanese ja JP
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Example of a command line parameter

The example below shows how to start the controller applications with the 
configuration file 'Myconfig.cfg', connected to the 'MyTCS500' server. The first 
language is set to UK English and the second language is set to French.

C:\Program Files\Remote Logic\Bin\AL.exe
configFile=Myconfig.cfg server=MyTCS500 language1=en country1=GB 
language2=fr country2=FR .
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Connect to the controller

Connect to the controller

Introduction

After you start one of the Océ Remote Logic® applications, you must connect to the 
Océ Power Logic® controller of the Océ TCS500. You must connect to the system 
for every separate application.

You can do the following when you connect to the controller. 
■ Select a system from the drop-down list.
■ Add a system to the drop-down list.
■ Remove a system from the drop-down list.

When the Océ TCS500 is not available in the 'Connect to' dialogue box, you must 
add the Océ TCS500 to the list of available systems.

How to connect to a system

1. Open the application you want to run.
2. From the 'File' menu, select 'Connect to'.
3. Select the system from the drop-down list.
4. Click 'OK'.

Note: From the 'File' menu, select 'Options' to define the default system. This is 
recommended if you frequently connect to the same system.

How to add a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.

The 'Edit systems' dialogue box appears.
3. Enter the IP address or the name of the system in the 'System' box.
4. Click 'Add'.

The system is added to the list.
5. Click 'OK' 2 times to return to the application.

How to remove a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.

The 'Edit systems' dialogue box appears.
3. Select the system you want to remove.
4. Click 'Remove'.

The system is removed from the list.
5. Click 'OK' 2 times to return to the application.
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Log on to the controller applications

User modes

The Océ Power Logic® controller has the following user modes.
■ Key operator
■ Repro operator
■ System administrator
■ Service operator.

Chapter 1 contains more information about the types of users (see ‘The Océ TCS500 
users’ on page 19). Chapter 5 contains more information about the user modes in the 
Océ Settings Editor (see ‘Introduction to the Océ Settings Editor’ on page 74). Log 
on to the correct user mode in the Océ Settings Editor to change the key operator 
settings or the system administrator settings.

Only assigned operators are allowed to use the user modes. Different passwords are 
required to access the user modes.
You do not need a password for the anonymous user mode.

Passwords

■ The default password for the system administrator is  SysAdm .
■ The default password for the key operator is  KeyOp .
■ The default password for the repro operator is  ReproOp .

When a user is logged on, the user can change the password for the current user 
mode. (see ‘Change the password’ on page 123) 

Note: The passwords are case sensitive.

Authorisation

Only one key operator, system administrator or repro operator at a time is authorised 
to change the settings.
An error message appears when a second user tries to log on to the key operator 
mode or system administrator mode. 
There is no limitation of users authorised to view the settings.

[95] 

[95] Error message when a second user tries to log on
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How to log on to the controller applications

1. From the 'File' menu, select 'Log on'.

2. Select the required user name.

3. Enter the password.

4. Click 'OK'.

You are now logged on as special user. When you are not logged on, you have 
'Anonymous' user permission. (see ‘The Océ TCS500 users’ on page 19).

The status bar at the bottom shows the user mode.

The logon is limited to one user only.

Note: You must separately log on to each application.

How to log off from the controller applications

From the 'File' menu, select 'Log off'.
You return to the anonymous user mode. Log off from the controller applications to 
prevent unauthorised use.

Note: You must separately log off from each application.
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Automatic logon

Introduction

The 'Automatic logon' option enables you to start an application automatically in the 
indicated user mode.

How to enable automatic logon
[49] 

Automatic logon is now enabled.

Change the password

How to change the password

1. From the 'File' menu, select 'Log on'.
2. Click 'Password' in the dialogue box.
3. Open the drop-down list and select a user.
4. Enter the old password.
5. Enter the new password.
6. Enter the new password a second time to confirm.
7. Click 'OK' to save the new password.

Step Action

1 From the 'Edit' menu, select 'Options'.
The 'Options' window appears.

2 Select the 'Enable automatic logon' checkbox.

3 From the drop-down box, select the user mode for the automatic logon.

4 Enter the password that corresponds to the selected user mode.

5 Click 'OK'.
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Change the password
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scan-to-file jobs
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Introduction to scan-to-file jobs

Introduction

A basic scan-to-file job takes three steps. Feed the original, select  'Scan-to-file' and 
press the start key. Every other type of scan-to-file job, where you change the 
scan-to-file settings, is called an extended scan-to-file job. An extended scan-to-file 
job takes one additional step. Define the scan-to-file job settings at the scanner 
operator panel. When you select 'Scan-to-file', the scanner operator panel shows five 
scan-to-file job templates. The scan-to-file job templates provide access to the 
different settings per scan-to-file job template. When you select a scan-to-file job 
template, the scanner operator panel shows the top 5 settings of the selected 
scan-to-file job template. The top 5 settings are the most often used settings. You can 
define the top 5 settings and their values for each scan-to-file job template with the 
Océ Settings Editor. (see ‘Define the job templates for your scanner operator panel’ 
on page 82). You can use the scroll wheel to see the other settings. After you start a 
scan-to-file job, you can manage your jobs from the Océ Queue Manager.

Illustration
[96] 

[96] The scan-to-file job templates
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Introduction to scan-to-file jobs

Steps in a basic scan-to-file job

1. Feed the original.
2. Select 'Scan-to-file'
3. Press the green start key.

Result

You get a digital file of your original.
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Introduction to scan-to-file jobs

Steps in an extended scan-to-file job without fine tuned job templates

1. Feed the original.
2. Select 'Scan-to-file'.
3. Define the scan-to-file job settings at the scanner operator panel.

■ Open a template.
■ Select the first setting and define the value.
■ Select the second setting and define the value.
■ ....
■ Select the last setting and define the value.

4. Press the green start key.

Result

You set the required settings that are not pre-defined in your job template and you 
get the desired digital file of your original. 

Steps in an extended scan-to-file job with fine tuned job templates

1. Feed the original.
2. Select 'Scan-to-file'.
3. Define the job settings.

Select the required template at the scanner operator panel and change the pre-defined 
settings only if necessary.

4. Press the green start key.

Result

You only set the required settings that are not pre-defined in your job template and 
you get the desired digital file of your original. The more settings you predefine (fine 
tuned job template), the less settings you will have to change. 
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Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the job 
settings  in two ways. 
■ Use the left softkeys and the scroll wheel.

You can use this method if you prefer a general step by step method.
■ Use the scroll wheel and scroll-wheel key only.

You can use this method if you prefer a fast method.

Know that the scanner operator panel also uses icons to explain a setting. The 
following illustration shows the scanner operator panel of the Océ TCS500 scanner.
(see table 7).

Illustration
[97] 

[97] The operator panel of the Océ TCS500 scanner

1 2 3 4 5 6 7 8 9 0
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Use the scanner operator panel

Define job settings with the left soft keys and the scroll wheel

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Select a job template with one of the left softkeys.
The top 5 settings appear.

3. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll wheel.

4. Select a setting with the left softkey.
There are several types of settings. The behaviour of the scanner operator panel and 
the definition of a setting depends on the type of setting you selected. You can select 
one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

When you select this setting while the setting was not in focus, the setting 
becomes in focus. When you select this setting while the setting was already in 
focus, the setting stays in focus and there are no changes.
Change the value of the setting with the left softkey. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Define the required value with the scroll wheel. The value and icon changes.

■ A setting that contains a list of settings, like 'Media'.
Define the required value with the scroll wheel. The value and icon changes.
Select the next setting of the list of settings with the left softkey.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

5. Select  'Close' with the lower-right softkey.
6. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Use the scanner operator panel

Define job settings with  the scroll wheel and scroll-wheel key only

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Focus on a job template with the scroll wheel.
A small diamond in front of a template indicates the focus of the scroll wheel.

3. Select a job template with the scroll-wheel key.
The top 5 settings appear.

4. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll wheel.

5. Select the setting with the scroll-wheel key.
There are several types of settings. The behaviour of the scanner operator panel and 
the definition of a setting depends on the type of setting you selected. You can select 
one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

Change the value of the setting with the scroll-wheel key to change the value of 
the setting. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

■ A setting that contains a list of settings, like 'Media'.
Focus on a setting with the scroll wheel. The bold text of a value indicates the 
focus of the scroll wheel. The icon changes.
Open the setting with the scroll-wheel key. The list of values appears.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

6. Select 'Close' with the lower-scroll-wheel key.
7. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 



132 Chapter 5 Use the Océ TCS500 for scan-to-file jobs

Do a basic scan-to-file job

Do a basic scan-to-file job

Introduction

This section describes a general workflow for a basic scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

How to do a basic scan-to-file job on the Océ TCS500

1. Place the original face down and right aligned.
The scanner takes the original.

[98] 

[98] Place the original face down and right aligned.

2. Select 'Scan-to-file' with the upper-left softkey.
3. Press the green start key.

Result

The scanner scans the original and the sends the scanned file to the default 
scan-to-file destination.
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Do an extended scan-to-file job

Introduction

This section describes a general workflow for an extended scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

How to do an extended scan-to-file job on the Océ TCS500

1. Place the original face down and right aligned.
The scanner takes the original.

[99] 

[99] Place the original face down and right aligned

2. Select 'Scan-to-file' with the upper-left softkey.
The scan-to-file job templates appear.

3. Define the job settings.
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Do an extended scan-to-file job

[100] 

[100] The top 5 settings of a scan job template
(see ‘Available settings for scan-to-file jobs’ on page 136)
■ Open a scan-to-file job template with a left softkey.

The top 5 settings appears.
■ Scroll to a setting.
■ Select a setting with the left softkey.
■ Scroll to the required value.
■ Select the next setting with the left softkey.
■ Scroll to the required value.
■ Select 'Close' to close the setting.
■ Repeat the selection of settings from bullet 3 if you need to define more settings.

4. Press the green 'Start' key.

Result

The scanner scans the original and sends the scanned file to the defined scan-to-file 
destination.
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Stop a scan-to-file job

Introduction

You can stop a scan-to-file job with the red stop key at the scanner operator panel.

How to stop a scan-to-file job

1. Press the red stop key.

Result

When you press the red stop key while the scanner scans, the scan process stops. The 
scanner rewinds the original and the scan-to-file job is cancelled.
When you press the red stop key while the scanner rewinds, the rewind process 
continues. The scan-to-file job is cancelled.
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Available settings for scan-to-file jobs

Settings for extended scan-to-file jobs

Available settings for scan-to-file jobs 

The scan-to-file settings on the scanner operator panel
[50] 

Setting Description

'Destination' Use this setting to define the default destination for 
scan-to-file jobs on the controller. You can define a 
maximum of 10 remote destinations and one of these 
destinations is the default destination.
[101] 

'File type' Depending on the colour mode and file type you select 
the values for the compression mode and organisation 
will change. For some File types, the Compression and 
Organisation settings cannot be set in all 
situations.(see ‘'File type'’ on page 138)

'Resolution' Use this setting to define the resolution of the scanned 
images. The higher the resolution you select, the finer 
the image quality but the larger the file size. (see 
‘'Resolution'’ on page 139)

'Original type' Use this setting to define the type of original for your 
scan-to-file jobs. The defined type influences the 
quality of the output.(see ‘'Original type' and 
background compensation’ on page 140)

'Original width' Use this setting to define the width of the original that 
the scanner scans.(see ‘'Original width'’ on page 142)

'Remove strip' Use this setting to define blank areas on the sides of the 
scanned image. (see ‘'Remove strip'’ on page 143)
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Available settings for scan-to-file jobs

'Mirror' Use this setting to create a mirrored image of an 
original. Mirroring occurs in the transport direction. 
(The image is mirrored along the vertical axis.)
[102] 

'Lighter/darker' Use this setting to define the exposure of the original. 
Negative values mean less exposure and darker 
scanned output. Positive values mean more exposure 
and greyer scanned output.
[103] 

Setting Description
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'File type'

'File type'
Depending on the colour mode and file type you select the values for the 
compression mode and organisation will change. For  some File types, the 
Compression and Organisation settings cannot be set in all situations.

Colour mode: Greyscale
[51] 

Colour mode:  Black and White
[52] 

Colour mode:  Colour
[53] 

Colour mode File type Compression Organisation

'Greyscale'
[104] 

'TIFF' ■ 'None'
■ 'Packbits'
■ 'LZW'

■ 'Raw'
■ 'Tiled'
■ 'Striped'

'PDF' ■ 'None'
■ 'Flate'
■ 'LZW'

Not available

Colour mode File type Compression Organisation

'Black&white'
[105] 

'TIFF' ■ 'None'
■ 'Group 3'
■ 'Group 4'
■ 'Packbits'
■ 'LZW'

■ 'Raw'
■ 'Tiled'
■ 'Striped'

'PDF' ■ 'None'
■ 'Flate'
■ 'Group 4'

Not available

'CALS' Not available Not available

Colour mode File type Compression Organisation

'Colour'
[106] 

'TIFF' ■ 'None'
■ 'Packbits'
■ 'LZW'

■ 'Raw'
■ 'Tiled'
■ 'Striped'

'PDF' ■ 'None'
■ 'LZW'
■ 'Flate'

Not available
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'Resolution'

'Resolution'
Use this setting to define the resolution of the scanned images. The higher the 
resolution you select, the finer the image quality. 
Select the required scan resolution with the scroll wheel.

[54] 

Note: A higher resolution increases the file size.

Setting Value in dots per inch

'Resolution' ■ '72 dpi'
■ '100 dpi'
■ '150 dpi'
■ '200 dpi'
■ '300 dpi'
■ '400 dpi'
■ '600 dpi'
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'Original type' and background compensation

'Original type' and background compensation

Colour mode: Greyscale

Use the 'Original type' setting to define the type of original for copy and scan-to-file 
jobs. Depending on the colour mode you select the values for the 'Original type' 
setting will change. The defined original type influences the quality of the output.
Use the 'Backgnd comp' setting to define the background compensation for your 
original.
Select the type of original and the background compensation with the scroll wheel.

[55] 

Colour mode 
'Greyscale'

Setting Value

[107] 

'Original type'
[108] 

■ 'Lines&Text'
■ 'Greys&Lines'
■ 'Dark original'
■ 'Blueprint'
■ 'Photo'
■ 'Transparent' for transparencies

'Backgnd comp'
[109] 

When the background on the original 
has pollution, use this setting to improve 
the quality of the background.
The compensation depends on the type 
of the originals. If enabled, the 
background compensation for 'Photo' or 
'Greys&Lines' originals is a standard 
value.
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'Original type' and background compensation

Colour mode: Colour

Use the 'Original type' setting to define the type of original for copy and scan-to-file 
jobs. Depending on the colour mode you select the values for the 'Original type' 
setting will change. The defined original type influences the quality of the output.
Use the 'Backgnd comp' setting to define the background compensation for your 
original.
Select the type of original and the background compensation with the scroll wheel.

[56] 

Colour mode 
'Colour'

Setting Value

[110] 

'Original type'
[111] 

■ 'Photo'
■ 'Lines&Text'
■ 'Map'
■ 'Artwork'

'Backgnd comp'
[112] 

When the background on the original 
has pollution, use this setting to improve 
the quality of the background.
The compensation depends on the type 
of the originals. If enabled, the 
background compensation for 'Photo' 
originals is a standard value.
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'Original width'

'Original width'
Use this setting to define the width of the original that the scanner scans.

Select one of the following.

[57] 

Setting Icon Result

'By scanner'
[113] 

The scan width is automatically 
determined based on the actual width of 
the original.

'Standard'
[114] 

Use this setting to define a 'Standard' 
width of the original. 
The standard widths that you can select 
depend on the media series that you 
selected in the Océ Settings Editor.

'Custom'
[115] 

Custom-selected width. Use this setting 
if the 'Auto' setting or the  'Standard' 
setting does not give the required result.
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'Remove strip'

'Remove strip'
Use the 4 settings below to define the blank areas around the image.

[58] 

[58] Remove strips 

Setting Icon Result

'Remove strip' -  
'Leading'

[116] 

Use this setting to remove a strip at the 
top of the image. This action decreases 
the print or file length.

Note: The top side of the 
image is the side that you 
first feed into the scanner.

'Remove strip' -  
'Trailing'

[117] 

Use this setting to remove a strip at the 
bottom of the image. This action 
decreases the print or file length.

'Remove strip' -  
'Left'

[118] 

Use this setting to remove a strip from 
the left side of the image/original 
viewed from the face-up direction. This 
action decreases the print or file width.

'Remove strip' - 
'Right'

[119] 

Use this setting to remove a strip from 
the right side of the image/original 
viewed from the face-up direction. This 
action decreases the print or file width.
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'Remove strip'
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What you need to know before you send your print jobs

Send print jobs to the Océ TCS500

What you need to know before you send your print jobs

Definition

Before you send print jobs to the Océ TCS500, remember the following.

■ The values defined in the Océ Settings Editor are default values for the system 
(see ‘The user interface of the Océ Settings Editor’ on page 75). You can define 
a number of job settings in the printer drivers or the job submission tools. The 
settings defined in the printer drivers or the job submission tools always overrule 
the settings defined in the Océ Settings Editor.

■ Make sure that you define the correct quality mode for your job  
(see ‘The quality modes’ on page 189).

■ Make sure that you define the correct media type for your job  
(see ‘Recommended media types and quality modes’ on page 191).

■ Make sure that you define the correct job settings. For example, orientation, 
rotate, and media type. 

Note: When the requested media type is not available on the printer, the printer will 
give a media request. The job is then placed on hold in the print queue. After the 
correct media is loaded on the printer and after you 'Resume' the job, the job will be 
printed. When the job is placed on hold in the print queue, you can also select 
another media roll for your job, with the option 'Settings''Job properties' in the Océ 
Queue Manager.

A job submission tool like Océ Print Exec® Workgroup, provides you with 
information about the media defined on the system. The printer drivers do not give 
this type of information. When you use the printer drivers to send your jobs, use Océ 
Remote Logic to view information about the media defined on the printer in the Océ 
System Control Panel.
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Send print jobs to the Océ TCS500

Send print jobs to the Océ TCS500
You can send your print jobs to the Océ TCS500 in various ways. The default 
configuration of the Océ TCS500 includes the following options to send a print job.

■ printer drivers
■ Océ Print Exec® Workgroup LT
■ FTP
■ LPR

Note: You require a license key in Océ License Logic to upgrade to the full version 
of Océ Print Exec® Workgroup in case you want to use the extended functionality.

After you send jobs to the printer, you can manage the jobs through the Océ Queue 
Manager and the printer operator panel.

Note: The settings defined in the printer drivers or the job submission tools always 
overrule the settings defined in the Océ Settings Editor. 

Use the printer drivers to send jobs to the Océ TCS500 
printer

Introduction

The Océ TCS500 printer is delivered with a driver pack CD-ROM. You can also 
download the latest Océ drivers, free of charge, from our Web site www.oce.com.

With these drivers PC users can access the Océ TCS500 printer remotely from their 
applications, to print their files.

Note: More information about how to install, configure and use the drivers is 
available in the documentation provided with the drivers.

Available printer drivers

(see ‘Specifications drivers and job submission software’ on page 290) for a list of 
the available printer drivers that you can use  to print files from your software 
applications.

Note: Please check www.oce.com, section drivers for the latest driver-updates.
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Use Océ Print Exec® Workgroup LT to send print jobs to the Océ TCS500 printer

Use Océ Print Exec® Workgroup LT to send print jobs to the 
Océ TCS500 printer

Introduction

Océ Print Exec®Workgroup LT is a print job submission application that allows you 
to send print jobs to the Océ TCS500 printer through your web browser.

Note: For this application a separate Océ Print Exec®Workgroup LT user manual 
is available.

When to do

Use Océ Print Exec®Workgroup LT to do the following.

1. Select and collect the files to print (documents and drawings), in a print job. You can 
add a maximum of 100 documents or drawings to a print job.

2. Configure the print job.
You can set the document or drawing settings and the print job settings. You can add 
a banner to the print job and add a settings configuration for a print job.

3. Submit the print jobs to the printer queue or inbox queue.
4. Check the print job and the printer configuration status.

You can view the status information of the printer configuration and the available 
media.

Required tools

Microsoft® Internet Explorer® 5.0 (or higher versions) or Netscape Navigator® 6.0 
(or higher versions). 
TCP/IP network that connects the printer and the end user workstation.

How to connect to Océ Print Exec®Workgroup LT

1. Enter the following URL in your workstation browser: http://'printer name'.

Note: 'Printer name' is the name of printer that you use for your print jobs.

Note: If you enter the URL for the first time, the required software is installed 
automatically on your workstation.
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Use FTP to send jobs to the Océ TCS500

Introduction

The Océ TCS500 supports printing through FTP. You can print the files through FTP 
from a command line prompt, an FTP application, or from a Web browser. The most 
convenient way to print files through FTP is to drag and drop the files or to copy and 
paste the files, into the 'Jobs' folder on the FTP site of your Océ TCS500. 

Web browsers that support job submission through FTP
[59] 

Level of functionality Web browser Operation

Supports drag and drop of 
files

Netscape® Navigator 4.x. Drag the jobs into the 
'Jobs' folder on the FTP 
site of your Océ TCS500. 
The jobs appear in the 
print queue of the Océ 
Queue Manager.

Supports copy and paste 
of files.

Netscape® Navigator 4.x
Microsoft® Internet 
Explorer 5.5.

Paste the jobs into the 
'Jobs' folder on the FTP 
site of your Océ TCS500. 
The jobs appear in the 
print queue of the Océ 
Queue Manager.
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Stop, delete or hold an active job

Stop, delete or hold an active job

Introduction

This section describes how to 'Stop', 'Delete' or 'Hold' an active job on the printer  
operator panel. You can also 'Stop', 'Delete'  or 'Hold' print jobs in the Océ Queue 
Manager. (see ‘User operations in the Océ Queue Manager’ on page 99)

How to 'Stop', 'Delete'  or 'Hold' an active print job on the printer operator panel

1. Press the 'Stop' key on the printer operator panel.
The printer stops immediately.
A dialogue box on the screen asks the user to 'Resume' or 'Stop' the job. 
When you do not select an option, the printer automatically continues the printing 
after 5 minutes.

[120] 

2. Use the lower softkeys to indicate if you want to 'Resume' or 'Stop' the job.
If you select 'Stop' a new dialogue box appears were you can 'Delete' or 'Hold' the 
job.

3. Use the lower softkeys to indicate if you want to 'Delete' or 'Hold' the job.
If you select 'Delete' the active job is permanently deleted from the print queue.
If you select 'Hold' the active job is put on hold in the print queue. The Océ TCS500 
allows you to change the properties of the job on hold.  
(see ‘How to change attributes of jobs on hold in the Océ Queue Manager’ on 
page 101)

Note: When you delete a job, the drying is not skipped. Press the key for 'Skip 
drying' to cancel the drying during the drying time. You can use the 'Feed & cut' 
wizard to cut the output.
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Change job attributes

Change job attributes

Introduction

The Océ TCS500 printer allows you to change the job attributes of an active print 
job.

How to change the job attributes of an active print job

1. Place the active print job on hold using the printer operator panel or using the Océ 
Queue Manager  How to place jobs on hold in the Océ Queue Manager.

2. Change the required attributes using the Océ Queue Manager  (Media roll, Quality 
mode, number of prints, Colour / Greyscale) (see ‘How to change attributes of jobs 
on hold in the Océ Queue Manager’ on page 101).

3. Restart the print job using the printer operator panel or using the Océ Queue 
Manager (see ‘How to restart jobs in the Océ Queue Manager’ on page 101).
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Define the correct media for your jobs

Define the correct media for your jobs

Definition

To achieve optimal output quality, make sure that you load and define the correct 
media type on the printer.

You can use the 'Change media type' wizard, to load a media roll and to change the 
media type defined on the system.
Make sure you define the correct media type for your job. Make sure the media type 
and the media format defined in your job is available on the printer.

Define the correct media on the printer and the correct settings in the job submission 
tools to set the Océ TCS500 for productive use or high output quality.

[60] 

Note: The above procedure is based on DIN media sizes. You can also use this 
procedure with ANSI media sizes.

[61] 

[62] 

When productivity with different media sizes is the most important 
requirement.

1 Load and define 2 or 3 media rolls on the printer with different media sizes 
and the same media types.

2 Use the 'Landscape' orientation to print a job on a media size that is one 
size smaller than the media defined on the system. For example, A1 prints 
in landscape on A0 and A2 prints in landscape on A1. You are not required 
to cut the media by hand.

3 Use the 'Auto rotate' setting in the Océ Settings Editor or the job 
submission tools to rotate the orientation automatically.

When productivity is the only important requirement.

1 Load and define two media rolls on the printer with the same media sizes 
and the same media types.

Note: When roll 1 is empty, the printer switches automatically 
to roll 2. You can load a new roll while the printing process 
continues.

When the output quality is the most important requirement.

1 Load and define 2 or 3 media rolls on the printer with the same media sizes 
and with different media types.

2 Select the media types you define based on the output quality you require.
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Change the default drying time

Introduction

You can change the drying time with a percentage of the default drying time. For 
example, when you set the default drying time for Premium coated paper, under the 
conditions used in the table above, to 200%, the drying time will be 0'40".

How to change the default drying time

1. Open the Océ Settings Editor application.
2. Go to the setting Key Operator - Printer - Media - Drying time correction.
3. Select the required media type.
4. Define the required percentage.
5. Press 'Apply'

Note: See (see ‘Typical drying times’ on page 284) to get an overview of the typical 
drying times per media type.
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Cut the output and clean cut a roll of media

Cut the output and clean cut a roll of media

Introduction

The off-line screen of the printer operator panel contains the 'Feed & cut' wizard that 
helps you do the following.
■ Cut the output.
■ Clean cut a roll of media. Use this option to cut the roll so that the edge is straight.

Note: You can only use the 'Feed & cut' wizard to cut the output when 'Automatic 
media cut' is disabled in the Océ Settings Editor. When 'Automatic media cut' is 
enabled in the Océ Settings Editor, the system automatically cuts the output.

How to use the Feed & cut wizard to cut the output.

1. Press the On-line / off-line key to set the printer off-line.
2. Use the upper softkeys to scroll to the 'Feed & cut' card.

[121] 

3. Press the softkey below the 'Feed & cut' card to enter the wizard.
The screen displays the message 'Preparing Feed & cut...'. The system prepares for 
the feed and cut. This can take between 0 and 20 seconds.

[122] 

4. Press the key for 'Feed' to feed the output in steps of 5 cm.
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[123] 

5. Press the key for 'Cut' to cut the output.
When you do not require to cut the output, press the key for 'Finish' to return to the 
on-line screen.
After you select 'Cut', the system returns to the on-line menu.

How to use the Feed & cut wizard to clean cut a roll of media

1. Press the On-line / off-line key to set the printer off-line.
2. Use the upper softkeys to scroll to the 'Feed & cut' card.
3. Press the softkey below the 'Feed & cut' card to enter the wizard.

■ When multiple rolls are available on the system, the screen displays the message 
'Select roll for Feed & cut.'

■ When 1 roll is available on the system, the wizard moves directly to the 'Cut' 
screen.

4. The screen displays the message 'Select roll for Feed & cut.' Use the lower softkeys 
to select a media roll to clean cut.

[124] 

5. Press the key for 'Next' to continue. The screen displays the message 'Length to cut 
from roll '

[125] 

6. Use the lower softkeys to select the cut length option. Select one of the following. 
■ 'Long strip'
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Feeds the media with a full roll rotation feed (50 cm) before the printer cuts the 
media.

■ 'Short strip'
The printer automatically cuts the media with the least possible media waste (20 
cm).

7. Press the key for 'Finish' to confirm the settings. The screen displays the message 
'Cutting sheet...'.

[126] 

After the sheet is cut, you automatically exit the wizard.
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Set up unattended / overnight printing optimisation

Introduction

The Océ TCS500 has the possibility to print unattended, for example outside office 
hours. To use this option, the setting Key Operator - Printer - Settings - 
Calibration - Overnight printing optimisation  in the Océ Settings Editor must be 
set to 'On'.
When the setting 'Overnight printing optimisation' is set to 'On', the system will 
automatically perform checks, after the selected number of prints,  to ensure a 
consistent output quality. For each check, the system uses a approximately 25 
centimetres of the loaded media roll.

Set up overnight printing

The setting 'Overnight printing optimisation' has the following options.

[63] 

Calibration is only possible when one of the following media types are loaded on the 
system.

■ Draft paper
■ Standard paper
■ Premium coated paper
■ Bond
■ Coated bond
■ Matt photo paper
■ High gloss photo paper
■ Deluxe bond
■ Recycled plain paper
■ Plain paper coated

Note: When these media types are not available on the system, the check is delayed 
until the next time a print is made on one of these media types.

Setting Function

'Off' The system will not check the output quality.

'On'. The system checks for failing printhead nozzles and corrects the 
alignment.
You can define the number of prints after which the system 
automatically does a check.
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Set up unattended / overnight printing optimisation
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Introduction to copy jobs

Introduction

A basic copy job takes two steps. Feed the original and press the start key. Every 
other type of copy job is called an extended copy job. An extended copy job takes 
one additional step, define the copy job settings at the scanner operator panel. When 
you turn the Océ TCS500 on or when you select 'Copy', the scanner operator panel 
shows five copy job templates. The copy job templates provide access to the different 
settings per copy job template. When you select a copy job template, the scanner 
operator panel shows the top 5 settings of the selected copy job template. The top 5 
settings are the most often used settings. You can define the top 5 settings for each 
copy job template with the Océ Settings Editor. You can use the scroll wheel to see 
the other settings. After you start a copy job, you can manage your jobs from the Océ 
Queue Manager.

Illustration
[127] 

[127] The copy job templates

Steps in a basic copy job

1. Feed the original.
2. Press the green start key.
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Result

You do a basic copy job in 2 steps. The basic copy job uses the settings of the  first 
template.

Steps in an extended copy job

1. Feed the original.
2. Define the job settings.

Select the required template at the scanner operator panel and change the pre-defined 
settings only if necessary.

3. Press the green start key.

Result

An extended copy job takes one additional action only.
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Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the job 
settings  in two ways. 
■ Use the left softkeys and the scroll wheel.

You can use this method if you prefer a general step by step method.
■ Use the scroll wheel and scroll-wheel key only.

You can use this method if you prefer a fast method.

Know that the scanner operator panel also uses icons to explain a setting. The 
following illustration shows the scanner operator panel of the Océ TCS500 scanner.
(see table 7).

Illustration
[128] 

[128] The operator panel of the Océ TCS500 scanner

1 2 3 4 5 6 7 8 9 0
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Define job settings with the left soft keys and the scroll wheel

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Select a job template with one of the left softkeys.
The top 5 settings appear.

3. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll wheel.

4. Select a setting with the left softkey.
There are several types of settings. The behaviour of the scanner operator panel and 
the definition of a setting depends on the type of setting you selected. You can select 
one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

When you select this setting while the setting was not in focus, the setting 
becomes in focus. When you select this setting while the setting was already in 
focus, the setting stays in focus and there are no changes.
Change the value of the setting with the left softkey. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Define the required value with the scroll wheel. The value and icon changes.

■ A setting that contains a list of settings, like 'Media'.
Define the required value with the scroll wheel. The value and icon changes.
Select the next setting of the list of settings with the left softkey.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

5. Select  'Close' with the lower-right softkey.
6. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Use the scanner operator panel

Define job settings with  the scroll wheel and scroll-wheel key only

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
The five job templates appear.

2. Focus on a job template with the scroll wheel.
A small diamond in front of a template indicates the focus of the scroll wheel.

3. Select a job template with the scroll-wheel key.
The top 5 settings appear.

4. Find a setting with the scroll wheel.
A small rectangle in front of a setting name indicates the focus of the scroll wheel.

5. Select the setting with the scroll-wheel key.
There are several types of settings. The behaviour of the scanner operator panel and 
the definition of a setting depends on the type of setting you selected. You can select 
one of the following types of settings.
■ A setting that contains two values only, like 'On' or ' Off'.

Change the value of the setting with the scroll-wheel key to change the value of 
the setting. The value and icon changes.

■ A setting that contains a list of values, like 'Lighter/darker'.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

■ A setting that contains a list of settings, like 'Media'.
Focus on a setting with the scroll wheel. The bold text of a value indicates the 
focus of the scroll wheel. The icon changes.
Open the setting with the scroll-wheel key. The list of values appears.
Open the setting with the scroll-wheel key.
Define the required value with the scroll wheel. The value and icon changes.
Close the setting with the scroll-wheel key.

Note: You can enter a numeric value with the numeric keys. To enter a negative 
numeric value, scroll to a negative value first and than enter the value with the 
numeric keys.

6. Select 'Close' with the lower-scroll-wheel key.
7. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job 
template to default. 
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Do a basic copy job

Introduction

The main steps of a basic copy job consists of the following steps.
■ Feed the original.
■ Press the green start key.

How to copy on the Océ TCS500

1. Place the original face down and right aligned.
The scanner takes the original.

[129] 

[129] Place the original face down and right aligned

2. Press the green start key.
The scanner operator panel shows the copy job number and the status of the copy job.

Note: You can copy faster when you feed the original landscape.

Result

The Océ TCS500 makes a copy.
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Do an extended copy job

Introduction

The main steps of an extended copy job are the following.
■ Feed the original.
■ Define the job settings.
■ Press the green start key.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

How to copy on the Océ TCS500

1. Place the original face down and right aligned.
The scanner takes the original.

[130] 

[130] Place the original face down and right aligned

2. Define  the job settings.
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[131] 

[131] The top 5 settings of a copy job template

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to a setting.
■ Select a setting with the left softkey.
■ Scroll to the required value.
■ Select the next  setting with the left softkey.
■ Scroll to the required value.
■ Select 'Close' to close the setting.

3. Define the number of copies if necessary and press the green start key.

Note: You can copy faster when you feed the original landscape, unless you must 
scale your original to another media size. In that case you must feed the original 
portrait. 

Result

The Océ TCS500 makes a copy according to the defined settings.
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Stop a copy job

Stop a copy job

Introduction

You can stop a copy job with the red stop key on the scanner operator panel.

How to stop a copy job

1. Press the red stop key.

Note: This will not affect a set job.

Result

When you press the red stop key while the scanner scans, the scan process stops. The 
scanner rewinds the original and the copy job is cancelled.
When you press the red stop key while the scanner rewinds, the rewind process 
continues. The copy job is cancelled.
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Extended copy jobs

Available settings for copy jobs

Introduction

The Océ TCS500 provides a lot of settings to manage all your different copy jobs. 
These settings are used for extended copy jobs. The following table gives an 
overview and a very short description of the available settings. This table is not 
complete, because a setting can contain more than one setting. You find a detailed 
description of each setting in the on-line help at the Océ Settings Editor. You can 
change the default value of a setting that you use very often in the job template at the 
Océ Settings Editor. 

Available settings for copy jobs
[64] 

[64] The available settings for copy jobs, a setting can contain more than one  
setting. (1 – 6)

Setting Function

'Original type' Use this setting to define the type of original for your 
copy jobs. The defined type influences the quality of 
the output. (see ‘'Original type' and background 
compensation’ on page 140)
[132] 

[132] 'Original type' (example)

'Scale' Use this setting if the size of your output must be 
different from the size of your original.  
(see ‘Scale to another media size’ on page 180)
[133] 

[133] 'Scale' (example)
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Available settings for copy jobs

'Media' Use this setting to define the media feed. You can 
select one of the following options.
■ Auto
■ Roll 1: 'Media description'
■ Roll 2: 'Media description' (if available)
■ Roll 3: 'Media description' (if available)

[134] 

[134] 'Media' (example)

'Lighter/darker' Use this setting to make your output lighter or darker.
[135] 

[135] 'Lighter/darker' (example)

'Copy Output' / 'Colour' 
mode

Use this setting to define if you want a 'Colour' output 
or a 'Greyscale' output.
[136] 

[136] 'Copy Output' /  'Colour' mode(example)

[64] The available settings for copy jobs, a setting can contain more than one  
setting. (2 – 6)

Setting Function
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'Copy Output' / 'Quality' 
mode

Use this setting to define the 'Quality' of your copied 
output. You can select one of the following options.
■ 'Presentation'
■ 'Release'
■ 'Check'

[137] 

[137] 'Copy Output' / 'Quality' mode (example)

'Original width' Use this setting to define the width of your original. 
You can select one of the following options.
■ 'By scanner'
■ 'Custom'

[138] 

[138] 'Original width' (example)

'Delete area' Use this setting to make a copy of your original 
without a specific area. (see ‘Make a copy and delete a 
specific area of an original’ on page 186)
[139] 

[139] 'Delete area' (example)

[64] The available settings for copy jobs, a setting can contain more than one  
setting. (3 – 6)

Setting Function
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Available settings for copy jobs

'Remove strip' Use this setting to make a copy of your original 
without the selected strips. (see ‘Make a copy and 
remove a strip’ on page 182) and (see ‘Make a copy of 
a specific area of an original’ on page 184)
[140] 

[140] 'Remove strip' (example)

'Cut method' Use this setting to define the cut method of the printer. 
You can select one of the following options.
■ 'Synchro'
■ 'Standard'

[141] 

[141] 'Cut method' (example)

'Add strip' Use this setting to make a copy of your original with 
an additional strip. (see ‘Make a copy and add a strip’ 
on page 181)
[142] 

[142] 'Add strip' (example) 

[64] The available settings for copy jobs, a setting can contain more than one  
setting. (4 – 6)

Setting Function
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'Alignment' Use this setting to define how you want to align the 
image of the copied output. You can select one of the 
following options.
'Horizontal'
■ 'Left'
■ 'Centre'
■ 'Right'

'Vertical'
■ 'Top'
■ 'Centre'
■ 'Bottom'

[143] 

[143] 'Alignment' (example)

'Shift' Use this setting to define how you want to shift the 
image of your original on the copied output. You can 
select one of the following options.
■ Horizontal shift
■ Vertical shift

[144] 

[144] 'Shift' (example)

[64] The available settings for copy jobs, a setting can contain more than one  
setting. (5 – 6)

Setting Function
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Available settings for copy jobs

'Mirror' Mirror the image of the copy
[145] 

[145] 'Mirror' (example)

'Collate' Use this setting to define how you want to collate your 
copied output. (see ‘Make multiple sets of copies’ on 
page 178)

[64] The available settings for copy jobs, a setting can contain more than one  
setting. (6 – 6)

Setting Function
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Improve  the copy quality according to the original

Introduction

You can improve the copy or scan quality even more for the following situations.
■ You have an original from a special type.

The Océ TCS500 scanner makes sure that the copy or the scanned file has a sharp 
image. You can define the 'Original type' setting  manually to improve the copy 
or scan quality according to the type of original you use.

■ You have a dark or light original.
The Océ TCS500 scanner detects the brightness of the  image  on the original 
automatically and makes sure that the copy or the scanned file has a bright image. 
You can adjust the brightness manually with the  'Lighter/darker' setting  to 
improve the copy or scan quality according to the type of original you use.

■ You have an original with very fine details.
The Océ TCS500 scanner optimizes the image of the original automatically. You 
can optimise the image manually to sharpen the fine details with the 'Copy 
Output' - 'Quality' setting.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

How to improve the copy quality of originals from a special type

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[146] 

[146] The 'Line Art' icon of the 'Original type' setting

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to 'Original type' and open this setting with the left softkey.
■ Scroll to the original type you have.

3. Define the number of copies if necessary and press the green start key.
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Result

The copy quality was improved according to the original type.

How to improve the copy quality of dark and light originals

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[147] 

[147] The 'Lighter/darker' icon

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to  'Lighter/darker' and open this setting with the left softkey.
■ Adjust the required value.

A positive value lightens the copy, a negative value darkens the copy.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality improved according to the brightness of the original.
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How to improve the copy quality of an original with very fine details

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[148] 

[148] The 'Presentation' icon of the  output 'Copy Output' - 'Quality' setting

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to 'Copy Output' - 'Quality' and open this setting with the left softkey.
■ Scroll to 'Presentation'.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality improved according to the fine details on the original.
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Make multiple sets of copies

Introduction

You can use the 'Create set' option to make multiple sets of copies.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

Illustration
[149] 

[149] The 'By set' (left) and 'By page' icon of the 'Collate' setting.

How to make multiple sets of copies sorted by set

1. Feed the first original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The 'Create set' option appears at the upper-right corner of the screen.
■ Select 'Create set' with the upper-right softkey.

The 'Cancel set' option appears at the upper-left corner of the screen. The 'Close 
set' option  appears at the upper-right corner of the screen.

■ Scroll to 'Collate' and define 'By set' with the left softkey. This setting is disabled 
after you press the green start key for the first time. 

■ Scroll to another setting if necessary, select the setting with the left softkey and 
define the value with the scroll wheel.

■ Define the number of copies and press the green start key. 
You can not change the number of copies after you press the green start key for 
the first time. 

■ Feed the next original, define the enabled settings for this original if necessary 
and press the green start key.
Repeat this step until all originals are fed.

3. Select 'Close set' with the upper-right softkey.
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How to make multiple sets of copies sorted by page

1. Feed the first original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The 'Create set' option appears at the upper-right corner of the screen.
■ Select 'Create set' with the upper-right softkey.

The 'Cancel set' option appears at the upper-left corner of the screen. The 'Close 
set' option appears at the upper-right corner of the screen.

■ Scroll to 'Collate' and define 'By page' with the left softkey. This setting is 
disabled after you press the green start key for the first time.

■ Scroll to another setting if necessary, select the setting with the left softkey and 
define the value with the scroll wheel.

■ Define the number of copies for the first original if necessary and press the green 
start key.

■ Feed the next original, define the enabled settings and the number of copies for 
this original if necessary and press the green start key.
Repeat this step until all originals are fed.

3. Select 'Close set' with the upper-right softkey.

Result

The Océ TCS500 copies a set of originals sorted by set or by page.
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Scale to another media size

Introduction

You can use the 'Scale' setting to copy to a larger or smaller media format. Use one 
of the following methods to scale a copy.
■ Select another media format with the 'To fit' setting.
■ Adjust a value in terms of percentage with the 'Custom' setting.

You can adjust a value between 10 and 1000%. A value lower than 100% reduces 
the copy, a value greater than 100% enlarges the copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

How to copy to another media size

1. Place the first original face down and right aligned. Make sure that you feed the 
original portrait.
The scanner takes the original.

2. Define the job settings.
[150] 

[150] Example of a 'Scale' icon

■ Select 'Copy' with the upper-left softkey.
The copy job templates appear.

■ Open a copy job template with a left softkey.
The top 5 settings appear.

■ Scroll to 'Scale' and open this setting with the left softkey.
The 'To fit' and the  'Custom' setting appear. 

■ Define the media format at the 'To fit' setting with the scroll wheel.

3. Define the number of copies and press the green start key.

Result

The Océ TCS500 copies to another media size.
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Make a copy and add a strip

Introduction

You can use a strip to file a drawing. Use 'Add strip' to copy an original without a 
strip and add a strip to the copy. Use 'Remove strip' to copy an original with a strip 
and remove the strip from the copy. You can adjust a strip at the leading or trailing 
side of a copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

How to make a copy and add a strip

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Add strip' and open this setting with the left softkey.
■ Select 'Leading' or 'Trailing' with the left softkey and define the value with the 

scroll wheel or numeric keys.

[65] 

3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the scanner 
(metric).

Result

The Océ TCS500 adds a trailing or leading strip from the copy.

[151] [152] 

The 'Leading' strip The 'Trailing' strip
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Make a copy and remove a strip

Introduction

You can use a strip to file a drawing. Use 'Add strip' to copy an original without a 
strip and add a strip to the copy. Use 'Remove strip' to copy an original with a strip 
and remove the strip from the copy. You can adjust a strip at the leading or trailing 
side of a copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

Attention: When you remove a strip, make sure that you copied all the required 
information.
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How to make a copy and remove a strip

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Remove strip' and open this setting with the left softkey.
■ Select 'Leading' or 'Trailing' with the left softkey and define the value with the 

scroll wheel or numeric keys.

[66] 

3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the scanner 
(metric).

Result

The Océ TCS500 removes a trailing or leading strip to the copy.

[153] [154] 

The 'Leading' strip The 'Trailing' strip
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Make a copy of a specific area of an original

Introduction

You can make a copy of a specific area of an original with the 'Remove strip' setting. 
Define the following strips to specify the area.
■ 'Leading'
■ 'Trailing'
■ 'Left'
■ 'Right'

Before you begin

If you must enter the same value for a setting very often, you can set this value as the 
default value for that setting in the Océ Settings Editor. 
After you press the start key, the scanner operator panel always shows the job 
number and status of the job. A copy job appears temporarily in the printer queue of 
the Océ Queue Manager, a scan-to-file job appears in the selected destination of the 
Océ Scan Manager.

Attention: When you remove a strip, make sure that you copied all the required 
information.
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How to copy a specific area of an original

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Remove strip' and open this setting with the left softkey.
■ Define the 'Leading' strip value with the scroll wheel or numeric keys.
■ Select 'Trailing' with the left softkey and define the value with the scroll wheel or 

numeric keys.
■ Select 'Left' with the left softkey and define the value with the scroll wheel or 

numeric keys.  'Left' is the left side of an original that is turned face up.
■ Select 'Right' with the left softkey and define the value with the scroll wheel or 

numeric keys and close the setting. 'Right' is the right side of an original that is 
turned face up.

■ Scroll to 'Alignment' and open this setting with the left softkey.
■ Define the value of the  'Horizontal' setting to 'Centre' with the scroll wheel.
■ Select 'Vertical' with the left softkey and define 'Centre' with the scroll wheel.

[67] 

3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the scanner 
(metric).

Result

The Océ TCS500 copies a specific area of the original to the specified position on 
the copy.

[155] [156] [157] [158] 

The 'Leading' strip The 'Trailing' strip The 'Left' strip The 'Right' strip
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Make a copy and delete a specific area of an original

Make a copy and delete a specific area of an original

Introduction

You can make a copy without a specific area of an original with the 'Delete area' 
setting.

Attention: When you copy without a specific area, make sure that you copied 
all the required information.

How to copy a specific area of an original

1. Place the original face down and right aligned.
The scanner takes the original.

2. Define the job settings.
[159] 

[159] The icons of 'Y Offset', 'X Offset','Width' and 'Length' setting
■ Select 'Copy' with the upper-left softkey.

The copy job templates appear.
■ Open a copy job template with a left softkey.

The top 5 settings appears.
■ Scroll to 'Delete area' and open this setting with the left softkey.
■ Define the 'X Offset' with the scroll wheel or numeric keys.
■ Select 'Y Offset' with the left softkey and define the value with the scroll wheel 

or numeric keys.
■ Select 'Width' with the left softkey and define the value with the scroll wheel or 

numeric keys.
■ Select 'Length' with the left softkey and define the value with the scroll wheel or 

numeric keys and close the setting.

3. Define the number of copies if necessary and press the green start key.

Result

The Océ TCS500 copies an original without the specified area.
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Introduction to how to ensure the best output quality

Introduction to how to ensure the best output quality

Introduction

This chapter describes how to make sure you have the best quality for your print jobs.
It is important to know that the quality of your output depends on both the scan 
quality of the scanner and the print quality of the printer.

■ The Océ TCS500 offers several methods that help you to define the best print 
mode for your job. These methods are described in the Define the output quality 
section of this chapter.

■ The Océ TCS500 has 3 methods that help you to identify and analyse changes in 
the output quality, the 'Quality check' print, the 'Tone scale area check' print, and 
the 'Demo print'. The Check the output quality section of this chapter describes 
these 3 methods. 

■ When you find problems with the output quality, the Optimise the output 
quality section of this chapter helps you to correct the problems.

To optimise the colours of your printed output, you can adjust the Colour 
Management settings. The Colour Management section of this chapter gives an 
overview of these Colour Management settings.

When to do

Only do actions to optimise the output quality based on the information supplied in 
the 'Check the output quality' section. 

When you are not satisfied with the output quality, use the following procedure

1. Make sure that you loaded and defined the correct media type on the printer.
Use the 'Change media type' wizard to change the media type defined on the system. 
(see ‘Replace the media’ on page 239).
Also make sure you defined the correct media type for your job.

2. Make sure you defined the correct output mode for your job.  
(see ‘The quality modes’ on page 189).

3. Finally, when you have defined the correct media and the correct print mode, and you 
are still not satisfied with the output quality, use the wizards to achieve optimal 
output quality. (see ‘Optimise the output quality on the printer’ on page 211).
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Define the output quality

The quality modes

Introduction

The Océ TCS500 enables you to select the correct quality mode for your output 
requirements. You can define the required quality mode in the printer driver. You can 
define the default quality mode in the Océ Settings Editor.

The Quality modes

Use these modes to define the output quality. You can select the following.

[68] 

[68] The output quality 

Quality mode Function

'Check' The print speed is maximum. This quality mode is used for 
fast printing of (line) drawings with good output quality. 
For other types of jobs, like print jobs with area coverages, 
you can use this quality mode to check if all the 
information is visible on the printed output. For these print 
jobs the output quality is good.

'Release' The print speed is very high. This quality mode is best for 
drawings, very good for images and provides a good 
combination of output quality and productivity. In this 
quality mode the printer will automatically optimise the 
print quality and the productivity based on the file content. 
Drawings will be printed twice as fast as images, resulting 
in optimal productivity and quality for most customers.
The Océ TCS500 further offers Dynamic switching 
Technology. In case a print job has mixed contents 
(drawings and images), the printer will adjust the print 
quality and the productivity automatically during the print 
process, without customer intervention.

'Presentation' Select this quality mode  if you need the best possible 
output quality. Especially for images, posters. The print 
speed is high. 
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Output type, output quality and print speed

Output type, output quality and print speed

Introduction

The type of your printed output depends on the following parameter.
■ The colour mode ('Greyscale' / 'Colour'

The quality of your printed output depends on the following parameters.
■ The media type
■ The quality mode
■ The print speed

The lower the print speed, the better the output quality.

The following table describes the relation between these parameters.

The relation between the output type and the quality parameters
[69] 

[69] The relation between the output quality parameters 

Colour mode Quality mode Print speed for all media 
(per A0, not including the 
drying time and the 
processing time)
(minutes' seconds")

'Greyscale' 'Check' 0'41"

'Release' Between 1'00" and 3'40", 
dependant on file content 
(the printer automatically 
optimises between print 
quality and productivity.

'Presentation' 3'40"

'Colour' 'Check' 1'03"

'Release' Between 3'05" and 6'15", 
dependant on file content 
(the printer automatically 
optimises between print 
quality and productivity.

'Presentation' 9'15"
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Recommended media types and quality modes

Introduction

The selection of the media and the quality modes depends on the application of the 
output. The tables give you an idea of which media type and quality modes to use in 
a work process.

CAD drawings - Greyscale
[70] 

[70] CAD drawings - Greyscale 

When to use Recommended media type Recommended Quality 
mode

To check a drawing Draft paper
Standard paper
Tracing paper
Bond
Translucent bond

'Check'
'Release'

To release a 
drawing

Draft paper
Standard paper
Tracing paper
Premium coated paper
Matt film
Bond
Translucent bond
Deluxe bond

'Release'

To present a 
drawing

Draft paper
Standard paper
Tracing paper
Premium coated paper
Matt film
Bond
Translucent bond 
Deluxe bond

'Presentation'

To archive a 
drawing

Matt film
Color vellum

'Release'
'Presentation'

Diazo Tracing paper
Matt film
Translucent bond
Color vellum

'Release'
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Recommended media types and quality modes

CAD and GIS drawings - Colour
[71] 

CAD and GIS drawings - Colour (high density)
[72] 

[71] CAD and GIS drawings - Colour 

When to use Recommended media type Recommended quality 
mode

To check a drawing Draft paper
Standard paper
Tracing paper
Bond
Translucent bond 

'Check'

To release a drawing Draft paper
Standard paper
Premium coated paper
Matt film
Bond
Deluxe bond

'Release'

To present a drawing Draft paper
Standard paper
Premium coated paper
Matt film
Bond
Coated bond

'Presentation'

To archive a drawing Matt film 'Release'
'Presentation'

[72] CAD and GIS drawings - Colour (high density) 

When to use Recommended media type Recommended quality 
mode

To release a drawing Premium coated paper
High gloss photo paper

'Release'

To present a drawing Premium coated paper
High gloss photo paper

'Release'
'Presentation'
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Colour Management

'Colour Management'
Path: Key Operator - Jobs - Print - Defaults - Colour Management

Depending on the type of file you want to print, the Océ TCS500 offers different 
colour-information conversions. You can select the 'Colour Management' settings, 
that give the best results for the colour-information conversion.
The tables below give an overview of the possible 'Colour Management' settings per 
'File type'. The default settings are emphasised.

'Colour Management' settings in the Settings Editor
[160] 

File type: Vector ('HP-GL, HP-GL/2, HP-RTL')
[73] 

[73] Overview  'Colour Management' settings for 'HP-GL, HP-GL/2, HP-RTL' files. (1 – 2)

Basic setting
'Colour feel'

Advanced settings

'Océ CAD colours' - -
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'Colour Management'

'Océ enhanced colours' 'Enhanced colours: 
RGB input data'

■ 'sRGB'
■ 'Adobe RGB'

'Enhanced colours: 
Rendering intent'

■ 'Perceptual (photo)'
■ 'Saturation (business 

graphics)'
■ 'Absolute colorimetric'
■ 'Relative colorimetric'

'Simulated Océ 
TCS400 CAD colours'

- -

'Simulated non-Océ 
printer: vivid colours'

- -

'Simulated non-Océ 
printer: match screen 
colours'

- -

'Simulated non-Océ 
printer: no colour 
correction'

- -

'None, managed by 
application'

- -

[73] Overview  'Colour Management' settings for 'HP-GL, HP-GL/2, HP-RTL' files. (2 – 2)

Basic setting
'Colour feel'

Advanced settings
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File type: Bitmap ('TIFF')
[74] 

[74] Overview 'Colour Management' settings for 'TIFF' files 

Basic setting
'Colour feel'

Advanced settings

'Océ CAD colours' - -

'Océ enhanced 
colours'

'Enhanced colours: 
RGB input data' ■ 'sRGB'

■ 'Adobe RGB'

'Enhanced colours: 
Rendering intent'

■ 'Perceptual (photo)'
■ 'Saturation (business 

graphics)'
■ 'Absolute colorimetric'
■ 'Relative colorimetric'

'Simulated Océ 
TCS400 CAD colours'

- -

'Simulated non-Océ 
printer: vivid colours'

- -

'Simulated non-Océ 
printer: match screen 
colours'

- -

'Simulated non-Océ 
printer: no colour 
correction'

- -

'None, managed by 
application'

- -
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'Colour Management'

File type: PostScript ('PostScript®, PDF')
[75] 

Note: There are a number of factors that influence the quality of your printed 
output. The 'Colour Management' settings allow you to finetune the result of your 
printed output for a number of input file types (Vector / Bitmap / PostScript). In 
addition the colour mode, the type of output media and the print quality (print speed) 
you select, have an impact on the quality of the final result. 

[75] Overview 'Colour Management' settings for  'PostScript®, PDF' files. 

Basic setting
'Colour feel'

Advanced settings

'Océ CAD colours' - -

'Océ enhanced 
colours'

'Enhanced colours: 
RGB input data'

■ 'sRGB'
■ 'Adobe RGB'

'Enhanced colours: 
CMYK input data'

■ 'Euroscale coated'
■ 'Euroscale uncoated'
■ 'US web coated (SWOP)'
■ 'US web uncoated'

'Enhanced colours: 
Rendering intent'

■ 'Perceptual (photo)'
■ 'Saturation (business 

graphics)'
■ 'Absolute colorimetric'
■ 'Relative colorimetric'

'Simulated Océ 
TCS400 CAD colours'

- -

'Simulated non-Océ 
printer: vivid colours'

- -

'Simulated non-Océ 
printer: match screen 
colours'

- -

'Simulated non-Océ 
printer: no colour 
correction'

- -

'None, managed by 
application'

- -
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'Colour feel'
Path: Key Operator - Jobs - Print - Defaults - Colour Management - HP-GL, 
HP-GL/2, HP-RTL

Path: Key Operator - Jobs - Print - Defaults - Colour Management - TIFF

Path: Key Operator - Jobs - Print - Defaults - Colour Management - PostScript, 
PDF

'Colour feel' settings in the Settings Editor
[161] 

One of the options you have to finetune your output quality is to adjust the 'Colour 
Management' settings.
With the 'Colour Management' setting  'Colour feel' you can finetune the look and 
feel of the printed colours. 

Note: You can select the 'Colour feel' setting for each input 'File type' ('HP-GL, 
HP-GL/2, HP-RTL' / 'TIFF' / 'PostScript®, PDF'). 
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'Colour feel'

[76] 

[76] Overview of the 'Colour feel' settings. 

'Colour feel' Description

'Océ CAD colours' This setting gives bright saturated colours.
Advised for: line and vector drawings.

'Océ enhanced colours' This setting gives photo-realistic colours. 
Advised for: photos or graphic art presentations.
If you select 'Océ enhanced colours' you can also 
adjust the advanced Colour Management 
settings.
■ 'Enhanced colours: RGB input data'
■ 'Enhanced colours: CMYK input data' (only 

for 'File type''PostScript®, PDF') 
■ 'Enhanced colours: Rendering intent'

'Simulated Océ TCS400 CAD 
colours'

Use this setting to get a print with colours similar 
to the Océ TCS400 printer.

'Simulated non-Océ printer: 
vivid colours'

Use this setting to get a print with colours similar 
to a non-Océ printer, that prints vivid colours.

'Simulated non-Océ printer: 
match screen colours'

Use this setting to get a print with colours similar 
to a non-Océ printer, that prints match screen 
colours.

'Simulated non-Océ printer: no 
colour correction'

Use this setting to get a print with colours similar 
to a non-Océ printer, that prints without colour 
correction.

'None, managed by application' Use this setting if your colour management is 
completely done by the application that 
generated the print file.
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'Enhanced colours: RGB input data'
Path: Key Operator - Jobs - Print - Defaults - Colour Management - HP-GL, 
HP-GL/2, HP-RTL

Path: Key Operator - Jobs - Print - Defaults - Colour Management - TIFF

Path: Key Operator - Jobs - Print - Defaults - Colour Management - PostScript, 
PDF

One of the options you have to finetune your output quality is to adjust the 'Colour 
Management' settings.
If the 'Colour Management' setting 'Colour feel' is set to 'Océ enhanced colours' you 
can define the 'Enhanced colours: RGB input data' setting. This setting specifies the 
source colour space for printing RGB images, objects and text and allows the Océ 
TCS500 to select the best conversion from the source's RGB-colour space to the 
printer's CMYK colours (colour mapping). 

Note: You can select the 'Enhanced colours: RGB input data' setting for each input 
'File type' ('HP-GL, HP-GL/2, HP-RTL' / 'TIFF' / 'PostScript®, PDF'). 

[77] 

[77] Overview of the 'Enhanced colours: RGB input data' settings. 

'Enhanced colours: RGB 
input data'

Description

'sRGB' This setting specifies the source space of a 
generic computer monitor.

'Adobe RGB' This setting specifies an RGB colour space 
developed by Adobe in 1998.
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'Enhanced colours: CMYK input data'

'Enhanced colours: CMYK input data'
Path: Key Operator - Jobs - Print - Defaults - Colour Management - PostScript, 
PDF

One of the options you have to finetune your output quality is to adjust the 'Colour 
Management' settings.
If the 'Colour Management' setting 'Colour feel' is set to 'Océ enhanced colours' you 
can define the 'Enhanced colours: CMYK input data' setting. This setting simulates 
printing to an offset press standard.

Note: You can only select the 'Enhanced colours: CMYK input data' setting for the 
'File type''PostScript®, PDF'. 

[78] 

[78] Overview of the 'Enhanced colours: CMYK input data' settings. 

'Enhanced colours: CMYK 
input data'

Description

'Euroscale coated' This setting uses an offset press standard often 
used in Europe for printing separations and 
proofs on coated media.

'Euroscale uncoated' This setting uses an offset press standard often 
used in Europe for printing separations and 
proofs on uncoated media.

'US web coated (SWOP)' This setting uses an offset press standard often 
used in the US for printing separations and 
proofs on coated media.

'US web uncoated' This setting uses an offset press standard often 
used in the US for printing separations and 
proofs on uncoated media.
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'Enhanced colours: Rendering intent'
Path: Key Operator - Jobs - Print - Defaults - Colour Management - HP-GL, 
HP-GL/2, HP-RTL

Path: Key Operator - Jobs - Print - Defaults - Colour Management - TIFF

Path: Key Operator - Jobs - Print - Defaults - Colour Management - PostScript, 
PDF

One of the options you have to finetune your output quality is to adjust the 'Colour 
Management' settings.
If the 'Colour Management' setting 'Colour feel' is set to 'Océ enhanced colours' you 
can define the 'Enhanced colours: Rendering intent' setting. Use this setting if the 
colour space that your print file was made in does not fully comply with the colour 
space of the printer (colour conversion).

Note: You can select the 'Enhanced colours: Rendering intent' setting for each input 
'File type' ('HP-GL, HP-GL/2, HP-RTL' / 'TIFF' / 'PostScript®, PDF'). 

[79] 

[79] Overview of the 'Enhanced colours: Rendering intent' settings. (1 – 2)

'Enhanced colours: 
Rendering intent'

Description

'Perceptual (photo)' This setting optimises the output to produce best 
results for photographic or scanned images.

'Saturation (business graphics)' This setting optimises the output of bright, 
saturated colours such as those used in business 
presentations.
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'Enhanced colours: Rendering intent'

'Absolute colorimetric' This setting provides the highest accuracy in 
rendering RGB colours into CMYK colours, 
including rendering the source's white.

Note: The slightly bluish cast of the 
monitor background might be 
noticeable as bluish white in the 
lightest tones of the printed output.

'Relative colorimetric' This setting provides a high accuracy in 
rendering RGB colours into CMYK colours, but 
maps the source's white to the media's white 
point, so that any monitor background colour 
cast is eliminated. Though the printed output 
will be colourful, this setting may lead to a loss 
of contrast in the dark areas.

Note: If you generate  a colour 
scan-to-file job in TIFF format on an 
Océ TCS400, an Océ TCS500 or an 
Océ TDS450, 'Relative colorimetric' 
gives the best result.

[79] Overview of the 'Enhanced colours: Rendering intent' settings. (2 – 2)

'Enhanced colours: 
Rendering intent'

Description
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Check the output quality 

Output quality problems

Introduction

The Océ TCS500 offers three possibilities to check the quality of your printed 
output.
■ Make a quality check print
■ Make a tone scale area print
■ Make a demo print.

This section describes the problems you can analyse by making one of these check 
prints. The Optimise print quality section describes how you can solve problems 
with the quality (see ‘'Quality check' print’ on page 208).

Overview of output quality problems - Graininess
[80] 

[80] Graininess problems 

Graphical representation of the 
problem

Description

[162] 

Colour specific graininess
Perform an 'Optimise print quality' test. 
The test checks all printheads and the 
printer compensates for missing 
nozzles.

Note: After the 'Optimise 
print quality' test is 
completed, the printer may 
ask you to replace a 
printhead. In this case, take 
out the printhead and clean 
the contact area with a 
lintfree cloth.
If the printhead is still not 
accepted, insert a new 
printhead.
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Output quality problems

Overview of output quality problems - Stripes and Banding
[81] 

[81] Stripes and Banding problems (1 – 2)

Graphical representation of the 
problem

Description

[163] 

Small stripes over the entire width of 
the print (colour independent)
Perform an 'Optimise print quality' test.

Note: This problem can 
occur in all print modes.

[164] 

■ Thin (White) Stripes or weak lines 
(Nozzle dropouts)

■ Stripes per primary colour
■ Stripes in parts / dotted lines but 

also over the entire width

Usually you will find these stripes only 
in the check mode. In this mode some of 
these lines are acceptable,  because 
there is no nozzle compensation.
The nozzle compensation, that is used in 
the release mode and in the presentation 
mode, will correct the lines.
■ If these lines are unacceptable, 

switch to a slower mode ('Release' or 
'Presentation'). Perform an 'Optimise 
print quality' test. The test checks all 
printheads and the printer 
compensates for missing nozzles.

■ Check if the maintenance cassette is 
clean. If necessary, clean the wipers 
with a moist, lintfree cloth.
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[165] 

Stripes perpendicular to the paper 
feed direction
In check mode the width of these lines is 
12 mm.
In release mode the lines are smaller 
(3-6 mm) and less visible.
Perform an 'Optimise print quality' test.

Note: After the 'Optimise 
print quality' test is 
completed, the printer may 
ask you to replace a 
printhead. In this case, take 
out the printhead and clean 
the contact area with a 
lintfree cloth and re-insert 
the printhead.
If the printhead is still not 
accepted, insert a new 
printhead.

[166] 

Banding in specific colours
Perform an 'Optimise print quality' test.

[167] 

Banding in all colours with 
alternating light and dark bands 
(bands can have different widths)
Perform an 'Optimise print quality' test.
If the problems persists, repeat the 
'Optimise print quality' test.

[81] Stripes and Banding problems (2 – 2)

Graphical representation of the 
problem

Description
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Output quality problems

Overview of output quality problems - Waves / Cockle
[82] 

[82] Waves / Cockle problems 

Graphical representation of the 
problem

Description

[168] 

Waves and or light stripes in the 
paper feed direction
Bands can consist of waves and / or 
slight colour differences of 
approximately 1cm.
Check if the correct media is defined on 
the system. (see ‘How to correct the 
media type defined on the system’ on 
page 244)
If yes, select a different media type.
When the printer applies a lot of ink the 
paper can cockle. Use premium papers 
or coated papers because they have a 
better resistance towards waving (also 
called cockle). If the problem persists, 
the use of heavier media will reduce 
cockle.
The following papers will never show 
cockle.
■ IJM149 Océ Smart Matt 120g
■ IJM150 Océ Smart Matt 170g
■ IJM155 Océ Smart Poster Paper 

Matt (180g)
■ IJM222 Océ Top Photo Paper
■ PrintPerfectPaper 180g (Océ USA)
■ PhotoPerfectPlusGlossy (180g) 

(Océ USA)
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Overview of output quality problems - Colours
[83] 

[83] Colour problems 

Graphical representation of the 
problem

Description

[169] 

Weak and polluted lines
Select the  'Océ CAD colours' setting 
from the 'Colour Management' menu in 
the Océ Settings Editor, PEWG (LT) or 
Océ Windows Printer Driver.

[170] 

Blue lines and areas appear purple
Select the 'Océ CAD colours' setting 
from the 'Colour Management' menu in 
the Océ Settings Editor, PEWG (LT) or 
Océ Windows Printer Driver.

[171] 

Colours appear too dark and dark 
areas are clipped
Select 'Océ enhanced colours' setting 
from the 'Colour Management' menu in 
the Océ Settings Editor, PEWG (LT) or 
Océ Windows Printer Driver.
Set the subset 'Rendering intent' to 
'Perceptual (photo)'.
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'Quality check' print

'Quality check' print

Introduction

The 'Quality check' print option is a quick method to help you find the cause of an 
unsatisfactory output quality. The 'Quality check' print option is especially useful to 
check the quality of printed lines.
Use the 'Quality check' print option on the printer operator panel to trace output 
quality problems. (see ‘Output quality problems’ on page 203)

How to make a quality check print

The system prints the 'Quality check' print in the 'Presentation' quality mode. The 
system uses a minimum of media for the 'Quality check' print. You are recommended 
to use Océ Premium Grade Paper (IJM113) for the 'Quality check' print. 

Do the following to make a quality check print.

1. Scroll to the 'System information' card on the on-line screen of the printer operator 
panel.
2. Use the lower softkey for 'Demo print' to enter the menu.
3. Use the lower softkey to select 'Quality check'. 
4. Check the output for the problems with the quality described below.
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'Tone scale area check' print

Introduction

The 'Tone scale area check' print option is a quick method to help you find the cause 
of an unsatisfactory output quality. The 'Tone scale area check' print option is 
especially useful to check the quality of the colour rendering and the colour fastness. 
(see ‘Output quality problems’ on page 203)

How to make a tone scale area print

The system prints the 'Tone scale area check' print in the 'Presentation' quality mode. 
The system uses a minimum of media for the 'Tone scale area check' print. You are 
recommended to use Océ Premium Grade Paper (IJM113) for the 'Tone scale area 
check' print. 

Do the following to make a tone scale area print.
1. Scroll to the 'System information' card on the on-line screen of the printer operator 
panel.
2. Use the lower softkey for 'Demo print' to enter the menu.
3. Use the lower softkey to select 'Tone scale area check'. 
4. Check the output for the problems with the quality described below.
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'Demo print'

'Demo print'

Introduction

You can make a demo print to get an impression of the print capabilities of the Océ 
TCS500.
Use the 'Demo print' print option on the printer operator panel to trace output quality 
problems. (see ‘Output quality problems’ on page 203)

How to make a demo print

The system prints the 'Demo print' in the 'Release' quality mode. The demo print 
takes several minutes to print. You are recommended to use Océ Premium Grade 
Paper (IJM113) for the 'Demo print'.

There are two methods to start the demo print.
■ Through the Océ System Control Panel
■ Through the 'System information' card on the on-line screen of the printer 

operator panel.
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Optimise the output quality

Optimise the output quality on the printer 

Introduction

This section describes different methods that you can use to optimise the output 
quality on the Océ TCS500 printer.

Problem analysis and solutions 
[84] 

[84] Problem analysis and solutions (1 – 4)

Problem Method of 
analysis

Solutions

The colour of one 
area merges with 
the colour of 
another area

'Quality check' 
print

■ The media type defined on the 
printer must be the same as the 
media available on the printer. When 
the media type defined on the printer 
is not the same as the media 
available on the printer, use the 
'Change media type' wizard to 
change the media type (see ‘Replace 
the media’ on page 239) 

■ Use coated media
■ Use the default drying time
■ Remove the printer from high 

humidity conditions.

The colour of one 
line runs into the 
colour of another 
line

'Quality check' 
print

■ The media type defined on the 
printer must be the same as the 
media available on the printer. When 
the media type defined on the printer 
is not the same as the media 
available on the printer, use the 
'Change media type' wizard to 
change the media type (see ‘Replace 
the media’ on page 239) 

■ Use coated media
■ Use the default drying time
■ Remove the printer from areas of 

high humidity.
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White stripes in 
filled areas

'Quality check' 
print

■ Use the 'Presentation' quality 
mode(see ‘Output type, output 
quality and print speed’ on 
page 190) 

■ Use the 'Optimise print quality' 
wizard to correct the problem (see 
‘Use the Optimise print quality 
wizard’ on page 215).

The output colour 
is not the same as 
the original colour

'Quality check' 
print

■ Make sure you define the correct 
software settings, for example the 
correct pen settings.

■ Use the 'Presentation' quality mode

The length and 
width 
measurements are 
different from the 
original

'Quality check' 
print

■ Make sure you defined the correct 
scale settings

■ Use the 'Presentation' quality mode
■ Use the 'Optimise print quality' 

wizard to correct the problem.
■ In case of a media length deviation, 

adjust the setting Key Operator - 
Printer - Media - Cut length 
correction in the Océ Settings 
Editor.

■ In case of a image length deviation, 
set the Key Operator - Printer - 
Vertical print optimisation to 'Size 
accuracy' and  adjust Key Operator 
- Printer - Image length correction 
in the Océ Settings Editor.

The coloured lines 
are not well 
aligned or blurred

'Quality check' 
print

■ Use the 'Presentation' quality mode
■ Use the 'Optimise print quality' 

wizard to correct the problem.
■ When failing printheads cause this 

problem, use the 'Replace printhead' 
wizard to replace the failing 
printheads (see ‘Replace a defective 
printhead’ on page 249).

[84] Problem analysis and solutions (2 – 4)

Problem Method of 
analysis

Solutions
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Missing sections 
in lines or stepped 
lines

'Quality check' 
print

■ Use the 'Presentation' quality mode
■ Use the 'Optimise print quality' 

wizard to correct the problem.
■ When failing printheads cause this 

problem, use the 'Replace printhead' 
wizard to replace the failing 
printheads.

Missing parts of 
characters

'Quality check' 
print

■ Use the 'Presentation' quality mode
■ Use the 'Optimise print quality' 

wizard to correct the problem.

Ink saturation 
causes the media 
to cockle

'Demo print' ■ The media type defined on the 
printer must be the same as the 
media available on the printer. When 
the media type defined on the printer 
is not the same as the media 
available on the printer, use the 
'Change media type' wizard to 
change the media type 

■ Use coated media.
■ Use the default drying time.
■ Remove the printer from areas of 

high humidity.

The individual ink 
drops merge on the 
media

'Demo print' Coalescence occurs in the 'Check' mode 
when you print on high gloss photo 
paper. Use the 'Release' or 'Presentation' 
quality mode

Problems with the 
nozzles cause 
drop-out

'Demo print' ■ Use the 'Optimise print quality' 
wizard to correct the problem.

■ A defective or end-of-life 
maintenance cassette can cause this 
problem. Use the 'Replace cassette' 
wizard to replace the maintenance 
cassette (see ‘Replace the 
maintenance cassette’ on page 254) 

■ Use the 'Optimise print quality' 
wizard to correct the problem.

[84] Problem analysis and solutions (3 – 4)

Problem Method of 
analysis

Solutions
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Optimise the output quality on the printer

The print contains 
regular horizontal 
light or dark bands

'Demo print' ■ The media type defined on the 
printer must be the same as media 
roll available on the printer. When 
the media type defined on the printer 
is not the same as the media 
available on the printer, use the 
'Change media type' wizard to 
change the media type

■ Use the 'Presentation' quality mode
■ Use the 'Optimise print quality' 

wizard to correct the problem.

Colour 
consistency 
problems

N/A ■ Some types of media can discolour 
with age. Check that the media is 
new and that is stored correctly.

■ Remove the printer from areas of 
high humidity.

[84] Problem analysis and solutions (4 – 4)

Problem Method of 
analysis

Solutions
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Use the Optimise print quality wizard

Introduction

The off-line screen of the printer operator panel contains the 'Optimise print quality' 
wizard that helps you to correct the problems with the output quality. The wizard 
performs the following actions.
■ Detect weak or failing nozzles. 

The Océ TCS500 automatically compensates the detected nozzles in future prints 
to make sure that print quality is optimal.

■ Align the printheads and optimise the paper transport.

During the 'Optimise print quality' wizard, the system performs an alignment. The 
alignment requires the use of media. Make sure at least one roll of the defined media 
(see ‘Set up unattended / overnight printing optimisation’ on page 157) is loaded 
before you enter the 'Optimise print quality' wizard.

Note: You can start the 'Optimise print quality' wizard from the printer operator 
panel or you can automatically optimise your print quality after a defined number of 
prints if you set 'Overnight printing optimisation' in  the Océ Settings Editor to 
'On'(see ‘Set up unattended / overnight printing optimisation’ on page 157).

When to do

Before you start the 'Optimise print quality' wizard, first check the following.
■ Did you use the correct media type?
■ Did you use the correct print mode?

Only start the wizard when you are sure that you used the correct media type and the 
correct print mode, and the output quality is still not satisfactory.

How to use the Optimise print quality wizard

1. Press the on-line / off-line key to set the printer off-line.
2. Press the upper softkeys to scroll to the 'Optimise print quality' card.

[172] 

3. Press the lower softkey for 'Optimise print quality' to enter the wizard.
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Use the Optimise print quality wizard

An introduction screen displays the message 'Use this wizard to optimise the print 
quality.'

[173] 

4. Press the key for 'Next'.
The screen displays the message 'Select roll to use'. 
You can only calibrate on the defined media types (see ‘Set up unattended / overnight 
printing optimisation’ on page 157). When calibration is not possible with the 
loaded media, the system asks you to load the correct media. When calibration is 
possible with one of the rolls, the system automatically uses the correct roll of media. 
When calibration is possible with both rolls, continue with step 5.

5. Press the lower softkeys to select a media roll for the calibration.
[174] 

6. Press the key for 'Next'.
The screen displays the message 'Preparing calibration...' The system prepares for 
the quality check.

[175] 

The screen displays feedback about the calibration process. The system does a 
nozzle failure recovery and alignment.
You can stop the calibration process at any time. Press the key for 'Cancel' to stop the 
calibration process.
In case more than 75 nozzles fail, a 'Printheads failing' message appears. Then you 
must replace the printhead, using the  'Replace printhead' wizard . 
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 Océ Account Center
Introduction

An overview of Océ Account Center

Introduction

Use Océ Account center to manage the account information of the print copy and 
scan-to-file jobs for your Océ TDS and Océ TCS devices.

Definition

Océ Account center consists of two software modules.
■ Océ Account Logic

Océ Account Logic runs on the Océ Power Logic® controller. You can connect to 
Océ Account Logic locally on the Océ Power Logic® controller or from a remote 
PC through a web browser. Océ Account Logic is managed by an administrator 
and mainly used by people that want to add account information to their print, 
copy or scan-to-file jobs.

■ Océ Account Console
Océ Account Console runs on a PC that functions as a server. You can connect to 
Océ Account Console from a local PC or remotely through a web browser. 
Access to Océ Account Console application is password protected and limited to 
authorised personnel such as an administrator and a book-keeper.
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Illustration
[176] 

User roles and tasks in Océ Account center
[85] 

[85] User roles and tasks in Océ Account center 

Users Tasks

1) Administrator A) Create, manage and delete the account dialogue.
B) Publish the account dialogue to the Océ Power Logic® 
controller. 

2) Users C) Use the dialogue of Océ Account Logic or the 
dialogue in the Océ Windows Printer Driver (WPD) or 
Océ Print Exec Workgroup to specify the account 
information for each copy, print and scan-to-file job.

3) book-keeper D) Retrieve and use the account information of the copy, 
print and scan-to-file jobs that is stored on the Océ Power 
Logic® controller. The log data serves as input for the 
accounting reports.
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Océ Account Logic

Introduction to Océ Account logic

Definition

Use Océ Account Logic to link account information to your job. The account 
information requirements are defined and managed by the administrator.

Purpose

Use Océ Account Logic for the following.
■ Enter the account information for the print jobs
■ Manage print jobs that do not have valid account information
■ Enter account information for the copy and scan-to-file jobs
■ Lock and unlock the scanner
■ Administer Océ Account Logic (administrators only).
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Summary of Océ Account Logic

Sections

Océ Account Logic has the following three sections.
■ The 'Copy & File' tab

Use this tab to enter account information for copy jobs and scan-to-file jobs.
■ The 'Print' tab

Use this tab to enter account information for print jobs.
■ The 'Administration' window.

Use this window to define the administrative settings for the application. Access 
to this window is password protected and limited to the application administrator.

Océ Account Console

Introduction to Océ Account Console

Definition

Océ Account Console is installed on the administrator's workstation. Access to Océ 
Account Console is password protected and limited to the administrator.

Purpose

Use Océ Account Console is intended for the following:
■ Manage, preview, and publish the account information dialogue for Océ Account 

Logic
■ Retrieve and export the log files.

Note: For this application a separate user manual is available.
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Océ Repro Desk

Océ Repro Desk

Introduction

Océ Repro Desk is a print management solution for reprographers.

Océ Repro Desk consists of two parts.

1. Océ Repro Desk Client
Océ Repro Desk Client is available in two versions. Both versions allow you to 
create, process and preview jobs, print to A4-size paper and submit drawings 
electronically.
■ Océ Repro Desk Remote Client allows you to submit jobs for printing via 

Internet, modem or FTP communication.
■ Océ Repro Desk LAN Client allows you to submit jobs for printing via LAN 

communication.

2. Océ Repro Desk Server
With the Océ Repro Desk Server software you can receive jobs from the clients by a 
modem, network, FTP or disk and you can arrange, prepare and print the digital files.
Océ Repro Desk Scan-to-file is an optional software application , used to scan paper 
originals and store them as digital files.

Note: For this application a separate Océ Repro Desk user manual is available.

Océ Engineering Exec®

Introduction

Océ Engineering Exec®is an integrated suite of applications to distribute, print and 
archive documents across the enterprise.

Océ Engineering Exec® products

Océ Engineering Exec® includes the following products.
■ Océ Doc Exec® Pro

An application to organise, archive and share documents.
■ Océ Print Exec® Pro

An application to provide controlled access to the documents, printing and 
distribution resources.

■ Océ Print Exec® Workgroup.
An application to define and control the print jobs via your  web browser.

Note: Visit Océ on the internet at www.oce.com for the latest information.
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Introduction to Océ License Logic

Introduction to Océ License Logic

Introduction

The Océ applications and options are protected against unauthorised use. You need 
to activate the license to enable an application or option for use. Océ License Logic 
enables you to manage the licenses very easy.

This section describes the following.
■ The basic concept of Océ License Logic
■ How to use  Océ License Logic.

The possibilities of Océ License Logic

Introduction

Océ License Logic has the following possibilities.

Possibilities

■ View the current active licenses
■ Get the host id of the Océ system
■ Save the active licenses
■ Perform a license activation job.

You can activate new licenses or saved licenses.
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The basic workflow of license activation

Introduction

Before you can use the possibilities of Océ License Logic, you must log on to Océ 
License Logic. The following workflow describes per step when to use which 
possibility.

The workflow

1. Select the new options you need.
Use the following possibilities of Océ License Logic to do so.
■ View the current active licenses

You can make a list of new options you need and make a list of license numbers. 
Océ needs the list of new options and the license numbers to create a new license 
file.

■ Get the host id of the Océ system.
Océ needs the host id of your Océ system to create a new license file.

2. Send the list of new options you need, the list of license numbers and the host id to 
Océ.
Océ creates and delivers one or more new license files.

3. Create a back-up of the current active licenses if necessary.
Use the following possibility of Océ License Logic to do so.
■ Save the current active licenses

4. Activate the licenses.
Use the following possibility of Océ License Logic to do so.
■ Perform a license activation job.

The license activation job guides you through the following steps.
1. Locate the license file
2. Preview the new active licenses
3. Accept the end user license agreement
4. Finish the license activation job
5. Restart the controller of the Océ system.

Note: Perform the license activation job for each license file.
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The structure of license files and licenses

Introduction

A license file contains a license per option of your Océ system. You can view the 
current active licenses with Océ License Logic. You can preview the new active 
licenses with Océ License Logic during the license activation job.

A license file contains licenses of the same license-type

A license file you receive from Océ contains only licenses of the same license-type. 
The following license types are possible.

■ Demo
■ Resale.

If you order demo and resale licenses, you receive 2 license files.

What  you see  per situation

What you see per situation depends on the license file you use.

[86] 

[86] What you see depends on the situation (1 – 2)

Situation What do you see

View the current active 
licenses.

You see the following.
■ All current active demo licenses
■ All current active resale licenses
■ All current other not active options.

Océ delivered one or more 
license files.

You see one of the following options.
■ A demo  license file
■ A resale license file
■ A demo  license file and a resale license file.

Preview the demo licenses  
during the license activation job 
if you use the license file with 
demo licences.

You see the following.
■ All current active demo licenses
■ All new active demo licenses.

Note: You can not see the current 
active resale licenses at this point.



227

The structure of license files and licenses

Preview the resale licenses 
during the license activation job 
if you use the license file that 
contains the resale licences.

You see the following.
■ All current active resale licenses
■ All new active resale licenses.

Note: You can not see the current 
active demo licenses at this point.

Preview the demo and resale 
licenses during the license 
activation job if you use the 
saved licenses of your back-up 
file.

You see the following.
■ All demo licenses that where active at the 

time you created the back-up file
■ All resale licenses that where active at the 

time you created the back-up file

The license activation job is 
finished.

You see the following.
■ All current active demo licenses
■ All new active demo licenses
■ All current active resale licenses
■ All new resale licenses
■ All current other not active options.

[86] What you see depends on the situation (2 – 2)

Situation What do you see
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Log on to  Océ License Logic

Introduction

You can run Océ License Logic on the controller of the Océ system or remote 
through a web browser. Access to Océ License Logic is password protected. Use the 
same System Administrator password as you use on the Océ system to log on.

Purpose

Log on to Océ License Logic for the following purposes.
■ View the current  active licenses
■ Get the host id of the Océ system
■ Save the current active licenses
■ Perform a license activation job.

You can activate new licenses or saved licenses.

Before you begin

To run Océ License Logic remote, you need the host name or IP address of the Océ 
system.

How to log on to  Océ License Logic on the Océ Power Logic® controller

1. Open the Océ Settings Editor
2. Click 'Edit' in the menu bar
3. Click 'Licenses...'

The logon window opens.
4. Select 'System administrator'
5. Enter the 'Password' 
6. Click the 'Logon' button.

How to log on to  Océ License Logic from a remote web browser

1. Open the web browser.
Océ License logic supports Microsoft® Internet Explorer® version 5.5 or higher.

2. Enter the following URL in your browser: http://'printer-name'/LicenseLogic.html

Note: 'Printer-name' is the host name or IP address of the printer.

The logon window opens.
3. Select 'System administrator'
4. Enter the 'Password' 
5. Click the 'Logon' button.
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Result

Océ License Logic starts with one of the following windows.

■ The 'No active license' window.
This window opens if there are no active licenses.

■ The 'View licenses' window.
This windows opens if Océ License Logic detects active licenses.

Note: If the log on failed, Océ License Logic displays a message. Read the message 
carefully and follow the instructions.
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View the  current active licenses

Introduction

When you log on and Océ License Logic detects active licenses, the 'View licenses'  
window opens and displays the current active licenses. Per option the following 
fields with license information display.

■ 'Option'
This field displays the name of the option.

■ 'State'
This field displays one of the following license states.
- 'Authorised'
- 'Not authorised'
- 'Expired'
- 'Update configuration'

■ 'License type'
This field displays one of the following license types.
- 'Resale' 
- 'Demo'

■ 'Duration in days' 
This field displays the time your license is valid.

■ 'License number'
This field displays a license number.

Purpose

View the license information for the following purposes.

■ Check the active licenses on license state, license type and license duration
■ Check how long a demo license is valid
■ View all options available for your Océ system.

The list of options depends on the type and version of the  Océ system.
■ Make a list of new options you need
■ Make a list of license numbers.

When to do

View the license information to make a list of new options you need and to make a 
list of license numbers.

Note: If an error occurs, Océ License Logic displays a message. Read the message 
carefully and follow the instructions.
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Before you begin

Make sure that the print system has active licenses. If  Océ License Logic does not 
detect active licenses, the 'No active license' opens (see ‘Log on to Océ License 
Logic’ on page 228).

How to view  license

1. Log on to Océ License Logic.

Result

The 'View licenses' window opens.

Get the host id of the Océ system

Introduction

Océ needs the host id and the license numbers of your Océ system to create a new 
license file.

When to do

Get the host id to order a new demo or resale license file from Océ.

Before you begin

Open a text editor on the  same system that you start Océ License Logic.  You can 
store the host id in a document.

How to get the host id

1. Log on to Océ License Logic.
The 'No active license' window opens if there are no active licenses.
The 'View licenses' windows opens if Océ License Logic detects active licenses.

2. Click the 'Host id' link.
The 'The host id of your Océ system' window opens.

3. Click the 'Copy' button to copy the host id to the clipboard.
4. Open a new document in a text editor.
5. Use the paste option of the text editor  to copy the host id into the document.
6. Enter the different license numbers into the document.
7. Save the document.

Result

The host id is stored in a document. You can use this document to send the host id 
and license numbers to Océ.
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Save the current active licenses

Introduction

You can save all current active licenses of different licenses types into one single file.

Purpose

Save the current active licenses for the following purposes.

■ Collect and save all active licenses of different types into one single file
■ Create a back-up file before you start a license activation job.

When to do

Save the current active licenses before you start a license activation job or to save the 
current license situation.

Before you begin

Make sure that the print system has active licenses. If  Océ License Logic does not 
detect active licenses, the 'No active license' opens (see ‘Log on to Océ License 
Logic’ on page 228).

How to save the license

1. Log on to Océ License Logic.
The 'View licenses' window opens.

2. Click the 'Save' button.
The 'Save licenses' window opens.

3. Select a directory, enter the file name and click the 'Save' button to back-up the 
current active licenses.

Result

All current active resale and demo licenses are stored into one single file.
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Perform a license activation job

Introduction

You need to activate the licenses on the Océ system to enable an option for use. Océ 
delivers the new licenses through one or more license files.

Purpose

Activate the licenses for the following purposes.

■ Activate a new demo or resale license to enable a new option
■ Activate the saved licenses of your back-up file to return to the saved situation.

When to do

Activate the licenses in the following situations.

■ Activate the new licenses when you received one or more new license files from 
Océ

■ Activate the saved licenses when an activation job for new licenses failed.

Before you begin

To activate the new licenses, you need a license file from Océ. Perform a license 
activation job per new license file. Make sure you use the correct license file: the host 
id in the license file must be the same host id as the host id on your Océ system. Make 
sure the license file is available on the system you run Océ License Logic. 

Note: If an error occurs, Océ License Logic displays a message. Read the message 
carefully and follow the instructions.
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How to activate the licenses

1. Log on to Océ License Logic.
The 'No active license' window opens if there are no active licenses.
The 'View licenses' windows opens if Océ License Logic detects active licenses.

2. If the 'No active license' window opens, click the 'Next' button.
The 'View licenses' window opens.

3. Click the 'Activate' button.
4. Click the  'Browse' button   to select the location of the license file and click 'OK' 
5. Click the 'Next' button

A preview of the new license situation displays. What you see depends on the license 
types in the license file you use (see ‘The structure of license files and licenses’ on 
page 226). You see one of the following options.
■ If you use a license file with demo licenses, the current active and the new demo 

licenses display
■ If you use a license file with resale licenses, the current active and the new resale 

licenses display
■ If you use a saved file with demo and resale licenses, the demo and resale licenses 

display like the time you created the back-up file.

6. Click the 'Next' button.
The end user license agreement displays.

7. Read the end user license agreement carefully. If you agree, select ' I accept'.
8. Click the 'Finish' button to activate the license.

The 'View licenses' window displays.
9. Restart the controller of the Océ system.

Result

The licenses are active and the options are ready for use.
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Maintain the Océ TCS500 scanner

Calibrate the scanner

Introduction

You can calibrate the scanner when you are not satisfied with the scan quality. Use 
the calibration wizard to calibrate the scanner.

How to calibrate the scanner

1. Select 'System' with the lower-right softkey.
The 'System settings' screen opens.

2. Select 'Scanner calibration' with a left softkey to start the calibration wizard.
The message 'Insert calibration sheet' and the following icon appears.

[177] 

[177] The 'Insert calibration sheet' icon
3. Insert the calibration sheet and press the green start key to start the calibration 

process.
The message 'Scanner is calibrating...'  and the following icon appears.

[178] 

[178] The 'Scanner is calibrating...' icon

When the calibration process is ready, the message 'Press OK to continue' and the 
following icon appears.

[179] 

[179] The remove the calibration sheet icon
4. Select 'OK' with the lower-right softkey.

Note: When the calibration process stops or  fails, follow the instructions on the 
scanner operator panel carefully.
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Result

The Océ TCS500 scanner is calibrated and the scan quality is correct again.

Clean the scan area

Introduction

You need to keep the glass plate clean. A dirty glass plate causes a decreased copy 
and scan quality. Clean the glass plate when you have lines on the image that are not 
on the original.

Required tools

Océ cleaner A, part of cleaning kit with codenumber 1068117
Two lint-free cloths

Attention: Use Océ cleaner A to get the best results.

Attention: Make sure you do not damage the sensor at the right of the glass 
plate.

How to clean the glass plate

1. Turn off the Océ TCS500 scanner.
2. Pull the top cover towards you and lift the top cover to open it.

[180] 

[180] Open the top cover
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3. Clean the glass plate and the white plate with a lint-free cloth and a small quantity 
of the cleaner.

[181] 

[181] Do not damage the sensor at the right side in front of the glass plate.

4. Dry the glass plate and the white plate with another lint-free cloth.
5. Clean the white plate.
6. Lift the top cover, turn the top cover towards you and push the top cover backwards 

until you hear or feel a click.
7. Turn on the Océ TCS500 scanner.
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Maintain the Océ TCS500 printer

Replace the media

Introduction

The standard configuration of the Océ TCS500 contains two rolls of media . The Océ 
TCS500 is also available with one roll or with three rolls. Appendix A contains a list 
of the supported media types and media sizes.

This section describes the following.
■ How to remove and load a roll of media .
■ How to change the type of media defined on the system.

When to do

Change a roll when a job needs a media type or size that is not on one of the rolls.
Change the media type that is defined on the system when the defined media type 
and the available media type do not correspond.

Before you begin

Use the Key Operator - System - Media - Paper series setting to define the correct 
media sizes in the Océ Settings Editor.



240 Chapter 11 Maintain the Océ TCS500

Replace the media

How to remove a roll of media 

1. Press the retract button on the right-hand side of the roll.
[182] 

[182] Press the retract button
The medium automatically retracts from the printer.

2. Use both hands to remove the roll.
[183] 

[183] Remove the roll
3. Both far ends of the roll contain flanges with handles. Lift the handles to release the 

flanges.
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[184] 

[184] Release the flanges

4. Remove the flanges.
[185] 

[185] Remove the flanges
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How to load a new media roll

1. Insert the flanges in both ends of the new media roll.
2. Press the handles down to fasten the flanges.
3. Put the saddles into position at the ends of the track.

[186] 

[186] Saddles

4. Use both hands to place both flanges in the green saddles on the printer.
5. Use both hands to slide the medium under the paper guide. Place the media on the 

printer as shown in the figure below.
[187] 

The medium loads into the printer from the top of the media roll.
Make sure the medium makes contact with the paper guide.

6. The printer automatically draws the medium in the correct position.
When the printer loads the roll of media, the screen of the printer operator panel 
shows the feedback.

Note: The printer automatically detects the width of the media.
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How to select the settings for the new roll of media 

Attention: After you load a new roll of media, the screen of the printer operator 
panel displays a wizard. Use the wizard to define the media type and the cut 
option for the new media roll.

1. The screen displays the message 'Select media type on roll (number)'. Use the lower 
softkeys to select the media type.

[188] 

[188] Select the media type

Note: The media types you can see on the screen are the three most recently used 
media types. The default media type is the media type that you defined for the media 
roll the last time. If you must select another media type, you can scroll down with the 
lower softkey and select 'More...'. Then a list displays of all the media types that you 
can select.

2. Press the key for 'Next' to enter the cut option screen. The system displays the 
question 'Cut?'

3. Use the lower softkeys to select the cut option for the media.
[189] 

[189] Select the cut option

Select one of the following.
■ 'Yes, long strip'

Cut the media with a full roll rotation feed (50 cm) before the printer cuts the 
media. You can use this option when the media is damaged or polluted with, for 
example, tape residue.

■ 'Yes, short strip'
Cut the media with the shortest possible strip (20 cm).

■ 'No'
No media cut.
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4. Press the key for 'Finish' to confirm the settings and to exit the wizard.

How to correct the media type defined on the system

Attention: You need only to correct the type of media when an incorrect media 
type was defined when the roll was loaded.
When you define a type of media that is different from the media type loaded on 
the system, the print quality decreases and pollution of the system can occur.

1. Press the On-line / off-line key to set the printer off-line.
2. Use the upper softkeys to scroll to the 'Change media type' card.

[190] 

[190] Change media type card on the off-line screen

3. Press the softkey below the 'Change media type' card to enter the wizard.
4. An introduction screen displays the message 'Use the retract button to replace a roll. 

Press Next to change the media type for a loaded roll.'
[191] 

[191] Introduction screen

When you do not want to load a new roll, use the upper right softkey to continue the 
wizard at the introduction screen. When you do want to load a new roll, press the 
retract button to change the media roll. (see figure 182 on page 240) 

5. When you press the retract button, the screen displays the message 'Load new 
media'. Change the media roll as described in the above sections. 

6. When you do not press the retract button and continue in the 'Change media type' 
wizard, the screen displays the message 'Select roll to change media type for...'. Use 
the lower softkeys to select the correct roll to change the media type for.
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[192] 

[192] Select a roll to change the media type.
7. Press the key for 'Next' to continue. The screen displays the message 'Change media 

type of roll [number]'. Use the lower softkeys to select the correct media type for the 
media roll.

[193] 

[193] Select the correct media type for the roll

8. Press the key for 'Finish' to confirm the settings and to exit the wizard.
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Replace the ink tanks

Introduction

The Océ TCS500 contains the following four ink tanks.
■ One tank for the cyan ink.
■ One tank for the magenta ink.
■ One tank for the yellow ink.
■ One tank for the black ink.

The ink level card on the printer operator panel indicates the ink level of each colour 
as a percentage.

You can replace the ink tanks at any time. A wizard is not required.

When to do

You must replace an ink tank when the ink level indicator on the printer operator 
panel shows 0%. The indicator flashes when the ink tank is empty.

Note: While you replace the ink tank, the printer can continue to print on the ink 
present in an intermediate ink storage tank inside the printer.

Note: If you do not replace the ink tank in time a pop-up message appears on the 
screen. The pop-up message displays the message 'Out of [colour] ink. Replace ink 
tank'. The system produces a double audio signal and the red LEDs of the printer 
operator panel remain illuminated. The printer stops and immediate action is 
required.
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How to remove an ink tank

1. Press the dimpled recess in the ink tank inward and upward to release the ink tank.
[194] 

[194] Push the tank inward and upward
2. Pull the ink tank straight out of the slot.

[195] 

[195] Pull the tank out

The indication for the removed tank on the printer operator panel changes into a 
dashed line.
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How to place an ink tank

Attention: Make sure that you only use Océ TCS500 ink tanks. Using TCS400 
ink tanks will damage your printer!

Attention: Make sure that you replace an ink tank with a tank that contains ink 
of the same colour.

1. Hold the ink tank with the colour of the label towards you.
The ink tanks are arranged in the same sequence as shown on the printer operator 
panel. From left to right, the sequence of the ink tanks is black, cyan, magenta, 
yellow, black (KCMY). A label on the ink tank indicates the colour of the ink in the 
ink tank.

Note: Do not shake the ink tank or touch the opening of the ink tank.

2. Slide the ink tank into the slot until you feel a resistance and stop.

Note: The ink tank fits only in one way . The ink tank fits only into the slot dedicated 
for the colour. When you attempt to place the ink tank the wrong way or in the wrong 
slot, the ink tank will not fit. Do not attempt to force it.

3. Press the dimpled recess in the ink tank inward and downward until the ink tank 
clicks into place.
When the printer detects the full ink tank, the ink level indicator on the printer 
operator panel displays 100%.  

Note: The printer first refills the intermediate ink storage tank. Therefore the ink 
level indicator on the printer operator panel can decrease to about 95%.  
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Replace a defective printhead

Introduction

The Océ TCS500 contains the following nine printheads.

[87] 

Always follow the instructions in the wizard on the printer operator panel when you 
replace a defective printhead.
After you replace a defective printhead, the system performs an alignment. The 
alignment requires the use of media. If you enter the 'Replace printhead' wizard 
while no media is present, the printer asks you to load a roll of media first.

Note: Only replace a defective printhead using the 'Replace printhead' wizard.

Note: A printhead is defective when the printhead has an electric defect or a major 
number of nozzles fail. You can not continue to print before the printhead is replaced.

When to do

The system displays an error message and prompts you to replace the defective 
printheads. Only replace the printheads the system indicates.

Attention: Only replace printheads when they are defective. Changing 
printheads that are not defective will shorten the printhead lifetime and cause 
problems with the ink system.

[87] Overview printheads 

Quantity Colour Printhead position (indicated on the printhead 
carriage)

3 Black (K) 1, 2, 3

2 Cyan (C) 4, 5

2 Magenta (M) 6, 7

2 Yellow (Y) 8, 9
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Attention: Always store printheads near the printer or allow the printheads to 
adjust to the printers environmental conditions before you insert them in to Océ 
TCS500 printer.

Attention: Do not open the top cover when you are not in the wizard. When you 
open the top cover outside the wizard, the system produces a long, uninterrupted 
audio signal audio signal. When you open the top cover during printing, the 
printer stops and the red LEDs on the printer operator panel remain illuminated. 
After you close the cover, the print is cut. Then the whole print job is restarted.

How to remove a printhead

1. Press the on-line / off-line key on the printer operator panel to set the printer off-line.
2. Use the upper softkeys to scroll to the 'Replace printhead' card.

[196] 

3. Press the softkey below the 'Replace printhead' card to enter the wizard.
An introduction screen displays the message 'Use this wizard to replace printheads. 
A roll is needed for calibration.'

4. Press the key for 'Next'.
The screen displays the message 'Select roll to use'.
The system does a calibration at the end of the wizard. You can only calibrate on the 
defined media types (see ‘Set up unattended / overnight printing optimisation’ on 
page 157). When calibration is not possible with the media available on the printer, 
the system asks you to load the correct media. When calibration is possible with one 
of the rolls, the system automatically uses the correct media roll. When calibration 
is possible with both rolls, use the lower softkeys to select the roll to use.

5. Press the key for 'Next'.
The screen displays the message 'Carriage moving to centre position...' while the 
carriage moves to the centre.
The screen displays 'Open top cover.'
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6. Open the top cover.
[197] 

The screen displays the message 'Replace printheads' and the printheads that you 
must replace. Find the correct printhead number on the printhead carriage.

[198] 

7. Press the front of the printhead cover to unlock the cover.
[199] 
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8. Open the printhead cover.
[200] 

9. Pull out the printhead and remove it.
[201] 
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How to place a printhead

1. Remove the protective tape from the new printhead.

Note: Do not touch the contact and nozzle areas of the printhead after you remove 
the protective tape.

2. Place the new printhead in the printhead holder.
The printhead only fits in one way.

3. Close the printhead cover.
4. After you replaced the defective printhead, press the softkey for 'Next'
5. The screen displays the message 'Make sure that all head covers are properly 

positioned.'
Press the key for 'Done'.
The screen displays the message 'Close top cover.'

6. Close the top cover.
The screen displays the message 'Carriage moving to home position...'

7. The screen displays 'Calibrating...'.
The calibration process takes several minutes.
You can stop the calibration process at any time. Press the key for 'Cancel' to stop the 
calibration process.

Note: If you cancel the calibration, the printer restarts the calibration process when 
a new print job starts.

Note: If the printer rejects the new printhead during the 'Replace printhead' 
procedure, remove the printhead, clean the contact area with a lintfree cloth and 
re-insert the printhead.

Note: Also check the maintenance cassette after you replaced a printhead. (see 
‘How to remove the maintenance cassette’ on page 255) Check if all wipers are 
present and clean. Excessive ink remains on the wipers can damage the printheads. 
Wipe the wiper blades with a moist cloth to increase the lifetime of the printheads.
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Replace the maintenance cassette

Introduction

The maintenance cassette wipes the printheads and caps the printhead nozzles. 
During the print process, the printhead carriage regularly moves to the right-hand 
side of the printer to spit some ink droplets into the maintenance cassette. These 
actions are necessary to keep the printheads in optimal condition.
After about 5000 m2of output (the exact value depends on the print modes you use) 
the printer indicates that you must replace the maintenance cassette.

When to do

Replace the maintenance cassette when printer operator panel displays the message 
'Maintenance cassette nearly full.'. The print quality can deteriorate. Replace the 
cassette as soon as possible.

Note: If you do not replace the maintenance cassette in time a pop-up message 
appears on the screen. The pop-up message displays the message 'Maintenance 
cassette full. Press Continue to start the Replace cassette wizard.'. The system 
produces a double audio signal and the red LEDs of the printer operator panel 
remain illuminated. The printer stops and immediate action is required.
The Océ System Control Panel also indicates that you must replace the cassette.

Note: When the maintenance cassette is not in position when the system starts up, 
the system produces an error signal The red LEDs of the printer operator panel 
remain illuminated. The printer operator panel displays the message 'Maintenance 
cassette not present.' The message gives access to a wizard that contains the 
procedure to replace the maintenance cassette.

Attention: Do not remove the maintenance cassette when you are not in the 
wizard. You can seriously damage the printheads. When you open the 
maintenance door outside the wizard, an error message prompts you to close the 
door.
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How to remove the maintenance cassette

1. Press the on-line / off-line key on the printer operator panel to set the printer off-line.
If you replace the cassette as the result of the message 'Maintenance cassette full. 
Press Continue to start the Replace cassette wizard.', press the softkey for 'Continue' 
to enter the 'Replace cassette.' wizard. Then continue with step 4.

[202] 

2. Use the upper softkeys to scroll to the 'Replace cassette' card.
[203] 

3. Press the softkey below the 'Replace cassette' card to enter the wizard.
An introduction screen displays the message 'Use this wizard to replace the 
maintenance cassette.'

[204] 

4. Use the upper right softkey to enter the wizard at the introduction screen.
The screen displays the message 'Carriage moving to centre position...' while the 
carriage moves to the centre.
Then, the screen displays the message 'Open maintenance door.'

5. Open the door to the maintenance cassette.
The screen displays the message 'Remove cassette.'
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6. Press the green grip to the left to release the cover that gives access to the 
maintenance cassette.

[205] 

7. Pull out the maintenance cassette.
[206] 

Note: Always store the old maintenance cassette in a horizontal position to prevent 
the spilling of ink. Be careful with the ink on the maintenance cassette.

Note: The packing of the new maintenance cassette also includes a plastic zip lock 
waste bag. Use this bag to dispose of the old maintenance cassette.  
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How to place the maintenance cassette

1. Slide the new maintenance cassette into the cassette holder.
2. Close the cover of the maintenance cassette . The cover locks automatically.

The screen displays the message 'Is the cassette you placed used or new?'
[207] 

Attention: Make sure that you select the correct option. Never select 'New' for 
a used cassette. This can seriously damage your printheads.

3. Press the key for 'Used' or 'New'.
Select 'Used' if you inserted a cassette that was used before. The end-of-life counter 
is not reset to zero.
Select 'New' if you inserted a cassette that was not used before. The end-of-life 
counter is reset to zero.

4. Close the door to the maintenance cassette.
The screen displays the message 'Carriage moving to home position...'
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Clear an original jam

The Océ TCS500 scanner

Clear an original jam

Introduction

A red light at the scanner operator panel indicates that an original jam occurred.

How to remove a jammed original

1. Pull the top cover towards you and lift the top cover to open it.
[208] 

[208] Open the top cover
2. Remove the original.
3. Lift the top cover, turn the top cover towards you and push the top cover backwards 

until you hear or feel a click.

Result

The green light at the scanner operator panel is on.
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Scanner error-messages and solutions

Introduction

When an error occurs, the Océ TCS500 scanner shows the following information.
■ The error-message icon
■ The error message
■ A description of the solution
■ An error code
■ Functions at the lower softkeys.

In some cases you need these functions, like wind and rewind for example, to 
come to the solution.

How to handle error messages at the scanner

1. Read the error message carefully
[209] 

[209] The error-message icon
2. Follow the instructions on the scanner operator panel.

Result

You solved the error with the help of the instructions on the scanner operator panel.
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The Océ TCS500 printer

Overview

Definition

This table gives an overview of the possible error messages and system messages of 
the Océ TCS500 printer and refers to the possible solution.

[88] 

Error message / System 
message

Description / solution

'Required media not available' The media required for the job is not available on 
the printer.
(see ‘Required media not available’ on 
page 264)

'Roll empty' The end of the roll of media is reached while you 
print
(see ‘End of roll’ on page 264)

'Close maintenance door' / 
'Close top cover.'

A door or cover is open, although you are not in 
a wizard
(see ‘Cover or door opened’ on page 265)

'Remove media' A media jam occurred
(see ‘Remove jammed media’ on page 266)

'Temperature out of range' 
/'Humidity out of range'

Excessive temperature or humidity.
(see ‘Temperature or humidity out of range’ on 
page 267)

'Warning Carriage away from 
home position too long'

The carriage is away from its home position too 
long
(see ‘Carriage away from home position too 
long’ on page 268)

? The Océ Queue Manager contains damaged jobs 
that you cannot delete.
(see ‘Clear the set memory’ on page 268)

'System error' A system error occurred.
(see ‘Correct system errors’ on page 269)

'Permanent error' An permanent error occurred.
(see ‘Deal with permanent errors’ on page 270)
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Printhead error messages

The table below gives on overview of the printhead-related error codes.

[89] 

Error 
code

Description Customer action

4501 - 
4509

Excessive leakage current 
detected for head [1…9]
Printhead failing
Replace printed [1…9]

Replace the printhead by using the 
wizard.

Note: Never re-insert a 
printhead that has 
caused this problem.

4551 - 
4559

Head defective during printing Printhead is probably not placed 
correctly. Remove and re-insert the 
printhead at the original position.

Note: If the problem 
persists you must replace 
the printhead.

4571 - 
4579

Head too hot during printing You can ignore this problem by 
pushing the 'OK' button.

Note: If the problem 
re-occurs after a short 
time you must replace 
the printhead.

4581 - 
4589

Head [1….9] keeps heating Replace the printhead by using the 
wizard.

4951 - 
4959

WOM memory failure for head 
[ 1……9]

Service warning only. No customer 
intervention needed.

4961 - 
4969

Heating of head [1……9] failed Continue printing until the message 
'Replace printhead' displays on the 
operator panel.
Then replace the printhead by using 
the wizard.



264 Chapter 12 System messages and solutions

Required media not available

Required media not available

Required media not available

When the Océ Power Logic® controller tries to print on a type of media that is not 
available on the printer, the printer operator panel displays a media request. The 
system produces a short interrupted audio signal. The red LEDs of the printer 
operator panel remain illuminated. Replace the media roll to continue. The following 
shows an example of the message.

[210] 

End of roll

End of roll

When two media rolls contain the same type of media and the end of one roll is 
reached, the printer automatically switches to the other roll.
When the end of the media roll is reached during printing and the other roll does not 
contain the same media type, the system produces a short interrupted audio signal. 
The red LEDs on the printer operator panel flash two times.
If necessary the output is dried, the printer takes back the output and delivers the 
output at the front side of the printer.

Note: If you stop the drying procedure, the printer moves the remaining piece of 
media to the back side of the printer. You must remove this piece of media manually.
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Cover or door opened

Cover or door opened

You are only allowed to open the top cover when you are in the 'Replace printhead' 
wizard.
You are only allowed to open the maintenance door when you are in the 'Replace 
cassette' wizard.

When you open the top cover or the maintenance door without accessing the wizard, 
the system produces a warning signal. The red LEDs on the printer operator panel 
remain illuminated. When you open a door or cover during printing, the printer 
stops. A message on the printer operator panel tells you to close the top cover or the 
maintenance door. Close the top cover or the maintenance door to continue.

[211] 

[212] 

When the cover or door is opened while the printer prints a job, the print is cut after 
you close the cover. Then the whole print job is restarted.
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Remove jammed media

Introduction

When a media jam occurs, the system produces a double audio signal. The red LEDs 
of the printer operator panel remain illuminated. When a jammed media error occurs 
on the system, immediately remove the jammed media to prevent damage to the 
printer.
The system handles the error recovery for the jammed media through a series of 
dialogue boxes. Use the following procedure to remove the jammed media.

How to remove jammed media

Attention: Never use a knife to cut loose the jammed media. When you use a 
knife to cut loose the media, you can damage the printer.

1. Open the cover or door that the printer operator panel indicates.
[213] 

2. Use a pair of scissors to cut loose the media.
3. Remove the jammed media from the output side of the printer.

[214] 

4. Press the softkey for 'Done' to confirm that you removed the jammed media.
5. Close the cover or door that the printer operator panel indicates.
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[215] 

6. Insert the roll of media in the printer.
The printer is ready for use.

Note: When you remove the media from the front of the printer, there is a risk of ink 
pollution in the media feed section.

Temperature or humidity out of range

Temperature or humidity out of range

The system produces a short interrupted audio signal. The red LEDs on the printer 
operator panel flash two times. Press the key for 'OK'. The system information card 
on the on-line screen of the printer operator panel displays the following message 
until the problem is solved..

[216] 

When this error persists, contact your local Océ service organisation. 
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Carriage away from home position too long

Attention: When the carriage stays away from its home position too long, the 
printheads become dry. When the printheads are dry, you must replace the 
printheads.

Carriage away from home position too long

Always replace the printheads or the maintenance cassette in one continuous action 
to prevent the drying of the printhead nozzles.
When you replace a printhead or the maintenance cassette, the carriage moves to the 
centre. When the carriage is in the centre too long, the system produces an error 
signal The red LEDs on the printer operator panel remain illuminated. The printer 
operator panel also displays a message. Press the key for 'OK' to acknowledge the 
error message.

[217] 

Clear the set memory

Attention: When you clear the set memory, all jobs on the system are deleted.

Clear the set memory 

Clear the set memory when the Océ Queue Manager contains damaged jobs that you 
cannot delete.
You can clear the set memory from the Océ System Control Panel.

From the 'System' menu, select 'Clear the system' to delete all the jobs on the system.

When you do not have a keyboard, mouse and monitor with your controller, you can 
also clear the system with the 'Configure system' wizard on the printer. (see 
‘Configure the network settings of the Océ TCS500’ on page 66).
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Correct system errors

Introduction

When a system error, the system produces a double audio signal. The red LEDs of 
the printer operator panel remain illuminated. 

How to correct system errors 

1. A system error is an error that the system can recover. When a system error occurs, 
an error code is displayed on the screen.

[218] 

2. When a system error occurs, you must turn the printer off and on.

Note: If the setting 'Synchronise controller power on / off' in the Océ Settings editor 
is set to 'Enabled', wait for the Power Logic® controller to shut down before you turn 
on the system again. If the setting 'Synchronise controller power on / off' in the Océ 
Settings editor is set to 'Disabled' just wait a few seconds before you turn on the 
system again.
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Deal with permanent errors

Introduction

When a permanent error occurs, the system produces a double audio signal. The red 
LEDs of the printer operator panel remain illuminated. 

How to deal with permanent errors

1. A permanent error is an error that neither the system nor the operator can recover. A 
permanent error does not recover when you restart the system. When a permanent 
error occurs, an error code is displayed on the screen.

[219] 

2. When a permanent error occurs, contact your local Océ service organisation. Make 
sure you have the error code at hand when you contact your local Océ service 
organisation.
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Specifications Océ TCS500 scanner

The Océ TCS500 scanner

Specifications Océ TCS500 scanner
[90] 

Technology ■ Free-standing console
■ Océ Image Logic® real-time image processing
■ 1 x Reduction type CCD camera

Scan speed 
(standard)

1 m/min. or 0.7 inch/sec.

Scan speed (high) up to 5 m/min. or 3.3 inch/sec.

Resolution 575 dpi

Camera 3 colour linear CCD  
21360 Pixels
24 bits colour 

Scan width 914.4 mm 

Original feed Right aligned

Original size Minimum
■ 210 mm x 210 mm (L x W)

Maximum
■ 6000 mm x 1016 mm (L x W).

Maximum media 
thickness

1.5 mm

Scale method ■ Scale to format.
Scale range 25% - 400% (0.1% fixed step interval).

■ Custom scale.
Scale range 10% - 1000% (0.1% fixed step interval).

■ Exact (1 to 1).
No scaling.

Input mode ■ Single sheet
■ Set

Number of copies 1 - 999 (scan once print many)

Colour space sRGB

Image quality ■ Original type selection (see ‘Original types for the Océ 
TCS500 scanner’ on page 274)

■ Colour selection (Black&White / Grey / Colour)
■ Brightness light/dark
■ Image optimisation for fine details or speed
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Image editing ■ Remove strips (leading/trailing/left/right)
■ Mirroring horizontal
■ Delete area

Other 
functionalities

■ Pre-programming of next job
■ Programmable default settings
■ Synchro cut mode
■ Leading and trailing strip adjustment (0 mm - 400 mm)
■ Concurrent scanning and printing
■ Scan to file Black&White / Grey  (option).
■ Scan to file Colour (option).

Interface Firewire

Voltage 85-264 V

Frequency 47/63 Hz

Power 
consumption

In operation: 110 W
Standby: 20 W

Dimensions 1105 mm x 615 mm x 1240 mm (H x D x W)

Weight 65 kg

Safety approvals TüV GS, CE, UL, (c)UL, CB, EMC Directive 89/336/EEC, 
FCC Class A
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Original types for the Océ TCS500 scanner
The original types that you can use for your Océ TCS500 scanner are listed in the 
table below.

[91] 

[91] Original types (1 – 2)

Original type Type Icon

Black & white / 
grey

'Lines&Text'
[220] 

[220] Lines / text icon

'Greys&Lines'
[221] 

[221] Greys & lines icon

'Transparent'
[222] 

[222] Transparent icon

'Blueprint'
[223] 

[223] Blueprint icon

'Dark original'
[224] 

[224] Dark original icon
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Colour 'Photo'
[225] 

[225] Photo icon

'Lines&Text'
[226] 

[226] Lines / text icon

'Map'
[227] 

[227] Lines / text icon
8835

'Artwork'
[228] 

[228] Lines / text icon

[91] Original types (2 – 2)

Original type Type Icon
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The Océ TCS500 printer

Specifications Océ Power Logic® controller

Océ Power Logic® controller hardware
[92] 

Platform Océ controller with Windows® XP Embedded

Memory 256 Mb, expandable to 1024 Mb

Hard disc capacity 80 GB high speed hard discs, expandable with 1 
extra hard disc (80 GB)

Graphical user interface Optional keyboard, mouse and monitor

Standard interface 10/100BaseT with RJ45

Network protocols TCP/IP, IPX/SPX, FTP, LPD, Novell

Power consumption Controller: < 100 W
Monitor: 200 W (depends on monitor type)

Electrical requirements 100-120 / 230 V, 50/60 Hz

Applicable software Océ Power Logic® controller software
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Océ Power Logic® controller software

The Océ Power Logic® controller software consists of a basic module and a print 
module.
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Specifications Océ Power Logic® controller

[93] 

[94] 

[93] Basic module 

Basic functions File spooling on the controller.
Concurrent receiving, processing and printing of 
digital jobs.

Basic applications ■ Océ Settings Editor
■ Océ System Control Panel
■ Océ Queue Manager
■ Océ License Logic
■ Océ Remote Logic®

■ Océ Print Exec® Workgroup LT.

Optional ■ Océ Account Center
■ Océ Scan Manager
■ Upgrade to Océ Print Exec® Workgroup

[94] Print module 

Print processing technology Océ Image Logic

Number of prints 1 - 999
Set memory: send once, process once, print 
many

Roll selection and switching Manual
Automatic

Print manipulation Rotation
Auto-scaling
Positioning
Pen management
Trailing strip adjustment; add up to 400 mm

Colour modes ■ Greyscale
■ Colour

Quality modes ■ Check
■ Release
■ Presentation

Language sensing Automatic Language Sensing (ALS)

Standard file formats ■ Vector: HP-GL, HP-GL/2, CalComp
■ Raster: HP-RTL, TIFF 6.0, NIFF, CALS-I, 

NIRS, C4, ASCII

Cut length ■ Standard cut
■ Synchro cut
■ Custom cut

Optional Adobe® PostScript 3 PDF printing and PDF 
Scan-to-file
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Specifications Océ TCS500 printer 
[95] 

Technology Multiple printhead thermal inkjet.

Printheads 9 Semi-permanent printheads with 640 nozzles
■ 3 Black printheads
■ 2 Cyan printheads
■ 2 Magenta printheads
■ 2 Yellow printheads.

True resolution 600 dpi x 600 dpi

Ink tanks 400 ml disposable ink tanks

Ink level monitoring Ink level indication on the printer operator panel and 
through Océ Remote Logic® 
Out of ink signalling

Print speed Greyscale, check mode
■ 1 A0 (portrait) per 41 seconds

Colour, check mode
■ 1 A0 (portrait) per 1 minute and 3 seconds

Maximum productivity Greyscale
■ 65 m2/h

Colour
■ 48 m2/h

Minimum pen thickness 0.080 mm

Media sources 1, 2, or 3 front loadable rolls

Media core diameter 2"

Maximum roll length 120 metre

Output delivery Slide, accessible from the roll side
Copy receiving rack (option)

Output sizes Width
■ DIN: From A3 to A0, 36", B1 and B2
■ ANSI: From 11" to 36"

(including 30")

Length
■ 200 - 5000 mm

Drawing margins ■ Leading and trailing strip: 3 mm
■ Left and right side: 3 mm

Width detection Automatic
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Specifications Océ TCS500 printer

Media types ■ Uncoated: 80 -110 g/m2 
■ Coated: 90 -110 g/m2 
■ Specialities

Calibration ■ Automatic printhead alignment
■ Failing nozzle compensation
■ Unattended printing in the overnight mode.

Dimensions 1461 mm x 743 mm x 1960 mm (H x D x W)

Voltage 100-120 / 230 V

Frequency 50/60 Hz

Power consumption ■ EPA-sleepmode (printer and Océ Power Logic® 
controller, not including the monitor)
< 60 W

■ Standby
153 W

■ In operation
201 W

Weight 165 -180 kg

Safety approvals TüV GS, CETECOM, CE, UL, (c)UL, CB, FCC Class A

Other ■ Maintenance cassette.
■ EPA Energy Star® compliant.



281

Preferred media types and sizes

Preferred media types and sizes

Introduction

Océ machines and media are matched for the best quality and performance. Océ 
advises only approved Océ media. You can receive a full list of the Océ media that 
you can use in your printer (that includes plain paper, transparent paper, coloured 
papers and different polyester films) from your Océ representative.

Attention: Do not store the paper in rooms where temperature and humidity are 
high. Avoid dust and direct sunlight. Wrap not used paper in the plastic to prevent 
it absorbing moisture.

Media types - Europe

The following preferred media types are available for the Océ TCS500 printer in 
Europe:

[96] 

Note: Visit Océ on the internet at www.oce.com for the latest information.

Note: To make sure that your print quality is optimal you can download the 
OMP-file (Océ Media Profiles-file) with the right IJM-number from the Océ website 
for all media types.

[96] Preferred media types - Europe 

IJM number Media name Media name in 
Wizard 

IJM005 Océ Draft Paper Draft Paper

IJM020 Océ Standard paper 90 gsm Standard Paper

IJM138 / 139 Océ Transparent Paper 90/112 gsm Tracing Paper

IJM113 / 123 Océ Premium Grade Paper 90 / 
120gsm

Premium Coated Paper

IJM149 / 150 Océ Smart Matt Paper 120 / 170gsm Matt Photo Paper

IJM222 Océ Top Photo Plus High Gloss Photo 
Paper

IJM311 Océ Double Matt Film 95 um Matt Film
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Preferred media types and sizes

Media types - USA

The following preferred media types are available for the Océ TCS500 printer in the 
USA:

[97] 

Note: Visit Océ on the internet at www.oce.com for the latest information.

Note: To make sure that your print quality is optimal you can download the 
OMP-file (Océ Media Profiles-file) with the right IJM-number from the Océ website 
for all media types.

[97] Preferred media types - USA 

IJM number Media name Media name in 
Wizard 

86-500 CheckPlot Bond Bond

86-800 DeluxeBond DeLuxeBond

86-2024 Premium ColorBond Coated Bond

GIPPLS7 PhotoPerfectPlus Glossy High Gloss Photo 
Paper

86-6020 Color Vellum Color Vellum

86-4016 / 86-4020 Mono chrome Vellum Mono Chrome Vellum

86-8342 / 86-8632 Double Matt Film Matt Film

86-0016 / 86-0018 Translucent Bond Translucent Bond
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Media types - Japan

The following preferred media types are available for the Océ TCS500 printer in 
Japan:

[98] 

Note: Visit Océ on the internet at www.oce.com for the latest information.

Note: To make sure that your print quality is optimal you can download the 
OMP-file (Océ Media Profiles-file) with the right IJM-number from the Océ website 
for all media types.

Media sizes 
[99] 

[98] Preferred media types - Japan 

IJM number Media name Media name in 
Wizard 

IPE Recycled Plain 64 gsm Recycled Plain

IPC Plain Coated 80 gsm PlainCoated

IJM311 Matt Thin Film MattFilmThin

IPT Tracing Japan Tracing Japan

Maximum Minimum

Media width 36 inch 297 millimetres
11 inch

Roll length 120 metres Not applicable
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Typical drying times

Typical drying times

Introduction

The printer automatically adapts the default drying time. The default drying time 
depends on the following.
■ The media type
■ The ambient humidity
■ The print mode.

When you print greyscale in the 'Check' quality mode, the system decreases the 
drying time to 20% of the default value.

You can change the drying time for all the media types. You can select a percentage 
of 0% - 999% of the default drying time (see ‘Change the default drying time’ on 
page 153).

Typical drying times per media type

The following table describes typical drying times for Océ media under standard 
conditions (22 °C, 50% relative humidity).

[100] 

[100] Typical drying times per media type (1 – 2)

Media type Media name Drying time
(minutes'sec
onds")

Draft paper Océ Draft Paper 80 g/m2 0'15"

Standard paper Océ Standard Paper 90 g/m2 0'20"

Bond Océ Check Bond uncoated 20 lbs 0'20"

Deluxe bond Océ Deluxe Bond uncoated 24 lbs 0'20"

Premium coated paper Océ Premium Grade Paper 90 g/m2 0'20"

Coated bond Océ Color Bond coated 24 lbs 0'20"

Matt photo paper Océ Smart Matt Paper 100 (170) g/m2 0'50"

High gloss photo paper Océ Smartfit Plus Photogloss 175 
g/m2 

4'45"

Tracing paper Océ Tracing Paper 90 g/m2 2'55"

Translucent bond Océ Translucent Bond 16 lbs
Océ Translucent Bond 18 lbs

0'50"

Monochrome vellum Océ Monochrome Vellum 16 lbs
Océ Monochrome Vellum 20 lbs

1'05"
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Note: For maximum productivity, the system does not perform drying times of 0'20" 
or less. When you change the default drying time, the system uses the drying times 
of 0'20" or less for the arithmetic operation.

Color vellum Océ Color Vellum 20 lbs 1'40"

Matt film Océ Double Matt Film 95 µ
Océ Film Double Matt Erasable 3 mil
Océ Film Double Matt Erasable 4 mil

1'45"

Recycled plain paper Océ Plain Uncoated 64 g/m2 0'25"

Tracing paper (Japan) Océ Tracing Uncoated 75 g/m2 2'55"

Plain paper uncoated 0'20"

Matt film (thin) 1'45"

[100] Typical drying times per media type (2 – 2)

Media type Media name Drying time
(minutes'sec
onds")
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Standard scale factor

Introduction

The Océ TCS500 can scale (reduce and enlarge) the image to a defined format.
The overview below shows the scale factor if you need to copy on media of different 
sizes.

Attention: If you select the wrong scale factor you can loose information.

Supported DIN media series

The table shows the scale factor if you copy from one media size (original column) 
to another media size (first row)

[101] 

[101] DIN table 

Originals Standard scale fixed steps for the DIN media series [%]

A0 A1 A2 A3 36 
Inch

B1 B2

A0 100 71 50 35 109 84 59

A1 141 100 71 50 153 119 84

A2 200 141 100 71 218 168 119

A3 283 200 141 100 308 238 168

36 Inch 107 65 46 32 100 77 55

B1 119 84 59 42 129 100 71

B2 168 119 84 59 183 141 100
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Generic ISO media series

The table shows the scale factor if you copy from one media size (original column) 
to another media size

[102] 

[102] ISO table 

Originals Standard scale fixed steps for the ISO media series [%]

A0 A1 A2 A3 A4 A5

A0 100 71 50 35 - -

A1 141 100 71 50 35 -

A2 200 141 100 71 50 35

A3 283 200 141 100 71 50

A4 400 283 200 141 100 77

A5 565 400 283 200 141 100
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Specifications Océ Scan Logic®

Specifications Océ Scan Logic®
[103] 

Application Océ Scan Manager, integrated scanning solution with Océ 
View Station LT

Scan destinations Maximum of 10 destinations.
■ Scan to the local controller
■ Scan to a Microsoft® Windows network location with 

Server Message Block (SMB)
■ Scan to an internet location with File Transfer Protocol 

(FTP).

Resolution 72, 150, 200, 300, 400, and 600 dpi.

File formats ■ TIFF
■ PDF
■ CALS-I.

Available file 
organization types 
for TIFF files

■ RAW
■ Stripped
■ Tiled.

Available file 
compression 
methods

TIFF file format
■ None (uncompressed)
■ Group 3 2D
■ Group 4
■ Packbits
■ LZW.

PDF file format
■ Group 4
■ Flate
■ LZW.

CALS-I file format
■ Group 4.
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Specifications Océ Scan Logic®

Available colour 
depths

TIFF file format
■ Black & white, 1 bit per pixel
■ Greyscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

PDF file format
■ Black & white, 1 bit per pixel
■ Greyscale, 8 bits per pixel
■ RGB, 24 bits per pixel.

CALS-I file format
■ Black & white, 1 bit per pixel.

Scan mode Single scan.

File naming Automatically generate unique file names for each scan.

Viewing View scans at point of scanning.

Océ Image Logic® The best scan quality for different image types.

Ease of use Job templates
Scan to file from the scanner operator panel.
Scan directly to a local or a remote destination.

Requirements Océ Power Logic® Controller and a graphical user interface

Options Océ View Station for editing and enhancement of scanned 
documents
Océ Batch Processor for automated editing.
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Specifications drivers and job submission software

Océ drivers 
[104] 

Note: Visit Océ on the internet at www.oce.com for the latest information.

Optional application software
[105] 

Software 
environment

Required driver Remarks

AutoCAD® 2000 
family

Océ Windows Printer 
Driver

This drivers is a mixed 
raster-vector HP-GL/2 printer 
driver that allows you to print 
from any application under 
Windows 2000, Windows XP 
or Windows Server 2003 to 
your Océ systems

Graphical application 
software

Océ TDS/TCS Adobe® 
PostScript 3 Drivers

The drivers allow you to print 
from a Windows 2000®, 
Windows XP®, Macintosh 
MacOS 8.6/9.x or Macintosh 
Mac OS X application to Océ 
printers.

Function Application software

Job submission ■ Océ Print Exec® Workgroup
■ Océ Print Exec® Pro
■ Océ Repro Desk

Account Logging ■ Océ Account Center
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Reader's comment sheet

Reader's comment sheet 

Questions 

Have you found this manual to be accurate? 
O Yes 
O No

Were you able to operate the product, after reading this manual? 
O Yes 
O No 

Does this manual provide sufficient background information? 
O Yes 
O No 

Is the format of this manual convenient in size, readability and arrangement (page 
layout, chapter order, etc.)?
O Yes 
O No 

Could you find the information you were looking for? 
O Always 
O Most of the times 
O Sometimes 
O Not at all 

What did you use to find the required information? 
O Table of contents 
O Index 

Are you satisfied with this manual?
O Yes 
O No 

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest improvements 
overleaf or on a separate sheet. 

Comments:
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------------------------------------------------------
----------------------------------------------------
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Reader's comment sheet

Date:

This reader's comment sheet is completed by: 
(If you prefer to remain unknown, please do fill in your occupation) 

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to: 

Océ-Technologies B.V.
For the attention of ITC User Documentation. 
P.O. Box 101, 
5900 MA Venlo
The Netherlands 

Send your comments by E-mail to: itc-userdoc@oce.nl 

For the addresses of local Océ organisations see: http://www.oce.com 
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Reader's comment sheet
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Addresses of local Océ organisations

Addresses of local Océ organisations 
[106] 

Océ-Australia Ltd. 
P.O. Box 363
Ferntree Gully MDC
Vic 3165
Australia 
http://www.oce.com.au/ 

Océ-Österreich GmbH 
Postfach 95
1233 Vienna
Austria 
http://www.oce.at/

Océ-Belgium N.V./S.A. 
J. Bordetlaan 32
1140 Brussel
Belgium 
http://www.oce.be/

Océ-Brasil Comércio e Indústria Ltda.
Av. das Nações Unidas, 11.857 
Brooklin Novo
São Paulo-SP 04578-000
Brasil 
http://www.oce-brasil.com.br/ 

Océ-Canada Inc. 
4711 Yonge Street, Suite 1100 
Toronto, Ontario M2N 6K8
Canada 
http://www.oce.ca/

Océ Office Equipment (Beijing) Co., Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China 
http://www.oce.com.cn/

Océ-Czech Republic ltd.
Hanusova 18
140 21 Praha 4
Czech Republic 
http://www.oce.cz/ 

Océ-Danmark a/s 
Vallensbækvej 45
2605 Brøndby
Denmark 
http://www.oce.dk/ 

Océ Finland OY
Valkjärventie 7 D, PL 3 
02130 Espoo
Finland 
http://www.oce.fi/

Océ-France S.A. 
32, Avenue du Pavé Neuf
93161 Noisy-le-grand, Cedex 
France 
http://www.oce.fr/

Océ-Deutschland GmbH
Solinger Straße 5-7
45481 Mülheim/Ruhr
Germany 
http://www.oce.de/ 

Océ-Hong Kong and China head office
12/F 1202 The Lee Gardens
33 Hysan Avenue 
Causeway Bay
Hong Kong 
http://www.oce.com.hk/
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Océ-Hungaria Kft.
1241 Budapest
Pf.: 237
Hungary 
http://www.oce.hu/

Océ-Ireland Ltd.
3006 Lake Drive 
Citywest Business Campus
Saggart
Co. Dublin
Ireland 
http://www.oce.ie/

Océ-Italia S.p.A. 
Strada Padana Superiore 2/B 
20063 Cernusco sul Naviglio (MI) 
Italia 
http://www.oce.it/ 

Océ Japan Corporation
3-25-1, Nishi Shinbashi
Minato-Ku
Tokyo 105-0003
Japan 
http://www.ocejapan.co.jp/

Océ-Belgium S.A.
Rue Astrid 2/A
1143 Luxembourg-Belair
http://www.oce.lu/

Océ Malaysia Sdn. Bhd.
#3.01, Level 3, Wisma Academy 
Lot 4A, Jalan 19/1 
46300 Petalig Jaya 
Selangor Darul Ehsan
Malaysia 
http://www.ocemal.com.my/

Océ-Mexico S.A. de C.V. 
Prolongación Reforma 1236, 
4to Piso 
Col. Santa Fé, Del. Cuajimalpa 
C.P. 05348 
México, D.F. 
México 
http://www.oceusa.com/

Océ-Norge A.S. 
Postboks 4434 Nydalen
Gjerdrums vei 8
0403 Oslo
Norway 
http://www.oce.no/

Océ-Poland Ltd. Sp.z o.o. 
ul. Bitwy Warszawskiej 1920 r. nr. 7 
02-366 Warszawa  
Poland 
http://www.oce.com.pl/ 

Océ-Lima Mayer, S.A.
Av. José Gomes Ferreira, 11 Piso 2 - 
Miraflores 
1497-139 Algés
Portugal 
http://www.oce.pt/

Océ Singapore Pte Ltd.
190 MacPherson Road
#03-00 Wisma Gulab 
Singapore 348548 

Océ Printing Systems (PTY) Ltd.
P.O.Box 629
Rivonia 2128
South Africa 
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Addresses of local Océ organisations

Note: The web site http://www.oce.com gives the current addresses of the local Océ 
organisations and distributors.

Note: The addresses of local Océ organisations for information about the Wide 
Format Printing Systems and the Production Printing Systems can be different from 
the addresses above. Refer to the web site http://www.oce.com for the addresses you 
need.

Océ España SA 
Business Park Mas Blau
Osona, 2 08820 El Prat de Llobregat
Barcelona
Spain 
http://www.oce.es/ 

Océ-Svenska AB
Sollentunavägen 84
191 27 Sollentuna 
Sweden 
http://www.oce.se/

Océ-Schweiz AG 
Sägereistrasse 10
CH8152 Glattbrugg
Schweiz 
http://www.oce.ch/

Océ (Thailand) Ltd. 
B.B. Building 16/Floor
54 Asoke Road
Sukhumvit 21
Bangkok 10110
Thailand 

Océ-Nederland B.V. 
P.O.Box 800 
5201 AV 's-Hertogenbosch 
The Netherlands 
http://www.oce.nl/ 

Océ (UK) Limited 
Océ House
Chatham Way
Brentwood, Essex CM14 4DZ 
United Kingdom 
http://www.oce.co.uk/

Océ North America Inc.
5450 North Cumberland Avenue
Chicago, IL 60656
USA 
http://www.oceusa.com/
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Index 

A
add a leading strip  . . . . . . . . . . . . . . . . . . . . . . 181
add a trailing strip . . . . . . . . . . . . . . . . . . . . . . . 181
Alternative language

Display language  . . . . . . . . . . . . . . . . . . . . . 62
An overview of Océ Account center  . . . . . . . . 218
Anonymous user

Password  . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Auto original feed setting . . . . . . . . . . . . . . . . . . 83
Auto view . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Automatic logon

enable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
available settings  . . . . . . . . . . . . . . . . . . . . . . . 169

B
basic copy job . . . . . . . . . . . . . . . . . . . . . . . . . . 165

C
CAD drawings

Colour  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
Colour (high density) . . . . . . . . . . . . . . . . . 192
Greyscale  . . . . . . . . . . . . . . . . . . . . . . . . . . 191

calibrate scanner . . . . . . . . . . . . . . . . . . . . . . . . 236
calibrate wizard  . . . . . . . . . . . . . . . . . . . . . . . . 236
Change job attributes  . . . . . . . . . . . . . . . . . . . . 151
Clean cut the media  . . . . . . . . . . . . . . . . . . . . . 155
clean the glass plate  . . . . . . . . . . . . . . . . . . . . . 237
clean the scan area  . . . . . . . . . . . . . . . . . . . . . . 237
clear an original jam . . . . . . . . . . . . . . . . . . . . . 260
Clear set memory . . . . . . . . . . . . . . . . . . . . . . . 268
Colour feel

HP-GL, HP-GL/2, HP-RTL . . . . . . . . . . . . 197
PostScript, PDF  . . . . . . . . . . . . . . . . . . . . . 197
TIFF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Colour Management
Overview settings . . . . . . . . . . . . . . . . . . . . 193

Colour mode
Black and White . . . . . . . . . . . . . . . . . . . . . 138
Colour  . . . . . . . . . . . . . . . . . . . . . . . . 138, 141
Greyscale  . . . . . . . . . . . . . . . . . . . . . . 138, 140

Colours
Output quality problems  . . . . . . . . . . . . . . 207

Common user  . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Components
Océ Power Logic® controller  . . . . . . . . . . . 28
Océ TCS500 printer . . . . . . . . . . . . . . . . . . . 31
Océ TCS500 scanner  . . . . . . . . . . . . . . . . . . 24
system . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

concept  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Configure system

Network adapter . . . . . . . . . . . . . . . . . . . . . . 66
Password protection . . . . . . . . . . . . . . . . . . . 66

Controller
Hardware

Specifications . . . . . . . . . . . . . . . . . . . . 276
Software

Specifications . . . . . . . . . . . . . . . . . . . . 277
controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Controller applications

Display language  . . . . . . . . . . . . . . . . . . 63
Display language  . . . . . . . . . . . . . . . . . . . . . 62

copy
a specific area . . . . . . . . . . . . . . . . . . . 184, 186

copy an area  . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
Copy jobs

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . 160
copy jobs

available settings  . . . . . . . . . . . . . . . . . . . . 169
basic copy job . . . . . . . . . . . . . . . . . . . . . . . 165
clear an original jam . . . . . . . . . . . . . . . . . . 260
extended copy job . . . . . . . . . . . . . . . . . . . . 166
stop a copy job . . . . . . . . . . . . . . . . . . . . . . 168

Copy quality, according to
fine details  . . . . . . . . . . . . . . . . . . . . . . . . . 175
original brightness  . . . . . . . . . . . . . . . . . . . 175
original type . . . . . . . . . . . . . . . . . . . . . . . . 175

Copy Receiving Rack . . . . . . . . . . . . . . . . . . . . . 40
copy receiving rack . . . . . . . . . . . . . . . . . . . . . . . 42
Copy sets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Cut the output . . . . . . . . . . . . . . . . . . . . . . . . . . 154

D
Default language
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Index

Display language  . . . . . . . . . . . . . . . . . . . . . 62
delete an area . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
Demo print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Destination

manage  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
DIN media series . . . . . . . . . . . . . . . . . . . . . . . . 286
Display counters  . . . . . . . . . . . . . . . . . . . . . . . . . 38
Display language

Alternative language . . . . . . . . . . . . . . . . . . . 62
Controller applications . . . . . . . . . . . . . . . . . 62

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Default language . . . . . . . . . . . . . . . . . . . . . . 62
First language . . . . . . . . . . . . . . . . . . . . . . . . 62
Océ Power Logic® controller . . . . . . . . . . . . 62
Printer operator panel . . . . . . . . . . . 62, 63, 64
Scanner operator panel . . . . . . . . . . . . . .62, 64
Second language . . . . . . . . . . . . . . . . . . . . . . 62

Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290
Drying time

change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
typical drying times per media type . . . . . . 284

E
Energy save mode

Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Enhanced colours

CMYK input data
PostScript, PDF  . . . . . . . . . . . . . . . . . . 200

Rendering intent
HP-GL, HP-GL/2, HP-RTL  . . . . . . . . . 201
PostScript, PDF  . . . . . . . . . . . . . . . . . . 201
TIFF  . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
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